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other countries.
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soft Internet Explorer are either trademarks or registered trademarks of 
Microsoft Corporation in the United States and/or other countries.

Specifications, terms and conditions are subject to change without notice. 
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Purpose and scope

The purpose of this guide is to help you successfully use the Lector and 
Scriptor features and capabilities. This guide includes task-based instruc-
tions that describe how to install, configure, use, and troubleshoot the 
Lector and Scriptor. Additionally, this guide provides a description of 
Willtek’s warranty, services, and repair information, including terms and 
conditions of the licensing agreement.

Assumptions

This guide is intended for novice users who want to use the Lector and 
Scriptor effectively and efficiently. We are assuming that you have basic 
computer and mouse/track ball experience.

Related information

Use this guide in conjunction with the following information:

Table 1 Additional manuals

Manual
Ordering 
number

7310 Lector and Scriptor getting started manual M 294 310

2201 ProLock user’s guide M 290 003

2303 Stabilock user’s guide M 290 002

3100 Mobile Fault Finder getting started manual M 295 111

3100 Mobile Fault Finder user’s guide M 290 111

4100 Mobile Phone Tester Series user guide M 290 012

4200 Mobile Service Tester Series user guide M 290 013

4300 Mobile Service Tester Series user’s guide M 290 043

4400 Mobile Phone Tester getting started manual M 295 011

4400 Mobile Phone Tester Series user’s guides (various)

Bluetooth Connectivity Test Products user’s guide M 292 018

7201 Update Utility user's guide M 294 001
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Technical assistance 

If you need assistance or have questions related to the use of this product, 
call one of Willtek’s technical assistance centers. You can also contact 
Willtek by e-mail at customer.support@willtek.com.

Conventions

This guide uses naming conventions and symbols, as described in the 
following tables.

Table 2 Technical assistance centers

Region Phone number Fax number

Europe, 
Middle East, 
Asia, Africa

+49 (0)89 99641 311 +49 (0)89 99641 440

Americas +1 973 386 9696 +1 973 386 9191

China +86 21 5836 6669 +86 21 5835 5238

Table 3 Typographical conventions

Description Example

User interface actions appear in 
this typeface.

On the Status bar, click Start.

Buttons or switches that you 
press on a unit appear in this 
TYPEFACE.

Press the ON switch.

Code and output messages 
appear in this typeface.

All results okay

Text you must type exactly as 
shown appears in this type-
face.

Type: a:\set.exe in the dialog 
box.

Variables appear in this <type-
face>.

Type the new <hostname>.

Book references appear in this 
typeface. 

Refer to Newton’s Telecom Dic-
tionary

A vertical bar | means “or”: only 
one option can appear in a single 
command.

platform [a|b|e]

Square brackets [ ] indicate an 
optional argument.

login [platform name]

Slanted brackets < > group 
required arguments.

<password>
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Table 4 Keyboard and menu conventions 

Description Example

A plus sign + indicates simultane-
ous keystrokes.

Press Ctrl+s

A comma indicates consecutive 
keystrokes.

Press Alt+f,s

A slanted bracket indicates 
choosing a submenu from menu.

On the menu bar, click 
Start > Program Files.
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Chapter 1 Overview

This chapter provides a general description of the Lector and Scriptor. Topics 
discussed in this chapter include the following: 

– “About Lector and Scriptor” on page 2

– “Features and capabilities” on page 3

– “Delivery” on page 4
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About Lector and Scriptor

Willtek’s Lector and Scriptor software is an economical solution for service 
centres and repair shops testing returned mobile phones. Running on a PC, 
the software provides an easy-to-use interface to the 4100 Series Mobile 
Phone Testers (requires Lector Enhanced or Scriptor), the 4200 and 4300 
Series Mobile Service Testers (both require Lector Enhanced or Scriptor), the 
3100 Mobile Fault Finder and the 4400 Series Mobile Phone Testers. 

Willtek’s family of test automation programs provides a scalable test solu-
tion for different applications around wireless device testing. It fits the 
needs of test operators and administrators in large service centres as well 
as in small repair shops. The members of this family are:

– 7311 Lector Basic  – Carry out automated measurements with simple 
pass/fail indication and more detailed test reports! (free of charge)

– 7312 Lector Enhanced  – Analyze test reports in more detail!

– 7315 Scriptor  – Edit and define test scripts and limits, and add new 
mobile phone models with coupling factors!

– 7360 Coupling Factor Update License  – Update your database of 
coupling factors for new mobile phone models over the Internet; the 1-
year license is available for use with 7312 Lector Enhanced and 7315 
Scriptor

– 7361 Bluetooth Connectivity Test License – Additionally check if the 
Bluetooth module of the phone is performing! This option adds Blue-
tooth Go/NoGo tests for instruments which do not support it inherently, 
like the 4100 and 4200 series instruments. With the 7361 Bluetooth 
Connectivity Test License, the 4941 Bluetooth Hardware can be 
connected directly to the PC.

Using one of these instruments and Lector on a PC, service and repair 
centres easily can check the performance of returned mobile phones. The 
system automatically recognises the phone type, and it can test single, dual, 
triple and quad band models.  All major RF parameters are measured 
against specifications, and audio tests check microphone and speaker func-
tionality. Results can be stored in a database for analysis or printed for 
reports.

The operator doesn’t have to learn the complexities of WCDMA or 
CDMA2000 testing: The Pass/Fail indication is good enough to filter bad 
from good phones. The accompanying detailed results can be printed or 
stored, and forwarded to the repair technician for fault diagnosis.

Using Scriptor, the test scripts running in Lector can easily be adapted and 
extended to individual needs. Support for GSM, GPRS, EDGE, WCDMA/UMTS, 
HSDPA, CDMA2000, 1xEV-DO mobile phones and TETRA radios is already 
built in.

Lector Basic is a standard accessory to the 3100 Mobile Fault Finder and can 
also be used as a free tool for the other mobile phone testers – just down-
load the software from the Internet!
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Features and capabilities

– Supported instruments: 

– 2201 ProLock

– 3100 Mobile Fault Finder

– 3110 Mobile Service Tester

– 4100 Mobile Fault Finder

– 4200 Mobile Service Tester

– 4300 Mobile Service Tester 

– 4400 Mobile Phone Tester

– 2303 Stabilock TETRA Mobile Station Tester

– Supported technologies:

– GSM, GPRS, EDGE, WCDMA, HSDPA and Bluetooth

– CDMA2000, EVDO, AMPS

– TETRA

– Free version available to run the tests: 7311 Lector Basic

– Coupling factor calculation

– Automatic calculation for GSM, WCDMA, CDMA2000 and TETRA

– Self explaining wizard

– Algorithm for defining the optimum position on the shuttle for GSM 
and WCDMA, with both the standard and the XY shuttle

– Coupling factor editor

– Coupling factor (CPL) database for popular phones included

– 7360 Coupling Factor Update License for one year included

– Monthly update for the latest phones from various vendors

– Online update via Internet

– Multiple installations on one PC for multiprocessing

– Synchronization

– Codes indicating reason for failure

– Different start conditions of test scripts possible

– Test dependent

– Mobile phone dependent (using serial no. indicated in signaling 
protocol)

– TAC dependent (using serial no. read by barcode reader)

– Test result summary available

– Can be stored automatically

– Stores also failure reason codes

– Easy-to-use script editor, mobile list editor, limits editor and X2T editor 
(Scriptor)

– One installation for all types of products (available functionality 
depends on USB dongle)
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Delivery

For 7312 Lector Enhanced and 7315 Scriptor, the software comes on a CD, 
together with a USB dongle. After software installation, the dongle must be 
plugged into a free USB port. See Chapter 2 “Installation” for more details.

For all three products, you can also download the latest Lector and Scriptor 
software from Willtek’s webserver at www.willtek.com. Without an appro-
priate dongle, you can only take advantage of the 7311 Lector Basic 
features.

http://www.willtek.com
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Chapter 2 Installation

This chapter describes how to install Lector and Scriptor. The topics 
discussed in this chapter are as follows:

– “Scope of delivery” on page 6

– “Software requirements” on page 6

– “Hardware requirements” on page 7

– “Installing the software” on page 7

– “Setting up the hardware” on page 9

– “Working with a network license” on page 11

– “Configuring the software” on page 12

– “Testing the connection setup” on page 14

– “Updating or upgrading software licenses” on page 15
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Scope of delivery

Lector and Scriptor come on a CD with an installation program. The installa-
tion includes the driver software necessary to control a 2201 ProLock, a 
3100 Mobile Fault Finder or a 4400 Series Mobile Phone Tester via USB.

Software requirements

Lector and Scriptor can be installed and run on every PC with Microsoft 
Windows NT, Windows 2000, Windows XP or Windows Vista. You will need 
to log in with administrator rights to install the software.

Table 1 shows which instruments are supported and by which member of 
the Lector and Scriptor family of test automation products.

To control a 4400 Series Mobile Phone Tester, the instrument will need firm-
ware version 6.20 or higher. In order to take advantage of all the latest 
features, the latest firmware is required.

To control a 3100 Mobile Fault Finder, the instrument will need firmware 
version 15.00 or higher. In order to take advantage of all the latest features, 
the latest firmware is required.

To make use of the Bluetooth and the Intersystem Handover capabilities, 
software version 15.00 or higher of the 4400 or 3100 is required.

Table 1 Supported instruments vs. Lector-Scriptor versions

7311 
Lector Basic

7312
Lector 

Enhanced

7315 
Scriptor

2201 ProLock

2303 Stabilocka

a. Remote control by Lector or Scriptor quires the 2331 Autotest Option to be installed

3100

3110

4100 Series –

4200 Series –

4300 Series –

4400 Series
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Hardware requirements

Before installing Lector and Scriptor on a PC, make sure that the PC has

– at least 60 Mb of free hard disk space

– a CD drive

– a free RS-232 or USB port (for initial setup of the 3100 Mobile Fault 
Finder)

– a free USB port for the USB dongle if you want to install 7312 Lector 
Enhanced and 7315 Scriptor

– a screen size of at least 1024 x 768 pixels

In addition, the PC needs an interface to the instrument to be controlled. 
Ensure that both the PC and the instrument can be connected using one of 
the following interfaces supported by Lector and Scriptor:

– TCP/IP

– GPIB (National Instruments interface)

– USB

– RS-232

Installing the software

Installing from the Lector

and Scriptor CD

In these directions we assume that you are installing the software from the 
Lector and Scriptor installation CD delivered by Willtek.

1 Insert the CD into the CD drive of the PC.

2 If the installation does not start automatically, use Microsoft Explorer to 
start the AUTORUN.EXE program from the CD.

3 Click on “Install Lector or Scriptor”
The Lector and Scriptor Setup Assistant appears.

4 Follow the instructions on the screen. In particular:

– Select a language for the setup assistant

– Read and accept the license agreement

– Select a folder to install the program files of Lector and Scriptor (e.g. 
“C:\Program files\Willtek\731X Lector-Scriptor”)

– Choose a program group name that will appear under Start > 
Programs (e.g. Willtek)

– Select if you want to have a Lector and Scriptor icon on the Windows 
desktop

– Start the installation process

The Lector and Scriptor program will be installed.
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5 After completion of the Lector and Scriptor installation, the setup 
program asks if you wish to install various drivers. If you want to run 
7312 Lector Enhanced or 7315 Scriptor, enable HASP HL USB dongle 
driver installation. If you are likely to use the USB connection to the 
3100,3110 or 4400, have the setup program install the CP210X USB to 
serial driver. For remote control of the ProLock via USB, select the 
Gadget Serial driver.
If selected, the HASP device driver is started.

6 Confirm the Welcome menu and the license agreement.
The HASP device driver is installed. Depending on the dongle installed, 
you may now be able to use the 7311 Lector or 7315 Scriptor features.

7 For 3100, 3110 and 4400: If selected, the Wizard for CP210X USB to 
UART Bridge Controller Driver appears. Follow the instructions on the 
screen.
The USB driver will be installed, typically in C:\SiLabs. After completion, 
you will be able to control the instrument via USB.

8 For 2201 ProLock: If selected the Gadget Serial installation wizard 
appears. Follow the instructions on the screen.
The USB driver will be installed. After completion, you will be able to 
control the ProLock via USB.

Installing from other

media

These instructions are applicable to an installation from either the Manual 
CD that is delivered with Willtek products, or from a downloaded file:

1 Call up the setup program for Lector and Scriptor.

2 Follow the instructions on the screen. In particular:

– Select a language for the setup assistant.

– Read and accept the license agreement.

– Select a folder to install the program files of Lector and Scriptor (e.g. 
“C:\Program files\Willtek\731X Lector-Scriptor”).

– Choose a program group name that will appear under Start > 
Programs (e.g. Willtek).

– Select if you want to have a Lector and Scriptor icon on the Windows 
desktop.

– Start the installation process.

The Lector and Scriptor program will be installed.

3 After completion of the Lector and Scriptor installation, the setup 
program asks if you wish to install the USB drivers. If you want to run 
7312 Lector Enhanced or 7315 Scriptor, enable HASP HL USB dongle 
driver installation. If you are likely to use the USB connection to the 
3100 or 4400, have the setup program install the USB to serial driver.
If selected, the HASP device driver is started.

4 Confirm the Welcome menu and the license agreement.
The HASP device driver is installed. Depending on the dongle installed, 
you may now be able to use the 7311 Lector or 7315 Scriptor features.
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5 The Wizard for CP210X USB to UART Bridge Controller Driver appears. 
Follow the instructions on the screen.
The USB driver will be installed, typically in C:\SiLabs. After completion, 
you will be able to control the instrument via USB.

Setting up the hardware

Before starting a test, the PC should be connected to the instrument and the 
USB dongle should be installed (Lector Enhanced and Scriptor only). The 
table below summarizes the remote control interfaces supported.

Please note the following particularities.

2201 ProLock The ProLock can be controlled by 7311 Lector Basic, 7312 Lector Enhanced 
or 7315 Scriptor. The interfaces available for remote control are LAN (TCP/
IP), USB and RS-232.

If you want to control the instrument via USB, you should select to install 
the Gadget Serial driver with the software.

2303 Stabilock The Stabilock can be controlled by 7311 Lector Basic, 7312 Lector Enhanced 
or 7315 Scriptor. The interface available for remote control is LAN (TCP/IP); 
see “TCP/IP” on page 10. The 2331 Autotest Option must be installed in the 
Stabilock.

Table 2 Interfaces supported by the instrument types

RS-232/USB TCP/IP GPIB

2201 ProLock –

2303 Stabilocka

a. Remote control by Lector or Scriptor quires the 2331 Autotest Option to be installed

– –

3100 b

b. Optional (3180 GPIB - IEEE 488.2 Option required)

3110 –

4100 series – –

4200 series – –

4300 series –

4400 series c

c. Instruments with a serial number below 0911001 require the 4478 TCP/IP Option
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3100 Mobile Fault Finder The 3100 Mobile Fault Finder supports remote control via TCP/IP, GPIB, USB 
and RS-232. 

If the 3100 shall be controlled via TCP/IP, a connection via USB or RS-232 
must be established at first-time use because the 3100 must be 
programmed with a valid IP address. You can find out the IP address by 
connecting the 3100 over the USB first; the Connection > Check Connec-
tion menu will show you the IP address.

If the 3100 shall be controlled via GPIB, a connection via USB or RS-232 
must be established at first-time use because the 3100 must be 
programmed with a valid GPIB address. See the manual for the 7201 
Update Utility for more information.

3110 Mobile Service

Tester

The 3110 Mobile Service Tester supports remote control via TCP/IP,  USB and 
RS-232. 

Series 4100 Mobile Phone

Testers

The Series 4100 testers can be controlled by 7312 Lector Enhanced or 7315 
Scriptor via a serial interface (RS-232).

Series 4200 Mobile

Service Testers

The Series 4200 testers can be controlled by 7312 Lector Enhanced or 7315 
Scriptor via a serial interface (RS-232).

Series 4300 Mobile

Service Testers

The CDMA and AMPS versions of the Series 4300 testers can be controlled 
by 7312 Lector Enhanced or 7315 Scriptor via GPIB or a serial interface (RS-
232).

4400 Mobile Phone Tester

Series

Instruments from the 4400 Mobile Phone Tester Series support remote 
control via GPIB and, depending on the status of the instrument and the 
installed options, via TCP/IP and USB. 

TCP/IP The LAN connector of your instrument can be connected with the PC in two 
different ways:

– Existing TCP/IP network with router or hub: Use a CAT5 or CAT6 LAN 
cable to connect the instrument to the LAN. Similarly, also connect the 
PC to the LAN.

– Point-to-point connection: Use a crossed-line LAN cable to directly 
connect the instrument to the PC.
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Lector Enhanced and

Scriptor

To make use of the advanced features of 7312 Lector Enhanced and 7315 
Scriptor, the USB dongle provided as part of the product must be installed.

After installing, but before running the software, slide the USB dongle into 
a free USB port of the PC.
After starting the Lector and Scriptor software, the title bar of the Lector or 
Scriptor menu should indicate the name of the product you have purchased, 
i.e. either “7312 Lector Enhanced” or “Willtek 7315 Scriptor”.

Working with a network license

Lector Enhanced is also available with a network license with the following 
advantages:

– Central management of the software license for 7312 Lector Enhanced 
and 7360 Coupling Factor Update License for multiple users

– Purchasing several a network license for several computers can be 
cheaper than individual licenses for each computer

– Individual dongles may get lost, whereas a dongle on a server in a sepa-
rate IT room is usually safe

Procedure 1 Install the Lector software (version 4.00 or higher) and the HASP 
dongle driver on all the PCs in the network that will either run Lector or 
serve as the network license host. 

2 Connect the network dongle to a free USB port on that PC.
The network license(s) should now be available to all other PCs on the 
network running Lector version 4.00 or higher.

3 Take the following steps if you want to ensure that the dongle is prop-
erly installed and accessible to other computers on the network:

a On the PC with the network dongle (the network license host), open 
a web browser and call up http://localhost:1947.
If the dongle is properly connected, the HASP License Manager will 
appear in the web browser. Click on HASP Keys to see on which PC 
the dongle is installed; the PC name is shown in the Location column. 

b On a different PC on the same LAN, call up http://localhost:1947.
If the PC is connected to the network license host over the LAN (or a 
VPN tunnel see below), the HASP License Manager will appear in the 
web browser.
If the HASP License Manager does not load, check the LAN connec-
tion to the network license host using one of the command line 
programs PING and TRACERT, with the name of the network license 
host PC name as a command line argument.

4 Run Lector on as many computers as copies are available on the 
network dongle!
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Particularities Only one computer (the network license host) on the local area network 
requires a dongle, the other computers automatically obtain their license 
information over the network. The network dongle is available for a 
maximum number of users; each PC requesting a network license decreases 
the number of licenses left for other computers. If a user exits the Lector 
software then the license becomes available for another user. If a computer 
running Lector is switched off without properly closing Lector, the license 
will time out after a few minutes.

Individual users can be blocked or admitted, and the usage and availability 
of licenses can be checked over the network using the HASP License 
Manager. The software can be called up with a web browser using the 
following address: 
http://localhost:1947
The HASP License Manager software includes a Help button with detailed 
information about how to use the software.

If a PC requiring a license is not connected to the LAN with the network 
license host, you can connect them over a Virtual Private Network (VPN).

Configuring the software

Lector and Scriptor can be set up to communicate with several different 
instruments over different connections. Only one instrument, however, can 
be used at any time while Lector is running. 

The connections need to be defined and the active instrument must be 
selected as follows:

1 In Lector and Scriptor, select Connection > Define Interface.
The Connection box appears.

2 In the first column, select the instrument (device) to be used with 
Lector and Scriptor for the next test. If no device has been defined as 
yet, select the first one and fill out the device information according to 
the table below.

3 Confirm your changes by selecting OK.
The PC will try to set up a connection with the tester and inform you if 
the attempt was successful.

Network license host requirements

The computer holding the network dongle must be switched on and con-
nected to the LAN in order for the network license to be available to 
other computers on the same LAN.
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Each device can be defined as follows by selecting the appropriate entries:

Table 3 Transport input fields in the Connection menu

Transport 
type

Parameters Remarks

USB/
RS-232

COM port 
(range 1 – 99)

Baud rate (in kbps)

Handshake protocol 
(Xon/Xoff, RTS, 
None)

For RS-232 connections, use the 
physical COM port number. 

The physical USB port is rerouted 
to a logical RS-232 port number. 
Once a 3100 or 4400 is con-
nected to the PC via USB, the 
port number is automatically 
assigned and can be looked up in 
the Windows environment at 
Start > Control Panel > System 
> Hardware > Device Manager > 
Ports. It should then be copied 
to the COM port input field.
Default values:  COM1, 
115200 bit/s, None.

TCP/IP IP Address

Port

The IP address must be selected 
in line with the local area net-
work policies. This must be the 
same address as selected on the 
3100 or 4400. Each address 
must exist only once within the 
network.
See “Finding the TCP/IP address” 
on page 14. 

The port number indicates the 
logical port for the software.
Default port is 49200. 
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Testing the connection setup

When you are not sure if a connection to a tester is still operational, you can 
check the connection (including the setup parameters) by selecting 
Connection > Check Connection.

The PC will try to establish a connection to the instrument marked as Active 
in the Connection > Define Interface menu. If successful, a box pops up 
showing the instrument type found, together with its serial number, firm-
ware version number and address (see below).

Finding the TCP/IP address

If you want to use the LAN (TCP/IP) connection to control the instrument, 
you need to find out the IP address first. If the network uses DHCP (Dynamic 
Host Configuration Protocol), the address is dynamically assigned by an 
address server and may change after the instrument is rebooted.

The current IP address can be found out in several ways:

– With Lector and Scriptor, set up an RS-232 or USB connection. Check the 
connection as described in “Testing the connection setup” on page 14. 
If the connection is established, the pop-up box confirming the connec-
tion will also show the current IP address along with the instrument 
type, serial number and software version number.

– In the 4400, you will find the IP address in the TOOLS > Config > I/O 
menu.

– You can also use the 7201 Update Utility to check the IP address. See 
separate manual for the utility.

– In the 2201 ProLock, you will find the IP address in the start menu and 
in the Config menu.

GPIB GPIB Address (range 
1 – 31)

This should be identical with the 
GPIB address of the instrument.
Default: 4.

Table 3 Transport input fields in the Connection menu 

Transport 
type

Parameters Remarks
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Updating or upgrading software licenses

The Lector and Scriptor family of wireless automation programs includes 
the 7312 Lector Enhanced, 7315 Scriptor and the 7360 Coupling Factor 
Update License. These are dongle-protected. If you are updating the 
Coupling Factor Update License or upgrading to 7315 Scriptor and already 
have a dongle, this can easily be done without shipping a new dongle or 
even returning the old dongle. You will simply be asked to send your current 
license code in a file, and receive a new one.

Creating a license data

file

When you are asked to send the license data file, proceed as follows:

1 Connect the Willtek dongle to the PC.

2 Start Lector or Scriptor.

3 Klick on Extras > License > Export. 
The C2V Export menu pops up.

4 Select a path (folder) where the file should be stored locally.

5 Click Export.
A new file with file name extension C2V is created in that folder.

6 Send an e-mail to the address that you received and attach the C2V file.
You will receive a new license data file from Willtek.

Updating the dongle with

the new license

When you receive an e-mail with the new license file, you can update the 
Willtek dongle as follows.

1 Store the license file from the e-mail in a folder on the local hard disk. 
The file should have the file name extension C2V.

2 Connect the Willtek dongle to the PC.

3 Start Lector or Scriptor.

4 Klick on Extras > License > Import. 
The V2C Import menu pops up.

5 Select the path (folder) where the received V2C file is stored locally.

6 Click Import.
The file is read and the information in the dongle is overwritten with 
the new license information. When finished you can close Lector or 
Scriptor, open it again and use the license.
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Chapter 3 Running a Test

This chapter describes how to run a predefined test. These topics are 
covered in the following chapters: 

– “Starting Lector” on page 18

– “Getting started” on page 18

– “Selecting a test” on page 19

– “Carrying out a test” on page 22

– “Reading and interpreting test results” on page 25

– “Troubleshooting” on page 26
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Starting Lector

Lector can be started by selecting 731X Lector-Scriptor from the Start > 
Programs > Willtek > 731X Lector-Scriptor menu. Alternatively, double-
click the 731X Lector-Scriptor icon on the Windows desktop if installed.
As a result, the Lector program window appears.

Getting started

This section describes the basic user interface elements that can be found 
in all three versions of the Lector and Scriptor family of automation soft-
ware.

The main elements of the Lector and Scriptor program window include

– the horizontal menu bar at the top to open pull-down menus

– a number of tabs (four in Lector Basic, more in the other program 
versions) for different menus

Menu bar The menu bar at the top of the program window allows you to stop a 
running test, to lock the configuration against changes, to set up the printer 
and to configure and test the connection to an instrument.

To select one of these menu entries

– either klick on the respective entry in the menu, then klick on the appro-
priate entry in the pull-down menu that opened upon the first klick, 

– or key in Alt, then the underscored letter for the menu to select, then 
use the cursor keys to move the highlight bar in the pull-down menu to 
the desired entry, and press RETURN.
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Tabs There are least four horizontally aligned tabs (Configuration, Running, 
Report Summary, Calculate CPL) in the program window. A click on one of 
the tabs changes the display and buttons in the area below (input/output 
section). See the next sections for details on how to use the different tabs.

Selecting a test

There is a large variety of different types of phones for different cellular 
standards (such as GSM, WCDMA, CDMA etc) and for different frequency 
bands on the market. Before measurements can be started, a test must be 
selected.

To ease the selection, the tests are grouped into different categories. Each 
Group can have one or more Subgroups, which in turn consist of individual 
Test Scripts. 

While the number of tests can easily be extended with Scriptor, there are 
already several default groups and test scripts available with Lector and 
Scriptor (if the respective mode is enabled under Program > Phones Config 
> Activate...). These tests are (subject to change and amendment):

Table 4 Default test scripts delivered with Lector and Scriptor

Group Subgroup Test Script

CDMA/EVDO 01.CDMA-Dual C2_DUAL_ST.RBT

C2_DUAL_LT.RBT

02.CDMA-US800 C2_US800_ST.RBT

C2_US800_LT.RBT

03.CDMA-USPCS C2_USPCS_ST.RBT

C2_USPCS_LT.RBT

04.CDMA-KOREAN C2_KPCS_ST.RBT

C2_KPCS_LT.RBT

05.CDMA-NMT450 C2_450_ST.RBT

C2_450_LT.RBT

06.EVDO+CDMA EVC2_US800_ST.RBT

EVC2_US800_LT.RBT

EVC2_USPCS_ST.RBT

EVC2_USPCS_LT.RBT

EVC2_DUAL_ST.RBT

EVC2_DUAL_LT.RBT

EVC2_KPCS_ST.RBT
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EVC2_KPCS_LT.RBT

EVC2_450_ST.RBT

EVC2_450_LT.RBT

07.EVDO-ONLY EV_US800_ST.RBT

EV_US800_LT.RBT

EV_USPCS_ST.RBT

EV_USPCS_LT.RBT

EV_KPCS_ST.RBT

EV_KPCS_LT.RBT

EV_450_ST.RBT

EV_450_LT.RBT

EV_DUAL_ST.RBT

EV_DUAL_LT.RBT

08.MEID2TEST MEID2TEST.X2T

GSM/WCDMA 01.GSM SINGLE-BAND GS_S90.RBT

GS_S18.RBT

GS_S19.RBT

GS_S85.RBT

02.GSM DUAL-BAND GS_D9018.RBT

GS_D8519.RBT

03.GSM TRI-BAND GS_T901819.RBT

GS_T851918.RBT

04.GSM QUAD-BAND GS_Q.RBT

05.WCDMA WC_ST.RBT

WC_LT.RBT

WC2_ST.RBT

WC2_LT.RBT

WC5_ST.RBT

WC5_LT.RBT

WC25_ST.RBT

WC25_LT.RBT

WC125_ST.RBT

WC125_LT.RBT

06.WCDMA;HSDPA WH_ST.RBT

07.WCDMA;GSM WG_D9018_ST.RBT

Table 4 Default test scripts delivered with Lector and Scriptor
 (Continued)

Group Subgroup Test Script
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Abbreviations used:

– C2: CDMA2000 standard

– EV: 1xEV-DO standard

– GS: GSM standard

– GP: GSM standard including GPRS

– GE: GSM standard including EGPRS

– H: HSDPA extension of WCDMA standard

– WC: WCDMA standard (UMTS FDD)

– WG: WCDMA standard and GSM standard

WG_D9018_LT.RBT

WG_T901819_ST.RBT

WG_T901819_ST.RBT

W25G_D8519_ST.RBT

W25G_D8519_LT.RBT

W125G_Q_ST.RBT

W125G_Q_LT.RBT

08.WCDMA;GSM;EDGE WGE_D9018_ST.RBT

WGE_D9018_LT.RBT

W25GE_D8519_ST.RBT

W25GE_D8519_LT.RBT

W125GE_Q_ST.RBT

W125GE_Q_LT.RBT

09.WCDMA;GSM;HSDPA WGH_D9018_ST.RBT

10.GSM;EDGE GE_D9018.RBT

GE_D8519.RBT

GE_T901819.RBT

11.GPRS GP_S90.RBT

GP_S18.RBT

GP_S85.RBT

GP_S19.RBT

GP_D9018.RBT

GP_D8519.RBT

12.TAC2TEST TAC2TEST.X2T

TETRA EXAMPLE TETRA_TTM_BER.RBT

TETRA_TMO_4.RBT

Table 4 Default test scripts delivered with Lector and Scriptor
 (Continued)

Group Subgroup Test Script
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– WGE: WCDMA standard and GSM standard including EGPRS

– TTM: TETRA Test Mode

– TMO: Trunked Mode Operation

– US800: US-800 frequency band used in North America

– USPCS: US-PCS frequency band used in North America

– DUAL: dual-band (US-800 and US-PCS)

– 450: NMT-450 frequency band

– KPCS: Korean PCS frequency band

– S: single frequency band

– D: dual frequency band

– T: triple frequency band

– Q: quadruple frequency band

– 18: 1800 MHz frequency band

– 19: 1900 MHz frequency band (North America)

– 85: 850 MHz frequency band (North America)

– 90: 900 MHz frequency band

– ST: Short test (one channel per band)

– LT: Long test (three channels per band, additional tests)

Willtek may offer updates and additional test scripts and configuration files 
available on its website www.willtek.com in the Lector and Scriptor Down-
loads section.

Carrying out a test

Starting and stopping a

test

To run a test, proceed as follows:

1 Select a test script in the Running input/output section, as described in 
“Selecting a test” on page 19.

2 In the Running input/output section, move the mouse pointer over the 
Run Test Script button.
The connection type currently selected is displayed. Check the details 
and, if necessary, change them under Connection > Change Interface. 

3 Click on Run Test Script.
The test will start, the instrument will set up a connection with the 
mobile phone and take various measurements. Lector and Scriptor will 

Note

TAC2TEST is a special case where the type of test is determined by the 
TAC (Type Approval Code) that is part of the mobile phone’s serial num-
ber. Please refer to Chapter 9 “X2TEST Editor”.

http://www.willtek.com
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keep you informed about the progress (see example below). During the 
test, you may be asked to switch on the phone or to speak into the 
microphone and check the audio receiver.

4 To stop a test, click on the Stop Test Script button on the Running tab.

At the end of the test, the software will show an overview of the results, 
together with a Pass or Fail statement. Depending on the selections made 
in the General configuration group in the Configuration tab menu (see 
sections “Save Test Result” on page 37 and “Print Test Result” on page 37), 
the results can be printed and/or stored on a media device. 

Messages and queries

during the test

During the test you may be asked to switch on the phone, answer a call and 
many other things. The following subsections highlight a few messages and 
queries that are not so obvious.

Assign TAC to an existing
mobile phone

This message appears as part of a dialog box when the type of mobile 
phone under test cannot be found. This may happen either with a phone 
that is not included in the database of mobile phones at all, or with a phone 
that has multiple TACs (Type Approval Code, part of the serial number (IMEI) 
in GSM and WCDMA phones) but not all of them are in the database yet.

If the phone model is not yet stored in the database, click on Cancel.
An error message will be stored in the results log file because there are no 
coupling factors available for proper measurements.

If the phone model is stored in the database:

1 Select the manufacturer or database from the Selected Manufacturer/
Database selection field. 
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2 Select the mobile phone model from the Select Mobile Phone selection 
field. As you scroll through the list of phones, the respective phone will 
be displayed in the dialog box, making it easier to choose the right one.

3 Click on Assign.
A warning will be stored in the results log file because the assignment 
of the mobile phone may potentially be wrong.
The TAC and the associated mobile phone model name will be stored in 
file USERTAC.DAT, and can be deleted from that file again if necessary.

IMEI Comparison Failed This message appears as part of a dialog box when the IMEI reported by the 
phone and the one entered by the user do not match (particularly in 
TAC2TEST).

Click on Stop Test if you are unsure why the IMEI is not correct or if you 
suppose that the IMEI has been entered incorrectly.
The test will be stopped.

Click on Continue Test if you want to proceed with testing anyway.
The test will be continued, but the test will be considered as failed.

Click on Swap Phone if you changed the IMEI on purpose.
The test will be continued, and the results log will indicate that the IMEI has 
been changed, i.e. a SWAP will be stored instead of PASS or FAIL.
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Reading and interpreting test results

Once a test has been started, the Result output section of the Running tab 
provides information about the progress, see picture below.

In the tabular results output, text in blue color indicates instrument param-
eters which are being set up by the software. 
Text in green or red color shows test parameters, their limits and the actual 
test result. The test result translates into a test verdict which is indicated at 
the right-hand side. A passed test is shown in green while a failed test test 
is indicated in red.

The progress is also shown in the Test Status area of the Running tab. A 
large PASS or FAIL shows all the tests in the Test Script have been passed or 
not.

Viewing the test report

summary

The software can also display a summary of all the tests performed since 
Lector or Scriptor has been started. (Note that this results summary may be 
lost when you close Lector or Scriptor, unless you store the table in a file.)

Click on the Report Summary tab to see a list of previously tested mobile 
phones with test script name, serial number of the phone and verdict.

You can view the summary sorted by e.g. date, serial number or test script: 
Just click on the respective header in the table and the result summaries will 
be sorted alphanumerically.

Note

The IMEI comparison (and consequent error messages) can be switched 
off in the Configuration tab, see section “IMEI Comparison” on page 36.
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Double-click on a line to open the detailed test report. This requires that the 
test report was stored previously. A test report can be stored by setting 
parameter Save to “Always” in the Configuration > General menu.

You can add a comment that is displayed at the right-hand side of the line 
by double-clicking into this field. This comment field can be useful to explain 
aborted or failed tests.

In addition to a simple Pass or Fail verdict, the report summary also displays 
a failure code indicating the part of the test which failed. The failure code is 
composed of two parts as detailed in “Display of Failure Codes” on page 38.

The summary can be printed or saved to a file using the appropriate buttons 
on the Report Summary tab. The report summary can be saved on disk in 
either pure text format or in CSV format (comma-separated values). The 
latter can easily be imported into a spreadsheet (e.g. Microsoft Excel) for 
further processing.

If Lector or Scriptor is closed and restarted on the same day, the previous 
results of tests from the same day will appear in the summary if the Report 
Summary Storage parameter on the Configuration tab is set to 
Date(DD.MM.YYYY).csv. See “Report Summary Storage” on page 33 for 
more information.

Troubleshooting

If you experience problems with Lector, please refer to one of the Technical 
Assistance Centers (TAC) (see page xi). 

If you call the TAC, please keep the following information at hand:

– Problem description

– Log file log.txt from the program installation folder, including the type 
and serial number of instrument and the version number of Lector or 
Scriptor. Lector logs the SCPI commands executed during the last appli-
cation run into file log.txt. The log file can be loaded to a file viewer 
from within Lector or Scriptor by clicking Help > Troubleshooting > 
Show Logfile.

– Installed options on the tester

– Script file

– Result file

Alternatively, if you request help from customer support by e-mail, you can 
generate a ZIP file with useful information that can be sent along with the 
problem description by clicking Help > Troubleshooting > Collect Data.
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Chapter 4 Configuring The Test Environment

This chapter describes how Lector and Scriptor can be configured to opti-
mally fit the test needs. Topics discussed in this chapter are as follows:

– “Introduction” on page 28

– “General settings” on page 28

– “Frequency band settings” on page 42

– “Finding appropriate GSM channels for testing” on page 46

– “Obtaining software and configuration updates” on page 48

– “Updating ProLock with new coupling factors” on page 54

– “Running multiple instances of Lector or Scriptor” on page 56

– “Changing Lector and Scriptor messages” on page 58
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Introduction

This chapter explains how Lector and Scriptor can be set up from the Config-
uration tab. The various parameters are grouped into general parameters 
and into parameters for the different frequency bands for GSM, WCDMA 
and CDMA including 1xEV-DO.

General settings

This section explains the parameters that can be set up in the General 
configuration group of the Configuration tab.

Test Script Path This parameter determines the folder where Lector and Scriptor will be 
looking for test scripts. New tests should be stored in this folder.

Note on folders

Some of the parameters are folder names. In the default configuration, 
all folders are located in the installation directory (e.g. 
C:\Program files\Willtek\731X Lector-Scriptor\ or one of its subdirecto-
ries. 

Note on protected parameters

If the parameters are greyed out and cannot be changed, they are pass-
word-protected. See section Password below to learn how to make pass-
word-protected parameters accessible again.
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Double-click on the Test Script Path line to change the folder name.
A new window pops up, and you can browse through the drives and folders 
to select another folder. Click on OK to accept the change, or Cancel to 
retain the old setting.

Report Summary Path This parameter determines the folder where Lector and Scriptor will save 
test report summaries. These are stored on user’s request on the Report 
Summary tab or even automatically. The file format of the report summary 
can be defined with the “Report Summary Storage” parameter.

Double-click on the Test Report Path line to change the folder name.
A new window pops up, and you can browse through the drives and folders 
to select another folder. Click on OK to accept the change, or Cancel to 
retain the old setting.

Result Folder Path This parameter determines the folder where Lector and Scriptor will save 
detailed test results as they appear in the Running tab. The results may 
either be saved for each test, or under certain conditions, or never; see the 
Save parameter below.

Double-click on the Result Folder Path line to change the folder name.
A new window pops up, and you can browse through the drives and folders 
to select another folder. Click on OK to accept the change, or Cancel to 
retain the old setting.

GSM/WCDMA Result

Filename

At the end of each test, the results may be stored in a file. This may lead to 
dozens of new files being stored on your harddisk every day. To keep some 
order in the result files, Lector and Scriptor save them in different subdirec-
tories according to a selectable method.

The GSM/WCDMA Result Filename parameter determines the method to 
which the result files are stored; select a method in the scroll box as follows.

.\Date(DD.MM.YYYY)\IMEI.txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate folder for each day, e.g. a test 
performed on December 25, 2008 will be saved in directory 25.12.2008. 
The file name is determined by the phone’s serial number IMEI (Interna-
tional Mobile Equipment Identity); if the same phone is tested multiple 
times, the serial number in the file name is amended by a new letter for each 
new test.

Note on folders

Instead of using the drive and folder defined in the respective parameter 
(such as Test Script Path), you can also store files in different locations. 
Lector and Scriptor remember directories below the one set in the folder 
parameter relative to that, while other directories are stored with their 
absolute location (drive and folder).
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Example: The results of the first test run are stored in a file named 
350170275619713.txt. The results for the second run with the same 
phone are stored in 350170275619713A.txt.

.\Date(YYYY-MM-DD)\IMEI.txt

This selection has the same effect as in .\Date(DD.MM.YYYY)\IMEI.txt 
except that the year in the date of the folder name comes first. This 
sequence is easier to sort by date in the file manager (e.g. Windows 
Explorer).

.\IMEI.txt

Lector and Scriptor store the results in the folder determined with the 
Result Folder Path parameter. The file name is determined by the serial 
number of the mobile phone (the IMEI); if the same phone is tested multiple 
times, the serial number in the file name is amended by a new letter for each 
new test.
Example: The results of the first test run are stored in a file named 
350170275619713.txt. The results for the second run with the same 
phone are stored in 350170275619713A.txt.

.\TAC\SN.txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate folder for each phone model; the 
model is determined by the first digits of the serial number. The file name 
consists of the remaining digits of the serial number. If the same phone is 
tested multiple times, the serial number in the file name is amended by a 
new letter for each new test.
Example: The results of the first test run are stored in a file named 
350170\275619713.txt. The results for the second run with the same 
phone are stored in 350170\275619713A.txt.

.\(Manufacturer)\Date(DD.MM.YYYY)\IMEI.txt

.\(Manufacturer)\Date(YYYY-MM-DD)\IMEI.txt

.\(Manufacturer)\IMEI.txt

.\(Manufacturer)\TAC\SN.txt

With these methods, the date, IMEI or TAC folder becomes a subfolder to a 
folder with the name of the manufacturer or vendor of the respective 
mobile phone.
Example: Nokia\2009-01-31\350170275619713.txt.

.\(ScannedNumber).txt

At the end of the test, a pop-up box requests the serial number of the 
phone. The number can be entered manually or with the help of a barcode 
reader. 
The results are written to a file in the results folder. The file name is identical 
with the scanned number.
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CDMA Result Filename At the end of each test, the results may be stored in a file. This may lead to 
dozens of new files being stored on your harddisk every day. To keep some 
order in the result files, Lector and Scriptor save them in different subdirec-
tories according to the selected method. 

The CDMA Result Filename parameter determines the method to which the 
result files are stored; select a method in the scroll box as follows.

.\Date(DD.MM.YYYY)\ESN(hex).txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate folder for each day, e.g. a test 
performed on December 25, 2008 will be saved in directory 25.12.2008. 
The file name is determined by the Electronic Serial Number (ESN) of the 
mobile phone; the ESN is given in hexadecimal value. If the same phone is 
tested multiple times, the serial number in the file name is amended by a 
new letter for each new test.
Example: The results of the first test run are stored in a file named 
657DC6DE.txt. The results for the second run with the same phone are 
stored in 657DC6DEA.txt.

.\Date(DD.MM.YYYY)\ESN.txt

This has the same effect as above, but the file name includes the ESN in 
decimal rather than hexadecimal format.
Example: The results of the first test run are stored in a file named 
1018242910.txt. The results for the second run with the same phone are 
stored in 1018242910A.txt.

.\Date(YYYY-MM-DD)\ESN(hex).txt

This selection has the same effect as in .\Date(DD.MM.YYYY)\ESN(hex).txt 
except that the year in the date of the folder name comes first. This 
sequence is easier to sort by date in the file manager (e.g. Windows 
Explorer).

.\Date(YYYY-MM-DD)\ESN.txt

This has the same effect as in .\Date(YYYY-MM-DD)\ESN(hex).txt, but the 
file name includes the ESN in decimal rather than hexadecimal format.

.\ESN(hex).txt

Lector and Scriptor store the results in the folder determined with the 
Result Folder Path parameter. The file name is determined by the Electroni 
Serial Number (ESN) of the mobile phone; the ESN is given in hexadecimal 
value. If the same phone is tested multiple times, the serial number in the 
file name is amended by a new letter for each new test.
Example: The results of the first test run are stored in a file named 
657DC6DE.txt. The results for the second run with the same phone are 
stored in 657DC6DEA.txt.
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.\ESN.txt

This has the same effect as in .\Date(YYYY-MM-DD)\ESN(hex).txt, but the 
file name includes the ESN in decimal rather than hexadecimal format.
Example: The results of the first test run are stored in a file named 
1018242910.txt. The results for the second run with the same phone are 
stored in 1018242910A.txt.

TETRA Result Filename At the end of each test, the results may be stored in a file. This may lead to 
dozens of new files being stored on your harddisk every day. To keep some 
order in the result files, Lector and Scriptor save them in different subdirec-
tories according to the selected method. 

The TETRA Result Filename parameter determines the method to which the 
result files are stored; select a method in the scroll box as follows.

.\Date(DD.MM.YYYY)\TEI.txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate folder for each day, e.g. a test 
performed on December 25, 2008 will be saved in directory 25.12.2008. 
The file name is determined by the serial number, i.e. the TETRA Equipment 
Identifier(TEI) of the mobile station; the TEI is given as a 15-digit hexadec-
imal value. If the same TETRA radio is tested multiple times, the serial 
number in the file name is amended by a new letter for each new test.
Example: The results of the first test run are stored in a file named 
1BF45C657DC6DE.txt. The results for the second run with the same radio 
are stored in 1BF45C657DC6DEA.txt.

.\Date(YYYY-MM-DD)\TEI.txt

This selection has the same effect as in .\Date(DD.MM.YYYY)\TEI.txt except 
that the year in the date of the folder name comes first. This sequence is 
easier to sort by date in the file manager (e.g. Windows Explorer).

.\Date(YYYY-MM-DD)\Time(HH-MM-SS).txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate folder for each day, e.g. a test 
performed on December 25, 2008 will be saved in directory 2008-12-25. 
The file name is determined by the time of day of the test, in the format hh-
mm-ss.txt (hours – minutes – seconds).

Note on TEI

Some types of TETRA radios do not support the mandatory protocol for 
requesting and transmitting the TETRA Equipment Identifier (TEI). There-
fore, if the instrument could not determine the TEI but needs it for stor-
ing the test results, Lector will prompt for manual entry of the number. 
The TEI is printed on the back or under the battery of each TETRA radio, 
and can easily be entered with a barcode scanner.
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.\TEI.txt

Lector and Scriptor store the results in the folder determined with the 
Result Folder Path parameter. The file name is determined by the TETRA 
Equipment Identifier (TEI) of the mobile station; the ESN is given as a 15-
digit hexadecimal value. If the same phone is tested multiple times, the 
serial number in the file name is amended by a new letter for each new test.
Example: The results of the first test run are stored in a file named 
1BF45C657DC6DE.txt. The results for the second run with the same phone 
are stored in 1BF45C657DC6DEA.txt.

.\YYYYMMDD-HHMMSS.txt

In the folder determined with the Result Folder Path parameter, Lector and 
Scriptor store the results in a separate file for each test. The file name is 
determined by the day and time of test, in the format YYYYMMDD-
HHMMSS.txt, i.e. year – month – day – hour – minute – second.

Report Summary Storage This field determines the format and the file name in which the results 
summary is automatically stored. The folder where the results summary is 
stored, is determined by the “Report Summary Path” parameter (see 
above).

Date(DD.MM.YYYY).csv

With this selection, the fields of the results summary are separated by 
commas and stored in a file (CSV format, comma-separated values). This 
format can easily be imported into a spreadsheet program such as Microsoft 
Excel, and processed according to individual needs such as sorting by serial 
number or failure codes.

The file name consists of the current date. If you close Lector and Scriptor 
and open it again on the same day, the previous results from that day will 
be shown in the Report Summary section. New results will be appended to 
the file.

Date(DD.MM.YYYY).txt

The results summary is stored in a file in pure text format, containing the 
same information as shown on the screen. 

Fixed csv file

With this selection, the fields of the results summary are separated by 
commas and stored in a file (CSV format, comma-separated values). This 
format can easily be imported into a spreadsheet program such as Microsoft 
Excel, and processed according to individual needs such as sorting by serial 
number or failure codes.

Fixed txt file

The results summary is stored in a file in pure text format, containing the 
same information as shown on the screen. 
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(Manufacturer) Date(DD.MM.YYYY).csv

With this selection, the fields of the results summary are separated by 
commas and stored in a file (CSV format, comma-separated values). This 
format can easily be imported into a spreadsheet program such as Microsoft 
Excel, and processed according to individual needs such as sorting by serial 
number or failure codes. 
The file name is generated from the current date in the format year-month-
date (YYYY-MM-DD). A separate summary file is created for each manufac-
turer and stored in the respective directory. 
Example: Results summaries for Samsung phones tested on January 31, 
2009 are stored in the folder Samsung\2009-01-31.csv.

(Manufacturer) Fixed csv file

The results summary is stored as for Fixed csv file, but separately for each 
manufacturer: For each manufacturer the results summary is stored in a 
folder named after the manufacturer.

Never

With this selection, the results summary is not automatically stored. You 
can, however, store it by clicking the Save as... button.

Result Output Format Lector and Scriptor can write the results into a file in different formats: pure 
text, HTML and XML. The latter is easier to import and interpret by a spread-
sheet or database program.

Select “*.html” for a file format that is easily viewn in a web browser. 
Select “*.html+*.xml” for both the web browser-compatible format and the 
format for postprocessing by a spreadsheet program.
Select “*.txt” if you do not need HTML or XML formatting. Only the text file 
will be written.
Select “*.txt+*.srw” if you want to get the results in a format that is suitable 
for database applications. Please refer to one of Willtek’s technical asssis-
tance centers (see page xi) for more information on this format.
Otherwise, select “*.txt+*.xml”. Both a text file and an XML file will be 
written into the results folder.

Multiple Result File

Naming

This parameter tells Lector and Scriptor how to treat result files when the 
same phone has been tested before. This is particularly useful when files are 
not saved in date folders (see “GSM/WCDMA Result Filename” on page 29 
and “CDMA Result Filename” on page 31).

Select “Multiple files - extension A;B;C;...” if you want to keep older results 
while saving new measurement results from the same phone. A letter is 
added in the file name to distinguish the files. 

Select “Single files only” if you want Lector or Scriptor to overwrite the 
results from a previous test of the same phone.
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Coupler A double-click on this parameter opens a scroll box offering different 
options for the radio frequency (RF) connection being used for the tests.

Cable

Select this option if you connect your mobile phone with the test instru-
ment using an RF cable. This option is useful if you have cables for the 
different types of phones available. The measurement accuracy is best with 
this method, and the effects of interference with other signals are rather 
low. The phone’s antenna, however, is not included in the test. This method 
uses fixed coupling factors for the upper and lower band.

User Connection

Use this option if none of the other options (cable, or 4916, or 4916 with 
4921) is applicable. You will need to define the coupling factors for the 
different types of mobile phones.

4916 Antenna Coupler (Standard Shuttle)

This option is useful because Willtek already delivers the coupling factors 
for many phone models for testing with the 4916 Antenna Coupler with the 
blue shuttle. In tests with the antenna coupler, the antenna is included in 
the test. The power accuracy, however, is comparatively low because the 
exact coupling depends on the environment. Also, there may be interfer-
ence from other phones and the real network that affect the measurement, 
and the power transmitted by the phone during the test may interfere with 
the real network.

4916 Antenna Coupler (XY Shuttle)

This option is useful because Willtek already delivers the coupling factors 
for many phone models for testing with the 4916 Antenna Coupler with the 
green XY shuttle. In tests with the antenna coupler, the antenna is included 
in the test. The power accuracy, however, is comparatively low because the 
exact coupling depends on the environment. Also, there may be interfer-
ence from other phones and the real network that affect the measurement, 
and the power transmitted by the phone during the test may interfere with 
the real network.

4916 Antenna Coupler and 4921 RF Shield (Standard Shuttle)

This option is the best compromise because interference is avoided through 
the 4921 RF Shield, the coupling factor can be determined quite exactly and 
the antenna of the mobile phone is included in the test. It assumes that the 
mobile phone is mounted on a 4916 with the blue shuttle inside the 4921 
RF Shield.

4916 Antenna Coupler and 4921 RF Shield (XY Shuttle)

This option is the best compromise because interference is avoided through 
the 4921 RF Shield, the coupling factor can be determined quite exactly and 
the antenna of the mobile phone is included in the test. It assumes that the 
mobile phone is mounted on a 4916 with the green XY shuttle inside the 
4921 RF Shield.
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Coupling Factor Source There are several ways how to define the coupling factors. Lector and 
Scriptor keep a database of different phone models with their individual 
coupling values in different frequency bands. User-defined coupling values 
are stored separately.

Select one of the following choices from the scroll list:

User Database

With this selection, Lector and Scriptor will look for the phone model and its 
coupling factors in the user-defined database only. 

User Database + Willtek Database

When Lector and Scriptor identify the type of phone, they first look for 
phone-specific data in the user-defined database and if there are no data 
available there, they look them up in the Willtek-provided database.

Willtek Database

With this selection, Lector and Scriptor will look for the phone model and its 
coupling factors only in the database provided by Willtek. 

Willtek Database + User Database

When Lector and Scriptor identify the type of phone, they first look for 
phone-specific data in the Willtek database and if there are no data avail-
able there, they look them up in the user database. 

Bluetooth Test Most of the Willtek-provided tests include a test sequence to check the 
Bluetooth device of the phone. This test requires the Bluetooth Connectivity 
Test Package to be installed in the instrument or in Lector or Scriptor. More 
on Bluetooth connectivity tests can be found in Appendix A. Also, the BLUE-
TOOTH or the BLUETOOTH_DIRECT command must be implemented in the 
respective test script, depending on the instrument. See page 99 for the 
details.
In order to have the test script actually carry out the Bluetooth test, the 
Bluetooth Test parameter must be set to “Enabled”; Lector and Scriptor will 
prompt a message to enable the Bluetooth feature in the phone before the 
Bluetooth test starts. 
If you want Bluetooth tests to be performed without the message, select 
“Enabled (without pop-up messages)”.
The test can easily be disabled again by setting the Bluetooth Test param-
eter to “Disabled”.

IMEI Comparison In GSM and WCDMA tests, Lector and Scriptor can compare the IMEI (serial 
number) transmitted in the signaling protocol with the IMEI entered manu-
ally or with a barcode reader. This feature helps to verify that the serial 
number programmed into the phone matches the one on the sticker. It is 
required that the IMEI_RDCMP command is implemented in the respective 
test script, see page 101.
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Select “Always” if you want the IMEI comparison to be run as part of all the 
tests.

Select “Never” if you do not want the IMEI comparison to be carried out at 
all.

Select “Only TAC2TEST” if you want the IMEI comparison to be run as part 
of the TAC2TEST procedure only.

Save Test Result This parameter determines the conditions under which the test results are 
stored in a file. Double-click on the present parameter value to open a pop-
menu with a scroll list of supported values: 
Select “Always (PASS; FAIL; USER BREAK)” if you want Lector or Scriptor to 
always save the test results automatically.
Select “If Overall result is Fail” if you want the results from only those tests 
to be saved that were not passed.
Select “If Overall result is Pass” if you want the results from only those tests 
to be saved that failed.
Select “If Overall result is Pass or FAIL” if you want the results from all tests 
to be saved, except when the test was interrupted by the user.
Select “Never” if you do not want any results to be saved.
Select “On Request” if you want to determine on a case-by-case basis if 
results should be stored or not. Lector or Scriptor will prompt after each test 
run.
See parameters Result Folder Path and FileNameFormat above about the 
way the results are stored.

Print Test Result After a test, the detailed results can be printed either always, only if passed 
or failed, on request or never. Double-click on the Print parameter line to 
open a scroll box that allows you to change the setting:
Select “Always (PASS; FAIL; USER BREAK)” if you want Lector or Scriptor to 
always print the test results automatically.
Select “If Overall result is Fail” if you want the results from only those tests 
to be printed that were not passed.
Select “If Overall result is Pass” if you want the results from only those tests 
to be printed that failed.
Select “If Overall result is Pass or FAIL” if you want the results from all tests 
to be printed, except when the test was interrupted by the user.
Select “Never” if you do not want any results to be printed.
Select “On Request” if you want to determine on a case-by-case basis if 
results should be printed or not. Lector or Scriptor will prompt after each 
test run.
See parameters Result Folder Path and FileNameFormat above about the 
way the results are stored.

Display Phone

Recognition

Normally, when a test is run and Lector and Scriptor identify a phone model, 
it is useful to have a message indicating which model has been found and 
how to set up the antenna coupler. Select “Always” if you want associated 
pop-up boxes to be displayed.
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If you testing phones of the same model over and over again, you may want 
the pop-up boxes to be omitted. Select “Once” if you only want the box to 
be displayed at the first time. Select “Never” if you do not want the 
messages to be displayed at all.

Display of Failure Codes Lector and Scriptor automatically generate a short failure code when a 
mobile has failed the test. This failure code is shown in the Report Summary 
menu and can also be shown and stored with the test results, depending on 
how this parameter field is set up.

The failure codes can be analyzed to determine a particular trend in the 
mobile phones, e.g. when there are many phones of the same type that fail 
the transmitter or receiver tests. Repetitive occurance of the same failure 
code over all the phones may also indicate a problem with the test setup, 
e.g. with the cabling.

Display options You can select from the following options in the list.

Add To Result

With this selection, the Running menu will include the failure codes at the 
end of the test.

Display Info Box After Test

After completion of the test, a pop-up box will show the failure codes if 
applicable.

Add to Result And Display Info Box

Both of the above options are enabled with this selection.

Display Nothing

At the end of the test, the failure codes are not displayed automatically. 
They are, however, included in the report summary. This selection is the 
default.

Failure codes The failure codes consists of two parts: The first part determines the type 
of test step that failed, and the second part details the technology and 
frequency band. More than one failure code may occur in a test.

The failure codes are composed as follows:
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Table 5 Failure codes in the results summary

Type of test step that failed
Technology and band 
information

0 – Pass

1 – Call dropped

2 – Call not answered

3 – Keyboard error

4 – User break

9 – Other

0 – General error

0 – No answer

7 – Device not ready

9 – Other

1 – Bluetooth

0 – TX failure

1 – RX failure

2 – BER failure

3 – Audio failure

4 – GPRS failure

5 – E-GPRS failure

8 – Handover failure

9 – Other

2 – GSM 850

3 – GSM 900

4 – GSM 1800

5 – GSM 1900

0 – TX failure

1 – RX failure

2 – BER/BLER failure

3 – Audio failure

4 – TX failure in HSDPA mode

5 – RX failure in HSDPA mode

6 – BER/BLER failure in HSDPA mode

8 – Handover failure

9 – Other

6 – WCDMA Band 1

7 – WCDMA Band 2

8 – WCDMA Band 3

9 – WCDMA Band 4

10 – WCDMA Band 5

11 – WCDMA Band 6

12 – WCDMA Band 7

13 – WCDMA Band 8

14 – WCDMA Band 9

15 – WCDMA Band 10

0 – TX failure

1 – RX failure

2 – BER failure

3 – Audio failure

5 – EVDO failure

8 – Handover failure

9 – Other failure

16 – CDMA US800

17 – CDMA US-PCS

18 – CDMA NMT-450

19 – CDMA KPCS

21 – CDMA AWS

0 – TX failure

8 – Handover failure

9 – Other

20 – AMPS
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Example: Failure code 1-6 means that Lector or Scriptor found a problem 
with a receiver test in WCDMA (Band 1), probably with the MS report. 
(Typical RX failures include problems with RX_LEVEL, RX_QUAL, RSCP.)

Stop Test After Fail When a measurement result exceeds the test limits, Lector or Scriptor can 
either continue with the test, e.g. to determine all the problems that occur. 
Or the test may be halted to save time. The Stop Test After Fail parameter 
lets you select which way you want the software to proceed after a problem 
occurred. The selection field lets you choose between No (the test will be 
continued until the end) or After 1st Fail (the test is halted immediately).

IMSI This parameter is applicable for GSM, GPRS, EDGE and WCDMA phones. 
The International Mobile Subscriber Identity (IMSI) is the individual identity 
number of the subscriber in the GSM or UMTS network. The mobile reads the 
IMSI from the SIM card. This parameter is used when calls from the tester 
are established without prior registration, i.e. when the instrument does not 
otherwise know the IMSI of the phone under test. The default IMSI is 001-
01-0123456789; this is the IMSI on Willtek’s test SIM.

Identifier This parameter is used to help identify individual Lector or Scriptor windows 
when running multiple instances of Lector or Scriptor. The instances are 
identified by individual numbers from 1 to 4. See “Running multiple 
instances of Lector or Scriptor” on page 56 for more information.

Test Channel File ID This parameter can be used for frequency planning, where several test 
stations in a service center are centrally managed.
In service centers where Lector configuration files and software updates are 
automatically distributed from a central server, all test stations use the 
same configuration files to ensure proper testing under defined conditions. 
The only wanted deviation may be the set of frequencies used for testing 
because test stations may interfere with each other. To ensure that each 
test station uses its own set of channels, enumerated channel files are 
distributed and each test station is allocated a channel file number. The Test 
Channel File ID set up in this parameter field must correspond to a channel 
file with the same number at the end of the file name. 
Example: The test script refers to a channel file as follows:

0 – TX failure

1 – RX failure

2 – BER or Paging Sensitivity Test failure

8 – Handover failure

9 – Other failure

21 – TETRA 300 MHz

22 – TETRA 400 MHz

23 – TETRA 800 MHz

24 – TETRA 900 MHz

Table 5 Failure codes in the results summary (Continued)

Type of test step that failed
Technology and band 
information
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TEST_CHANNEL, ManufacturerXYZ_Channels.tcf
The server distributes files such as ManufacturerXYZ_Channels_1.tcf, 
ManufacturerXYZ_Channels_2.tcf etc. The test station with the Test 
Channel File ID set to 3 loads the channel list from 
ManufacturerXYZ_Channels_3.tcf.
If Test Channel File ID is set to 0, the ID will be ignored.
See “Frequency band settings” on page 42 for more information about how 
to set up test channel files for the various wireless standards and frequency 
bands.

Password Administrators can protect the configuration data and coupling data from 
unauthorized modification by operators. If protected by a password, the 
configuration or coupling data can be modified only if the password is 
entered.

Locking the configuration data To protect the configuration data from modifications, double-click on Pass-
word.
Lector and Scriptor prompt for a password. A password of arbitrary length 
can be set. The password must consist of Latin characters and Arabic 
numerals only. For a new password you will be prompted to repeat the pass-
word. 
The configuration data are protected against modification with the next 
start of Lector or Scriptor, or if you select Program > Configuration locked.

Unlocking the configuration
data

To unlock the test Configuration section, select Program > Configuration 
locked. You will have to enter the password once more.

In order to undo the password protection, leave the Password entry field 
empty.

Locking the “CPL (GSM/
WCDMA)” tab

You can also protect the CPL (GSM/WCDMA) tab to protect the coupling 
data from modifications. The input/output section will not be accessible 
anymore if the password protection is enabled (see section“Locking the 
configuration data” above).

Select Program > CPL tab locked.
The input/output section of the CPL (GSM/WCDMA) tab will not appear if 
you click on that tab.

Notes

Choose a password that cannot easily be guessed by colleagues. 

Note down the password and store it in a place that is not accessible to 
others because if you forget the password, you will not be able to modify 
the configuration via Lector anymore.
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Unlocking the “CPL (GSM/
WCDMA)” tab

To unlock the input/output section of the CPL (GSM/WCDMA) tab, select 
Program > CPL tab locked. If a password is enabled, Lector or Scriptor will 
prompt for the password.

Frequency band settings

The system and frequency dependent setup menus allow you to configure 
the frequency channels on which the measurements shall be performed. 
Tests are typically performed on three channel pairs: at the band edges and 
in the middle of the band.

Today‘s phones support more than one frequency band. Lector and Scriptor 
allow you to define frequencies for testing in each band.

Select Configuration > Test Channels to change the system and 
frequency-dependent parameters.

Test channel

configurations

Multiple test channel configurations can be defined, saved and loaded. The 
default folder for test channel configuration files is Data\Channels in the 
installation folder of Lector and Scriptor.

In order to load a configuration file, use the selection field “Select a channel 
file”.

After making changes to the channel configuration, click on Save As to 
store the configuration changes (only available in 7315 Scriptor). Select a 
new name to save the channel definition in a separate file, or use the 
previous name to overwrite the previous settings.

Note 

The GSM frequency bands also apply to GPRS and EDGE (EGPRS) tests.
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Comment This parameter field can be used to enter text that is stored with the phone 
configurations while they are exported (Program > Phones Config 
>Export). You can even fill more than one line in the Value column. 
The comment appears on screen when the phone configurations are 
imported.

GSM settings There are three subtypes for the GSM 900 band. The E-GSM 900 band is the 
most popular one and is supported by most GSM phones. If a mobile phone 
does not support the E-GSM frequencies, select a channel numbers from the 
P-GSM band (see Table 6). 

A frequency for the BCCH (Broadcast Control Channel or base channel) must 
be defined separately for each band because the mobile phone will drop a 
test call if the BCCH is not present. The BCCH may be located on one of the 
other test frequencies in the same band.

WCDMA settings The WCDMA setup menus allow you to configure the frequency channels on 
which the measurements shall be performed. Tests are typically performed 
on three channel pairs: at the band edges and in the middle of the band.

WCDMA uses different channel numbers for the uplink (mobile transmit) 
and downlink (base station transmit) directions; see Table 7. There are 
different frequency bands in use with their respective channel numbers.

Table 6 GSM frequency bands

Frequency 
band

Channel 
numbers

Uplink 
frequencies

Downlink 
frequencies

GSM 850 128—251 824—849 MHz 869—894 MHz

P-GSM 900 1—124 890—915 MHz 935—960 MHz

E-GSM 900 975—1023, 
0—124

880—915 MHz 925—960 MHz

R-GSM 900 955—1023, 
0—124

876—915 MHz 921—960 MHz

GSM 1800 512—885 1710—1785 
MHz

1805—1880 
MHz

GSM 1900 512—810 1850—1910 
MHz

1930—1990 
MHz

Table 7 WCDMA frequency bands

Frequency 
band

Uplink channels
Downlink 
channels

Region or 
designation

Band I 9612—9888

(1920—1980 
MHz)

10562—10838

(2110—2170 
MHz)

Europe, 
China, Japan, 
Korea
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Band II 9262—9538,
12, 37, 62, 87, 
112, 137, 162, 
187, 212, 237, 
262, 287

(1850—1910 
MHz)

9662—9938,
412, 437, 462, 
487, 512, 537, 
562, 587, 612, 
637, 662, 687

(1930—1990 
MHz)

North Amer-
ica (PCS 
band)

Band III 937—1288

(1710—1785 
MHz)

1162—1513

(1805—1880 
MHz)

Europe/Asia 
(GSM 1800 
band)

Band IV 1312—1513,
1662, 1687, 
1712, 1737, 
1762, 1787, 
1812, 1837, 
1862

(1710—1775 
MHz)

1537—1738,
1887, 1912, 
1937, 1962, 
1987, 2037, 
2062, 2087

(2110—2155 
MHz)

North Amer-
ica

Band V 4132—4233,
782, 787, 807, 
812, 837, 862

(824—849 MHz)

4357—4458, 
1007, 1012, 
1032, 1037, 
1062, 1087

(869—894 MHz)

North Amer-
ica (US cellu-
lar band)

Band VI 4162—4188,
812, 837

(830—840 MHz)

4387—4413, 
1037, 1062

(875—885 MHz)

Japan

Band VII 2012—2338,
2362, 2387, 
2412, 2437, 
2462, 2487, 
2512, 2537, 
2562, 2587, 
2612, 2637, 
2662, 2687

(2500—2570 
MHz)

2237—2563,
2587, 2612, 
2637, 2662, 
2687, 2712, 
2737, 2762, 
2787, 2812, 
2837, 2862, 
2887, 2912

(2620—2690 
MHz)

UMTS 2600 
(not sup-
ported by 
3100 and 
4400 series)

Band VIII 2712—2863

(880—915 MHz)

2937—3088

(925—960 MHz)

Europe, Asia 
(E-GSM 
band)

Band IX 8762—8912

(1749.9—
1784.9 MHz)

9237—9387

(1844.9—
1879.9 MHz)

Japan

Table 7 WCDMA frequency bands (Continued)

Frequency 
band

Uplink channels
Downlink 
channels

Region or 
designation
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CDMA and 1xEV-DO

settings

CDMA and 1xEV-DO use the same parameters, which depend on the 
frequency band. The parameters that can be affected are the channel 
numbers on which to test, and an additional coupling offset.

Configuring the channels to be
used

CDMA and 1xEV-DO use the same channel numbering system. The channel 
numbers for the different frequency bands can be found in Table 8, while 
more details regarding the frequency numbering is available in Table 9.

Band X 2887—3163, 
3187, 3212, 
3237, 3262, 
3287, 3312, 
3337, 3362, 
3387, 3412, 
3437, 3462

(1710—
1770 MHz)

3112—3388,
3412, 3437, 
3462, 3487, 
3512, 3537, 
3562, 3587, 
3612, 3637, 
3662, 3687

(2110—2170 
MHz)

Table 7 WCDMA frequency bands (Continued)

Frequency 
band

Uplink channels
Downlink 
channels

Region or 
designation

Table 8 CDMA2000 frequency bands

Frequency 
band

Channel 
numbers

Uplink 
frequencies

Downlink 
frequencies

US-800 1–799, 
991–1023

824–849 MHz 869–894 MHz

US-PCS 0–1199 1850–1910 MHz 1930–1990 MHz

Korean PCS 0–599 1750–1780 MHz 1840–1870 MHz

NMT 450 1–300,
539–871,
1039–1473,
1792–2016

411–484 MHz 421–494 MHz

AWS 0–899 1710–1755 MHz 2110–2155 MHz

Table 9 Channel arrangements

Band Channel 
number

Center frequency, 
reverse link (in 
MHz)

Center frequency, 
forward link (in 
MHz)

US-
800

1 to 799

991 to 
1023

.03⋅n + 825

.03⋅(n-1023) + 825

.03⋅n + 870

.03⋅(n-1023) + 870

US-
PCS

0 to 1199 .05⋅n + 1850 .05⋅n + 1930
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TETRA settings There are no general TETRA frequency bands with fixed test channels; 
models are normally built (optimized) to work on a customer-specific 
number of channels. Therefore, the test channels are typically entered in the 
Model Editor for each type of TETRA radio.

Coupling offset This parameter can be used to adjust minor differences in the cable atten-
uation between different test systems. This way, the various test systems 
in a service center can use the same databases containing mobile phone 
configurations and coupling factors, but the coupling factors are finetuned 
locally.

By entering a non-zero value, the coupling factor automatically found can 
be increased by a static factor (for each band). This can be used, for 
example, to compensate an additional coupling loss caused by very long 
cables.

Finding appropriate GSM channels for testing

If you intend to test over the air using an antenna coupler and without 
appropriate shielding, make sure that the measurements are not affected 
by a neighboring test station or the signals from a real network!

Lector and Scriptor can find occupied GSM channels for you, at least for 
nearby base stations transmitting permanently, if you are using a 4100 or 
4200 series instrument:

1 Connect the 4100 or 4200 to the PC running Lector or Scriptor, and 
configure the interface (see Chapter 2 “Installation”).

2 Click on the Configuration tab and select the Test Channels submenu. 
The Test Channels menu appears.

Korean 
PCS

0 to 599 .05⋅n + 1750 .05⋅n + 1840

NMT 
450

1 to 300

539 to 871

1039 to 
1473

1792 to 
2016

.025⋅(n-1) + 450

.025⋅(n-512) + 411

.025⋅(n-1024) + 
451

.025⋅(n-1792) + 
479

.025⋅(n-1) + 460

.025⋅(n-512) + 421

.025⋅(n-1024) + 461

.025⋅(n-1792) + 489

AWS 0 to 899 .05⋅n + 1710 .05⋅n + 2110

Table 9 Channel arrangements (Continued)

Band Channel 
number

Center frequency, 
reverse link (in 
MHz)

Center frequency, 
forward link (in 
MHz)
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3 Click on GSM Channel Scan.
A pop-up menu appears, offering the GSM bands supported.

4 Select the GSM frequency bands that you want to include in the testing, 
and click on Start Scan.
Lector tests the currently selected low, mid and high channels for the 
selected bands for the presence of a base station signal on these chan-
nels. For this purpose, it uses the 4100 and 4200 with the attached 
antenna coupler. If a base station signal is found, the test is repeated on 
a higher or lower channel until a free channel is found. Lector replaces 
the previous entries for the low, mid and high channel by the respective 
free channel. 

Note

Do not forget to save the new test channel settings in a channel file, they 
will be lost once you exit Lector or Scriptor!
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Obtaining software and configuration updates

Overview Lector and Scriptor provide several options to update the software and the 
configuration, and to distribute additional configuration information.

– If you want to frequently check for Lector or Scriptor software updates 
and coupling factor updates (from the 7360 Coupling Factor Update 
License), please refer to “Updating the Lector and Scriptor software and 
the coupling factors” on page 53.

– If you want to share configuration information and test scripts amongst 
a number of test stations connected by a local area network (LAN), 
please refer to “Updating the configuration from a network drive” on 
page 51.
Note: This option is only available for 7312 Lector Enhanced and 7315 
Scriptor.

– If you want to add test scripts that have been provided by a service 
center administrator or a mobile phone vendor, please refer to “Using 
predefined phone configurations” on page 48. With this method, a 
package of test scripts can be created and distributed via e-mail or the 
Internet.

Using predefined phone

configurations

Willtek’s Lector and Scriptor provide the possibility to load a file with 
predefined test scripts. Such a file may be distributed by a phone vendor or 
service center administrator. It contains the test script groups, subgroups 
and scripts required; these test script items will show up in addition to the 
ones already selectable when picking a test in the Running menu. From the 
available number of test scripts, the user can then activate or deactivate 
individual test script groups, e.g. if only a particular group of tests such as 
CDMA tests are required.
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Loading a phone configuration
file

In order to load (import) such a distribution of test scripts, proceed as 
follows:

1 Select Program > Phones Config > Import. 
The Import Phone Configuration box appears.

2 Click on the … symbol and pick a drive, folder and filename containing 
the desired file; select Open.
The selected file is opened and the phone descriptions and test scripts 
items are activated. See sections below on how to select individual test 
script groups.

Activating and deactivating a
test script group

If you want to see more or less test script groups from which a test script 
can be selected, proceed as follows:

1 Select Program > Phones Config > Activate. 
The Activate Displayed Phone Configuration box appears.

2 Check the test script groups that you want to select from in the 
Running menu, and uncheck those that you do not want to see there 
anymore.

3 Click on OK to confirm your selection, or Cancel to undo the changes.
The available groups in the Running menu change accordingly.

Deleting a test script group If you want to delete a test script group, proceed as follows:

1 Select Program > Phones Config > Delete. 
The Delete Phone Configuration box appears.

2 Check the test script groups that you irrevocably want to delete.

3 Click on OK to confirm your selection, or Cancel to undo the changes.
The selected groups are deleted and will not be available anymore.

Compiling a test script
package for distribution

With Scriptor you can put together a group of test scripts for distribution. 
You can pick the files needed, which are then compressed into a file. This file 
can be sent to Lector users who can then load the mobile phone configura-
tions from that file.

The following conditions should be met on the PC that holds the test scripts 
to be distributed:

– The PC should have a 7315 Scriptor license.

– The script files to be distributed should be stored in a separate 
subfolder of the Script directory.

Note

Deleting a test script group is an irreversible step. Once deleted, the test 
script group cannot be undeleted. If you just want it not to show up in 
the menu temporarily, follow the steps in section “Activating and deacti-
vating a test script group”.
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– The file names should differ from the standard script file names.

– Limit files can be added to the distribution, but should have a separate 
name (not the standard limit.lim file).

For each test script group, a separate package needs to be built. To compile 
a test script package for distribution, proceed as follows:

1 In 7315 Scriptor, click Program > 
Phones Config > Export.
The Export Phones Configuration 
menu appears.

2 In the Available Groups section, 
select a test script group.

3 In the Include Additional Data 
section, select one or more 
configuration categories that 
you want to distribute with the 
test scripts.

4 In the Phone Configuration Name 
section, enter a file name and 
folder to which the data shall be 
copied.

5 Click Export.
The data are stored in the 
selected file and folder. The file 
can be passed on for import as 
described in “Loading a phone 
configuration file” on page 49.
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Updating the

configuration from a

network drive

If you have multiple computers running 7312 Lector Enhanced, there may 
be a central file server on which your organization maintains user-defined 
databases for test scripts, test limits, mobile phone configurations, channel 
definitions and user-defined coupling factors. From time to time, the locally 
stored databases should be updated from, or synchronized with, the central 
databases on that network drive.

Files that can be synchronized are listed in “User-defined configuration 
data files” on page 212.

Setting up local
synchronization

In order to be able to read the centrally stored configuration files, Lector 
Enhanced (or Scriptor) needs to know the location of the files on the 
network drive. Set up Lector Enhanced as follows:

1 Select Extras > Synchronize > Sync Settings... to open the Synchroni-
zation Settings pop-up menu.

2 Check the Read Files for Synchronization radio button.

3 If you want Lector to look for local configuration updates each time 
Lector is started, check the Check after Startup box. If you do not want 
Lector to update the configuration each time it is started, uncheck the 
box.

4 If you want Lector to periodically search for configuration updates, 
check the Periodic check box and select an interval at which Lector 
should do it in the Time Cycle pull-down list.

Note

These features require 7312 Lector Enhanced or 7315 Scriptor.

Note

This procedure overwrites the current configuration on the local hard 
disk with the ones on the network drive.
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5 Click on the ... button in the Synchronization Path section of the pop-up 
menu and select a network drive and folder where the user configura-
tion data are stored. Confirm your choice by clicking OK. 

6 Confirm your changes by clicking OK.

Please also refer to “Providing a reference configuration to multiple users” 
on page 210.

Manually starting a local
update

You can start the local update of user-defined configuration data from a 
network drive at any time by selecting Extras > Synchronize > Read Manu-
ally or Read Manually (overwrite all).
If a synchronization path has been set up properly as described in the 
section above, Lector or Scriptor will update the configuration on the local 
PC with the one found on the network drive.

Note

The Read Manually command uses the date and time code to determine 
if the current file version should be replaced by a newer one. 

The Read Manually (overwrite all) command replaces all the current files 
with a version from the network, independent of the date and time code.
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Updating the Lector and

Scriptor software and the

coupling factors

From time to time, Willtek may provide an updated software version, an 
updated help file, or the coupling factor tables (for the 7360 Coupling 
Factor Upgrade License) and script packages on the Internet. Lector and 
Scriptor can be set up to manually load these updates, or even load them 
automatically at given intervals. In service centers with multiple Lector or 
Scriptor installations, the updates can also be loaded from a folder on a 
network drive where the administrator stores them.

Setting up Lector and Scriptor
to load configuration updates

Before an automatic update can be performed, the update should be config-
ured. Lector and Scriptor can be set up to automatically search for configu-
ration updates, and the update source and destination can be defined.

Configuring automatic updates

1 In Lector or Scriptor, select Extras > Update > Update Settings.
The Update Settings pop-up menu appears.

2 Check the “Check after Start” box if you want Lector or Scriptor to auto-
matically search for configuration updates when the program is started.

3 Check the “Periodic check” and select the appropriate “Time Cycle” if 
you want Lector or Scriptor to automatically search for updates at given 
time intervals.

4 Confirm your changes by clicking on OK, or select Cancel to undo the 
changes.
If automatic update checks are enabled and Lector or Scriptor finds a 
new version, the red bar at the botttom will indicate it with a Warning 
symbol (see below). Click on the symbol to open the Online Update 
(Installation) menu. 
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Note that as part of the update checks, Lector and Scriptor can also receive 
messages for you. If a new message is available, a Letter symbol will appear 
on the red bar at the bottom. 

Click on it to read the message.
If you want to read the last message again later on, select Help > Last Infor-
mation Message.

Configuring the update source and destination

1 In Lector or Scriptor, select Extras > Update > Update Settings.
The Update Settings pop-up menu appears.

2 There are three possibilities for the data source and destination.

– If you want to download and install an update directly from Willtek’s 
website, select “Online Update (Installation)” in the Update Method 
section of the pop-up menu.
At the time of the update, Lector or Scriptor will download all the 
configuration files from Willtek’s website that have not yet been 
downloaded, and install them.

– If you want to load and install the update from a local server, select 
“Offline Update”. Enter the network folder where updates are stored 
in the Update Path entry field.
At the time of the update, Lector or Scriptor will load and install all 
the configuration files from the local network folder that have not 
been loaded previously.

– As an administrator, if you want to download updates to make them 
available for all users on a local network, select “Online Update (Copy 
files to update path)”. Also, enter the network folder where updates 
should be stored in the Update Path entry field.
At the time of the update, Lector or Scriptor will download all the 
configuration files from Willtek’s website and store them in the 
update folder on the local computer network.

Updating ProLock with new coupling factors

Advantages and

prerequisites

Willtek’s 2201 ProLock has an integrated database of coupling factors for a 
large number of mobile phones. With these factors, ProLock can take the 
attenuation over the air between the mobile phone and Willtek’s 4916 

Note

If you want to download files from the web to a folder on the local net-
work, you will need write-access rights for that folder.
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Antenna Coupler into account in the measurements and in the RF power 
setup so that the results are correct. The integrated database is useful when 
operating ProLock in manual mode; Lector Enhanced or Scriptor can take 
care of the coupling factors when the tests are operated from the PC.

You can update Willtek’s 2201 ProLock with the coupling factors of the 
latest phone models. The prerequisites are:-

– Willtek 2201 ProLock

– Willtek 7312 Lector Enhanced or 7315 Scriptor (license on a USB-based 
dongle)

– 7360 Coupling Factor Update License (license on a USB-based dongle)

– Internet access

– USB flash drive (delivered with the ProLock)

Procedure The coupling factors in the 2201 ProLock can be updated as follows:

1 Connect the 2201 ProLock to the PC running Lector or Scriptor, either 
through TCP/IP, USB or RS-232, and switch it on.

2 Connect the USB flash drive to the PC.

3 Ensure that the dongle is connected to the PC.

4 Start Lector Enhanced or Scriptor.

5 Ensure that in the Extras > Update > Update Settings menu, either 
Online Update (Installation) or Offline Update is enabled.

6 Select Extras > Update > Check for 2201 CPL Update.
Lector or Scriptor reads the current version of the coupling factor data-
base from ProLock and compares it with the latest version from the 
server. If a new version is available, the following message will be 
displayed.

7 If you want to update ProLock’s database, click on Yes to continue. 
Follow the onscreen directions.
Lector or Scriptor will guide you through the update process.
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Running multiple instances of Lector or Scriptor

Installing and identifying

multiple instances

Service centers running a large number of tests everyday can increase their 
efficiency by having one operator testing multiple phones at the same time. 
What it needs is an appropriate number of test stations (e.g. 3100 Mobile 
Fault Finder with 4916 Antenna Coupler and 4921 RF Shield) and the same 
number of Lector (or Scriptor) installations that may run simultaneously on 
a single PC.
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In order to identify the different Lector instances and keep them apart, you 
can give them different numbers (identifiers, see “Identifier” on page 40). 
The program windows will display the identifier in the top line, with 
different window colors as an additional means to separate them. 

For the purpose of running several instances simultaneously, Lector (or 
Scriptor) must be installed into different folders with individual names for 
the program group. Up to four simultaneous installations are supported.

Applying a compact view Instead of running multiple instances of Lector or Scriptor in four full-size 
windows, you can reduce the window size so that each window shows the 
most important information only. In order to reduce the window size, select 
View > Compact in each Lector or Scriptor window.
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In order to return to the normal window size, click on the Maximize button 
(top-right corner of the window).

Enable View > Use Compact View if you want Lector Enhanced or Scriptor 
to automatically run in compact mode at startup. The Minimize and Maxi-
mize buttons in the top-right corner can be used to switch between 
compact and normal view.

Changing Lector and Scriptor messages

Lector and Scriptor display messages, e.g. prompting for action. The texts 
can be changed by the user, e.g. for localization.

The texts can be found and changed in file Data\Init\SpecialUserEntries.ini 
in the Lector and Scriptor installation folder. Willtek recommends to make a 
backup copy of the file before changing the messages with an editor.

The text in front of the equation mark must not be changed because it indi-
cates to Lector or Scriptor which message the text belongs to.

Note

The compact view feature is available in 7312 Lector Enhanced and 7315 
Scriptor only. 
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Chapter 5 Setting and Determining the Coupling 

Factor

This chapter describes different ways how to set up the coupling factors for 
mobile phones. Topics discussed in this chapter are as follows:

– “Introduction” on page 60

– “Running the Coupling Factor Wizard for GSM, GPRS, EDGE and WCDMA” 
on page 61

– “Running the Coupling Factor Wizard for CDMA, 1xEV-DO and TETRA” on 
page 65

– “Manually changing the coupling factors” on page 65
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Introduction

There are several ways to connect the mobile phone to the tester: An RF 
cable, an antenna coupler like Willtek’s 4916, and the 4916 Antenna 
Coupler in the 4921 RF Shield. Each coupling involves some attenuation of 
the RF signal which has to be taken into account in the RF measurements 
(transmit power, sensitivity).

The coupling factors or coupling data allow Lector and Scriptor to take the 
attenuation between the mobile phone and the tester into account. The 
signals between the two are attenuated both when the phone is connected 
via a cable (attenuation typically in the range 0 to 3 dB) or when it is 
connected via an antenna coupler (attenuation typically in the range 5 to 
35 dB). 

By specifying the coupling factor, Lector and Scriptor can take the raw 
power measurement values or settings and add or subtract the factor. The 
coupling factor or attenuation depends on the type of coupling (cable or 
antenna), the cables and coupler being used, the phone model and the 
frequency. The more exact the coupling factor is given, the more exact the 
test results are. You can, however, work with typical values, at the expense 
of measurement accuracy.

The coupling factor depends on the shape and material of the phone, its 
position relative to the antenna connected to the measuring instrument, 
the environment and the frequency. 

For proper transmit power and receiver measurements, it is essential that 
any attenuation due to device coupling is compensated. As coupling is 
specific to a phone type, the coupling factors are stored with information 
about the mobile phone. 

The following methods are available in Lector and Scriptor to determine the 
coupling factors:

– Database of mobile phones delivered with Lector and Scriptor (Willtek 
database, see section “Coupling Factor Source” on page 36)

– Enhanced Willtek database of mobile phones based on the 7360 
Coupling Factor Update License that can be purchased separately; 
contains most recent phone models and requires 7312 Lector Enhanced 
or 7315 Scriptor (Willtek database, see section “Coupling Factor 
Source” on page 36)

– Coupling Factor Wizard for GSM, GPRS, EDGE and WCDMA phones (user 
database, see section “Running the Coupling Factor Wizard for GSM, 
GPRS, EDGE and WCDMA” on page 61)

– Coupling Factor Wizard for CDMA and 1xEV-DO; only available with 
7315 Scriptor (user database, see section “Running the Coupling Factor 
Wizard for CDMA, 1xEV-DO and TETRA” on page 65)
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Running the Coupling Factor Wizard for GSM, GPRS, EDGE and WCDMA

The Coupling Factor Wizard helps you determine the correct coupling 
factors for the different frequency bands. All that is required is a mobile 
phone that is known to be good – a so-called “golden phone”. The informa-
tion is written into the user database of mobile phones. 

To define the coupling loss values and other parameters of the phone, 
please proceed as follows:

1 Select the CPL (GSM/WCDMA) tab.
The CPL (GSM/WCDMA) input/output section appears (see picture).

2 To start the Coupling Factor Wizard, click on Calculate New Values.
A new window with the Coupling Factor Wizard will pop up, see screen-
shot below.

Note

All coupling factor values previously measured and stored in the user 
database for that mobile phone type will be overwritten.
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3 Select the wireless technologies supported by the phone, and click on 
Next.

4 Select additional technologies that the phone supports and that might 
be tested, then click on Next.

5 Select the coupling method. If you want to connect the phone to the 
tester via an RF cable or if you are using another coupling device that is 
not listed, choose “User Defined Connection”.

6 If Willtek’s 4916 Antenna Coupler is involved in the test you may either 
let the Coupling Factor Wizard select the best position for the antenna 
coupler shuttle (Automatic Position Finding), or you may select the 
position from the scroll field (Manual Position Finding; select “No posi-
tioning used” if the position does not matter). If you do not use a 4916, 
ignore these fields. 

7 Click Next.

Note

Automatic position finding is only available in 7315 Scriptor.
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8 In the next menu appearing, click on ... to select one or two file name(s) 
for the picture(s) of the phone. Prior to that, you can store pictures in 
either BMP, JPG/JPEG or GIF format in folder Data\CPL_DB\Pictures of 
the program installation directory.
The selected picture is shown on the right-hand side.

9 In the Name field, assign a name to the phone – this name will appear 
on the screen during a test and also in the test log.

a Select up to two files with the picture(s) of the mobile phone.

b Click Open to confirm your choice.
The new picture is displayed in the Picture section. If more than one 
have been selected, click on the file name to see the corresponding 
picture.

10 In the Instructions field, enter text that is to be displayed during the 
text, such as “Open the flip phone”. The text can be up to 60 characters 
in length.

11 In the Comment field, you may enter text for your own purposes.

12 Click Next.
The Coupling Factor Wizard now determines the coupling factors with a 
number of measurements. Follow the onscreen instructions.

Note

You can select one or two pictures, e.g. displaying the phone from the 
front and rear to show how a slider must be set up. During the test, the 
picture display will alternate between the two in 1-second intervals.

Note

Keep the CTRL key pressed to select multiple files.
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When completed, the Coupling Factor Wizard displays the coupling 
factors. The table on the left-hand side shows the results of a measure-
ment and the right-hand side table displays coupling factors averaged 
over several measurements (if available).

13 In order to perform another measurement and allow Lector or Scriptor 
to average the results, click on Continue Average. 
The measurements are restarted, i.e. step 12 is repeated. At the end, 
the new measurement results and previous results are averaged.

14 You can view a set of measurement results by selecting the appropriate 
measurement number in the Measurements selection field. Click on 
Delete Measurement to remove a set of results; they will be excluded 
from the averaging.

15 Click on the Save Values button to store the coupling data.
When completed, the Coupling Factor Wizard is terminated and the 
coupling factors are displayed on the Calculate CPL tab menu.

Note

The averaging can be used to get a better result for one phone, or to get 
an average over several phones.
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Running the Coupling Factor Wizard for CDMA, 1xEV-DO and TETRA

The Coupling Factor Wizard for CDMA and TETRA is part of the Model Editor 
menus. The Model Editor is available in 7315 Scriptor. Please refer to 
“Changing the coupling factors” on page 82.

Manually changing the coupling factors

GSM and WCDMA You can change the coupling factors for GSM and WCDMA phones that are 
in the user database of phones. i.e. the mobile phone data must have been 
determined with the help of the Coupling Factor Wizard. To change the 
coupling factors, proceed as follows:

1 Click the CPL (GSM/WCDMA) tab.
The CPL (GSM/WCDMA) input/output section appears.

2 Select the phone in question from the Available User Phones scroll list.

3 Select the action below, depending on the desired change.

– In order to manually adjust the coupling values, select the coupler 
(on the left-hand side) and click on the respective value in the Low, 
Mid or High field for the band and direction at hand. The field 
changes into an entry field; enter the new value and confirm with 
the ENTER key. 

– In order to re-calculate all coupling factors, click on Calculate New 
Values. 
The Coupling Factor Wizard runs again and all previous results are 
overwritten with the new coupling data.

– In order to calculate the coupling factors for a band previously not 
measured, or to re-calculate the coupling factors for one of the 
bands, remember the position on the coupler and click on Add 
Values. 
The Coupling Factor Wizard runs again, but without overwriting 
previous results for unselected bands.

Note

If you use GSM or WCDMA phones with different type approval codes 
(TAC) to take measurements, the averaged results will be stored for both 
TACs.

Note

You may have to repeat the measurements if the coupling values are too 
high because this usually means that the measurement was not success-
ful. Scriptor will prompt you to repeat the measurements in such a case.
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– In order to delete a row with coupling factors for a frequency band 
and direction, mark the appropriate row with the cursor, then click 
on Delete Values.
The row disappears.

– In order to delete all the coupling factors related to a specific coupler, 
click on Delete Coupler.
The coupler entry and the related coupling values disappear from 
the list. 

4 Klick the Save Settings button to store the new coupling values. 

CDMA, EVDO and TETRA Phone definitions to these standards can only be created and edited using 
7315 Scriptor. To change the coupling factors, proceed as follows:

1 Click the Model Editor tab.
The Model Editor input/output section appears.

2 Use the Group and Subgroup scroll lists to select the phone in question.

3 Click on the Coupling Factors tab within the Model Editor menu.
The coupling device and the coupling values appear.

4 Select the action below, depending on the desired change.

– In order to manually adjust the coupling values, select the coupler 
(on the left-hand side) and click on the respective value in the Low, 
Mid or High field for the band and direction in question. The field 
changes into an entry field; enter the new value and confirm with 
the ENTER key. 

– In order to re-calculate all coupling factors, click on Calculate New 
Values. 
The Coupling Factor Wizard runs again and all previous results are 
overwritten with the new coupling data.

– In order to calculate the coupling factors for a band previously not 
measured, or to re-calculate the coupling factors for one of the 
bands, remember the position on the coupler and click on Add 
Values. 
The Coupling Factor Wizard runs again, but without overwriting 
previous results for unselected bands.

– In order to add a new band with coupling values to the table, klick 
the Add Values Manually button. 
A pop-up menu appears, prompting for band and coupler informa-
tion. The appropriate information will be added to the table with 
default values. You can then manually change these values as 
explained above.

– In order to delete a row with coupling factors for a frequency band 
and direction, mark the appropriate row with the cursor, then click 
on Delete Values.
The row disappears.

NOTE

The Add Values button and functionality is available in 7312 Lector 
Enhanced and 7315 Scriptor only.
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5 Klick the Save Settings button to store the new coupling values. 



Chapter 5 Setting and Determining the Coupling Factor

Manually changing the coupling factors

68 Lector and Scriptor Version 6.10



6

Lector and Scriptor Version 6.10 69

Chapter 6 Setting Up Phone Models in Lector and 

Scriptor

This chapter describes how Lector and Scriptor can be configured to opti-
mally fit the test needs. Topics discussed in this chapter are as follows:

– “Introduction” on page 70

– “Selecting a phone model” on page 70

– “Changing the phone settings for GSM and WCDMA phone models” on 
page 72

– “Changing the picture and information for GSM and WCDMA phones” 
on page 72

– “CDMA and 1xEV-DO phone models” on page 74

– “TETRA mobile station models” on page 84
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Introduction

In order to define a new phone model in Lector and Scriptor, or to change or 
amend the configuration of an existing model, go to the Model Editor tab. 
This tab and the subsequent menu are only available in 7315 Scriptor.

Selecting a phone model

You can either select a new phone model description by creating one, or 
choose from the list of existing models or generic groups and subgroups.

Creating a new phone

model description

1 To define a new model that was not previously available in Lector and 
Scriptor, click on the New button.

2 Select an existing Group name or enter a new one, e.g. the phone manu-
facturer’s name.

3 In the Subgroup field, enter the name of the new phone model.

4 Next to the Pictures input field, click on ... to select one or two file 
name(s) for the picture(s) of the phone to be displayed. Prior to that, 
you can store pictures in either BMP, JPG/JPEG or GIF format in the 
Data\CPL_DB\Pictures folder of the program installation directory.
The menu displays the selected picture(s).

5 Next to the Test Script input field, click on … to select one or multiple 
test script file(s) from the list. The list displays the available scripts 
available in the folder selected on the Configuration tab menu under 
General > Test Script Path (see “Test Script Path” on page 28), but test 
scripts may also reside in other folders. 
For a list of test scripts and their respective systems and frequency 
bands, see “Selecting a test” on page 19. 
You can also create your own test scripts according to your testing 
requirements. See Chapter 7 “Modifying and Creating Test Scripts” to 
learn more about it.
The selected test scripts are shown in the Test Script field. The sequence 
in which they appear can be changed with the arrow buttons on the 
right-hand side.

Note

You can select one or two pictures, e.g. displaying the phone from the 
front and rear to show how a slider must be set up. During the test, the 
picture display will alternate between the two in 1-second intervals.

Note

Keep the CTRL key pressed to select multiple files.
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6 In the System scroll field, select the applicable system(s), GSM and/or 
WCDMA, or CDMA2000 (including 1xRTT and 1xEV-DO), or TETRA.
Depending on the chosen system, the tabs below display parameter 
groups for either GSM and WCDMA phones, or for CDMA2000 phones, 
or for TETRA radios.

7 Click Save to store the current configuration.
The phone parameters are stored and can be retrieved with the Group 
and Subgroup scroll fields.

Selecting a model to

change an existing

description

To change or amend an existing phone model or generic description, select 
the phone according to the appropriate group and subgroup.
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Changing the phone settings for GSM and WCDMA phone models

This section explains how you can affect mobile phone parameters for 
phones in the user database, i.e. phones that have been defined through 
either the Model Editor (in Scriptor) or through the Calculate CPL menu.

The place to change the parameters that Lector and Scriptor use for the 
selected phone is in the parameter fields in the bottom half of the Model 
Editor menu.

Bluetooth Text The text entered in this field will be displayed when a Bluetooth test is 
started. It could contain information how to enable the Bluetooth feature in 
the phone.

Phone Information The text entered in this field will be displayed below the picture of the 
phone in the Running tab menu.

Changing the picture and information for GSM and WCDMA phones

When a test is called up, Lector or Scriptor displays a picture of a mobile 
phone (or alternate between two); the picture is linked to the TAC field of 
the IMEI. For phones in the user database, Scriptor allows you to define 
another picture to be displayed as follows:

1 Click on the CPL (GSM/WCDMA) tab.
The CPL (GSM/WCDMA) menu appears.

2 Select the phone model with the Group and Subgroup selection fields.
The configuration of the model appears, including the picture currently 
selected.

3 In order to select a new picture:

a In the line displaying “Pictures”, click on …
A file selection menu appears.
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b Select up to two files with the picture(s) of the mobile phone.

c Click Open to confirm your choice.
The new picture is displayed in the Picture section. If more than one 
have been selected, click on the file name to see the corresponding 
picture.

4 In order to remove the current picture without selecting a new one, click 
on the Delete button in the Picture line. 

5 In the Instructions field, enter text that is to be displayed during the 
text, such as “Open the flip phone”.

6 In the Comment field, you may enter text for your own purposes.

7 Click Save Settings. 
The changes are saved and immediately available in the next test.

Note

You can select one or two pictures, e.g. displaying the phone from the 
front and rear to show how a slider must be set up. During the test, the 
picture display will alternate between the two in 1-second intervals.

Note

Keep the CTRL key pressed to select multiple files.
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CDMA and 1xEV-DO phone models

Changing the phone

settings

This section explains how you can affect mobile phone parameters for 
phones in the user database, i.e. phones that have been defined through 
the Model Editor in Scriptor.

The place to change the parameters that Lector and Scriptor use for the 
selected phone is in the parameter fields in the Mobile Settings tab in the 
Model Editor menu.

Bluetooth Text The text entered in this field will be displayed when a Bluetooth test is 
started. It could contain information how to enable the Bluetooth feature in 
the phone.

Phone Information The text entered in this field will be displayed below the picture of the 
phone in the Running tab menu. The text can be up to 60 characters in 
length. 

CDMA TEXT The text entered in this field will be displayed in the Results section of the 
Running tab menu when a CDMA test is started. It is also stored in the test 
results log.

CDMA RADIO CONFIGURATION This is the radio configuration to be applied for the tests. Valid entries are 
in the range from 1 to 5.
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CDMA SERVICE OPTION Valid entries for the service option depend on the radio configuration as 
follows: 
Radio configuration Service option
1 or 3 or 4 1 or 2 or 3 or 55
2 or 5 9 or 17 or 55 or 32768

CDMA MINIMUM BASE POWER The value constitutes the minimum signal power at the mobile’s input for 
CDMA2000 1xRTT tests, in dBm.

CDMA FER TEST TRAFFIC LEVEL This value represents the forward channel signal power level for FER 
measurements, in dBm.

EVDO TEXT The text entered in this field will be displayed in the Results section of the 
Running tab menu when an EVDO test is started. It is also stored in the test 
results log.

EVDO MINIMUM BASE POWER The value constitutes the minimum signal power at the mobile’s input, in 
dBm.

FTAP DATA RATE Forward data rate for the FTAP-based (Forward Test Application Protocol) 
test.

RTAP DATA RATE The data rate for the RTAP-based test. RTAP stands for Reverse Test Appli-
cation Protocol. 

EVDO POWER CLASS EVDO power class of the phone (Access Terminal, AT). Knowing the power 
class, the test software can check if the phone can transmit at its maximum 
power level.

As there are different CDMA/EVDO bands with different power classes, an 
individual EVDO power class can be defined for each frequency band (US-
800, US-PCS, KPCS, NMT-450, AWS).
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Changing the carrier

settings

To change or add parameters that are specific to a carrier (network), click 
on the Carrier Settings tab in the Model Editor menu. 

In order for the CDMA and EVDO phone to register with a network, that 
network must use certain parameters that are also programmed into the 
phone. These parameters include frequency band, SID and control channel 
frequency. So for the purpose of carrying out tests, the tester must use the 
network parameters that the phone is expecting. You can define and store 
different new carrier networks to use in your tests, or you can modify an 
existing network description. Note that when you edit or delete the 
network parameters for a carrier in the Model Editor menu, these changes 
will affect the carrier settings for all the phone models using that carrier.

Preselecting carriers For each phone model, you can preselect the carrier networks that offer this 
type of phone: In the Carrier list on the Carrier Settings tab, check the appli-
cable networks, then store the changes by clicking the Save button. (Excep-
tions: Preselection of the carriers is not possible if either there is only one 
carrier or the preselection has already been done in the test script (see 
SET_CARR command.)
The carriers are saved in the configuration of the model, and offered at the 
start of a test for that phone model.

Defining a new carrier network 1 On the Carrier Settings tab in the Model Editor menu, click the New 
Carrier button.
A box with an entry field opens, allowing you to enter a name for the 
new carrier.
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2 Enter a name for the network carrier (such as Alltel, Sprint Nextel, 
Verizon Wireless), and click OK.
In the Carrier list, the new name appears. The list of fields and values is 
filled with the relevant parameters and arbitrary values.

3 Set up the fields (parameters). For more information about the parame-
ters, see section “Modifying an existing carrier description” below.

Modifying an existing carrier
description

You can define the network parameters that are used by the tester to simu-
late a particular carrier network. Note, however, that carrier changes made 
for one phone model in the Model Editor also apply to the carrier for all the 
other phone models as well.

The Field and Value scroll list displays the network parameters and their 
current settings for all the networks defined in Lector and Scriptor. To move 
to a particular network description, click on the network name in the Carrier 
list on the left-hand side.

Double-click on the field (parameter) name to change a parameter. The 
following subsections indicate the parameters and their respective 
meaning.

Name

This field contains the carrier network name chosen when the carrier defini-
tion was created, and cannot be changed.

CDMA BAND

From the scroll box, select the CDMA frequency band being used by the 
carrier network. Available frequency bands are AWS, KPCS (Korean PCS 
band), NMT450, US800 or USPCS. For a definition of the frequency bands 
and their respective channel numbers, see “CDMA and 1xEV-DO settings” 
on page 45.

CDMA CONTROL CHANNEL

Channel number for the CDMA control channel. This is the frequency carrier 
at which the instrument transmits the logical channels that the mobile 
requires to synchronize with the simulated network and to set up a call.

CDMA SID

The system identity (SID) is a number which identifies the subscriber’s 
CDMA home system. Using a home SID allows operation with phones that 
are programmed for home-only operation.
Valid SIDs are in the range from 0 to 32767.

CDMA MCC

The mobile country code identifies the country in which the (simulated) 
network is located. Valid MCCs are in the range from 0 to 999.
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CDMA MNC

The mobile network code identifies a network within a country. Valid MNCs 
are in the range from 0 to 99.

CDMA NID

The network identification (NID) number identifies the network. Valid NIDs 
are in the range from 0 to 65535. 

EVDO CONTROL CHANNEL

Channel number for the EVDO control channel. This is the frequency carrier 
at which the instrument transmits the logical channels that the mobile 
requires to synchronize with the simulated network and to set up a data 
connection.

EVDO SECTOR ID

This parameter field allows for entering the 128 bit (32 hexadecimal char-
acters) address of the sector ID of the simulated cell. The EVDO Sector ID can 
be entered in hexadecimal; for each of the 32 hexadecimal characters, you 
can use hex codes 0 to 9 and A to F.

EVDO SUBNET MASK

A network in EVDO can be divided into a maximum of 128 subnets. This is 
an important parameter that needs to match the mobile’s preferred 
roaming list (PRL). Otherwise, it might not be possible to initiate a session. 
Valid entries are in the range from 0 to 127.

EVDO MCC

The country code identifies the network internationally. This is an important 
parameter that needs to match the mobile’s preferred roaming list (PRL). 
Otherwise, it might not be possible to initiate a session. Valid entries are in 
the range from 0 to 999.

EVDO COLOR CODE

The EVDO color code identifies the network on a national level. This is an 
important parameter that needs to match the mobile’s preferred roaming 
list (PRL). Otherwise, it might not be possible to initiate a session. Valid 
entries are in the range from 0 to 255.

EVDO PROTOCOL REVISION

The scroll list allows to select the protocol revision for testing. While Rev0 
allows for a maximum forward data rate of 2456.7 kbps, RevA allows for 
3072 kbps.

EVDO CONTROL CHANNEL DATA RATE

Data rate used by the instrument on the control channel. The scroll list 
allows to select between 38400 and 76800 kbps.
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Deleting a carrier description You can easily delete a carrier from the Carrier list in the Carrier Settings 
menu. Note, however, that the carrier is not available to any other mobile 
phone either.

1 Select the carrier to be deleted by clicking on it, then click the Delete 
Carrier button.
A box appears, displaying the selected carrier(s) and asking to confirm 
deletion.

2 Click OK to delete the carrier network description, or No to leave it.
The carrier name disappears from the Carrier list, and all the parameters 
for that carrier are deleted.

3 If the selected mobile phone (or group and subgroup combination) 
previously used the deleted carrier, click Save to store the new phone 
setup.

Determining the coupling

factors

The coupling values can be determined by the Coupling Factor Wizard for 
CDMA and EVDO. 

1 Select the phone for which to determine the coupling (see “Selecting a 
phone model” on page 70 on how to do it).

2 On the Coupling Factors tab within the Model Editor menu, click 
Coupling Meas.
The Coupling Factor Wizard appears.

3 In the Bands section, check the applicable frequency bands for the 
mobile phone, and click Next.
The Features page of the Coupling Factor Wizard appears.

Note

The Coupling Factor Wizard for CDMA and EVDO may take a long time to 
determine the coupling factors. Use an external power supply for the 
phone, or a fully loaded battery to avoid that the Wizard is aborted due 
to an empty battery.
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4 Select additional technologies that the phone supports and that might 
be tested, then click on Next.
The Coupling page of the Coupling Factor Wizard appears.

5 Select the coupling method. If you want to connect the phone to the 
tester via an RF cable or if you are using another coupling device that is 
not listed, choose “User Defined Connection”.

6 If Willtek’s 4916 Antenna Coupler is involved in the test you may either 
let the Coupling Factor Wizard select the best position for the antenna 
coupler shuttle (Automatic Position Finding), or you may select the 
position from the scroll field (Manual Position Finding; select “No posi-
tioning used” if the position does not matter). If you do not use a 4916, 
ignore these fields. 

7 Click Next.
The Calculation Type page of the Coupling Factor Wizard appears.
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8 In the Calculation Type section, click on Cable + Coupler if you want to 
determine the coupling values for an antenna coupler and if you also 
have an RF cable available. Otherwise, select Coupler only.

9 For the different frequency bands to be supported, carefully enter the 
respective maximum power (according to the power class for that band, 
in dBm) and the expected receiver sensitivity (usually –109 dBm).

10 Click Next. 
The Coupling Factor Wizard now determines the coupling factors with a 
number of measurements. Follow the onscreen instructions.

When completed, the coupling factors are displayed.

11 You can click on the values in the Low, Mid and High columns to manu-
ally adjust the coupling values.
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The table on the left-hand side shows the results of a measurement and 
the right-hand side table displays coupling factors averaged over 
several measurements (if available).

12 In order to perform another measurement and allow Lector or Scriptor 
to average the results, click on Continue Average. 
The measurements are restarted, i.e. step 10 is repeated. At the end, 
the new measurement results and previous results are averaged.

13 You can view a set of measurement results by selecting the appropriate 
measurement number in the Measurements selection field. Click on 
Delete Measurement to remove a set of results; they will be excluded 
from the averaging.

14 Click Save Values to store the coupling values.

15 Click Cancel to terminate the Coupling Factor Wizard.

Changing the coupling

factors

1 Select the phone for which to determine the coupling (see “Selecting a 
phone model” on page 70 on how to do it).

2 Go to the Coupling Factors tab within the Model Editor menu.

3 You can click on the values in the Low, Mid and High columns to manu-
ally adjust the coupling values.

4 Click Save to store the coupling values.

Note

You may have to repeat the measurements if the coupling values are too 
high because this usually means that the measurement was not success-
ful. Scriptor will prompt you to repeat the measurements in such a case.

Note

The averaging can be used to get a better result for one phone, or to get 
an average over several phones.
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Changing the mobile

phone picture

When a test is called up, Lector or Scriptor displays a picture (or two alter-
nating pictures) of a mobile phone; the picture is linked to the Group and 
Subgroup. In Scriptor you can define another (or an additional) picture to be 
displayed as follows:

1 Click on the Model Editor tab.
The Model Editor menu appears.

2 Select the phone model with the Group and Subgroup selection fields.
The configuration of the model appears, including the picture currently 
selected.

3 In order to select a picture (or two):

a In the line displaying “Pictures”, click on …
A file selection menu appears.

b Select up to two files with the picture(s) of the mobile phone.

c Click Open to confirm your choice.
The new picture is displayed in the Picture section. If more than one 
have been selected, click on the file name to see the corresponding 
picture.

4 In order to remove the current picture without selecting a new one, click 
on the Delete button in the Picture line. 

Note

You can select one or two pictures, e.g. displaying the phone from the 
front and rear to show how a slider must be set up. During the test, the 
picture display will alternate between the two in 1-second intervals.

Note

Keep the CTRL key pressed to select multiple files.
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TETRA mobile station models

Changing the TETRA radio

settings

This section explains how you can affect TETRA radio parameters for TETRA 
mobile stations in the user database, i.e. radios that have been defined 
through the Model Editor in Scriptor.

The place to change the parameters that Lector and Scriptor use for the 
selected TETRA radio is in the parameter fields in the Mobile Settings tab in 
the Model Editor menu.

Bluetooth Text The text entered in this field will be displayed when a Bluetooth test is 
started. It could contain information how to enable the Bluetooth feature in 
the TETRA radio.

Phone Information The text entered in this field will be displayed below the picture of the 
TETRA radio in the Running tab menu. The text can be up to 60 characters 
in length.

POWER CLASS The power class determines the maximum power that the TETRA radio can 
transmit. The test software needs to know the power class so that it can set 
up and test the maximum power level correctly. Also, the limits are typically 
narrower at the highest power level.
The power class is expressed both as a number (with modifier L where 
necessary) and the nominal power level in dBm.
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Defining the channel

settings

TETRA radios are typically configured for a specific carrier (network). Click 
on the Channel Setup tab in the Model Editor menu to define or change the 
channel settings. 

In order for the TETRA radio to register with a network, that network must 
use certain parameters that are also programmed into the mobile station. 
These parameters include frequency and network information. So for the 
purpose of carrying out tests, the tester must use the network parameters 
that the radio is expecting. You can define and store different new carrier 
networks to use in your tests, or you can modify an existing network 
description. Note that when you edit or delete the network parameters for 
a carrier in the Model Editor menu, these changes will affect the network 
settings for all the TETRA radio models using that carrier.

Preselecting networks For each TETRA radio model, you can preselect the TETRA networks that 
offer this type of mobile station: In the Channel list on the Channel Setup 
tab, check the applicable setups, then store the changes by clicking the 
Save button. (Exceptions: Preselection of the carriers is not possible if either 
there is only one carrier or the preselection has already been done in the 
test script (see SET_CARR command.)
The carriers are saved in the configuration of the model, and offered at the 
start of a test for that TETRA radio model.

Defining a new carrier network 1 On the Channel Setup tab in the Model Editor menu, click the New 
Channel Setup button.
A box with an entry field opens, allowing you to enter a name for the 
new setup.
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2 Enter a name for the setup (e.g. the name of the network), and click OK.
In the Channel list, the new name appears. The list of fields and values is 
filled with the relevant parameters and arbitrary values.

3 Set up the fields (parameters). For more information about the parame-
ters, see section “Modifying an existing carrier description” below.

Modifying an existing setup You can define the network parameters that are used by the tester to simu-
late a particular TETRA network. Note, however, that network changes 
made for one mobile station model in the Model Editor also apply to the 
network for all the other TETRA radio models as well.

The Field and Value scroll list displays the network parameters and their 
current settings for all the networks defined in Lector and Scriptor. To move 
to a particular network description, click on the network name in the 
Channel list on the left-hand side.

Double-click on the field (parameter) name to change a parameter. The 
following subsections indicate the parameters and their respective 
meaning.

Name

This field contains the TETRA network name chosen when the network defi-
nition was created, and cannot be changed.

MCC

The mobile country code identifies the country in which the (simulated) 
network is located. Valid MCCs are in the range from 0 to 999.

MNC

The mobile network code identifies a network within a country. Valid MNCs 
are in the range from 0 to 16,383.

BCC

The Base station Color Code (BCC) is a number identifying a scrambling code 
that is used on all channels of the base station. The BCC can be chosen 
randomly. Valid entries are in the range from 0 to 63.

LAREA

The Location Area (LArea) identifies a cell. For TETRA mobile stations that 
are not restricted to a certain area, the location area can be freely chosen. 
Valid LArea codes are in the range from 0 to 16,383.

MAIN CARRIER CHANNEL

Channel number for the main control channel in TETRA. This is the frequency 
carrier at which the instrument transmits the logical channels that the 
mobile requires to synchronize with the simulated network and to set up a 
call.
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LOW CHANNEL

The low channel entry is a channel number determining one of the three 
traffic channel frequencies for testing. TETRA channel numbers are in the 
range from 0 to 3999.

MID CHANNEL

The mid channel entry is a channel number determining one of the three 
traffic channel frequencies for testing. TETRA channel numbers are in the 
range from 0 to 3999.

HIGH CHANNEL

The high channel entry is a channel number determining one of the three 
traffic channel frequencies for testing. TETRA channel numbers are in the 
range from 0 to 3999.

FREQUENCY BAND

This selection field determines the frequency band in which the TETRA radio 
transmits and receives. Possible entries are 300 MHz, 400 MHz, 800 MHz 
and 900 MHz.

CHANNEL OFFSET

The channel offset is the offset of the carrier frequency relative to a multiple 
of 25 kHz. It is important to set the correct channel offset that is also 
programmed into the TETRA radio; otherwise the radio will not find the 
simulated TETRA network.
One of the following values can be selected: 0 kHz, 12.5 kHz, +6.25 kHz, –
6.25 kHz.

DUPLEX SPACING

The duplex spacing is the difference between the uplink (mobile station 
transmit) frequency and the downlink (base station transmit) frequency. 
Most networks in teh 300 and 400 MHz range apply a duplex spacing of 
10 MHz while networks operating in the 800 and 900 MHz bands typically 
apply 45 MHz duplex spacing.
One of the following values can be selected: 10 MHz or 45 MHz.

Deleting a channel setup You can easily delete a network from the Channel list in the Channel Setup 
menu. Note, however, that the carrier is not either available to any other 
TETRA radio anymore.

1 Select the network to be deleted by clicking on it, then click the Delete 
Channel Setup button.
A box appears, displaying the selected setup(s) and asking to confirm 
deletion.

2 Click OK to delete the network description, or No to leave it.
The channel setup name disappears from the Channel list, and all the 
parameters for that network are deleted.

3 If the selected TETRA radio (or group and subgroup combination) previ-
ously used the deleted setup, click Save to store the new channel setup.
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Determining the coupling

factors

The coupling values can be determined by the Coupling Factor Wizard for 
TETRA radios. 

1 Select the TETRA radio for which to determine the coupling (see 
“Selecting a phone model” on page 70 on how to do it).

2 On the Coupling Factors tab within the Model Editor menu, click Calcu-
late New Values.
The Coupling Factor Wizard appears.

3 In the Bands section, check the applicable frequency band(s) for the 
TETRA radio, and click Next.
The Features page of the Coupling Factor Wizard appears.

4 Select additional technologies that the mobile station supports and 
that you might want to be tested, then click on Next.
The Coupling page of the Coupling Factor Wizard appears.

Note

The Coupling Factor Wizard for TETRA may take a long time to determine 
the coupling factors. Use an external power supply for the radio, or a fully 
loaded battery to avoid that the Wizard is aborted due to an empty bat-
tery.
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5 Select the coupling method. If you want to connect the radio to the 
tester via an RF cable or if you are using another coupling device that is 
not listed, choose “User Defined Connection”.

6 If Willtek’s 4914 or 4916 Antenna Coupler is involved in the test you 
may either let the Coupling Factor Wizard select the best position for 
the antenna coupler shuttle (Automatic Position Finding), or you may 
select the position from the scroll field (Manual Position Finding; select 
“No positioning used” if the position does not matter). If you do not use 
a 4914 or 4916, ignore these fields.

7 Click Next. 
The Coupling Factor Wizard now determines the coupling factors with a 
number of measurements. Follow the onscreen instructions.

When completed, the coupling factors are displayed.

8 You can click on the values in the Low, Mid and High columns to manu-
ally adjust the coupling values.
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The table on the left-hand side shows the results of a measurement and 
the right-hand side table displays coupling factors averaged over 
several measurements (if available).

9 In order to perform another measurement and allow Lector or Scriptor 
to average the results, click on Continue Average. 
The measurements are restarted, i.e. step 7 is repeated. At the end, the 
new measurement results and previous results are averaged.

10 You can view a set of measurement results by selecting the appropriate 
measurement number in the Measurements selection field. Click on 
Delete Measurement to remove a set of results; they will be excluded 
from the averaging.

11 Click Save Values to store the coupling values.

12 Click Cancel to terminate the Coupling Factor Wizard.

Changing the coupling

factors

1 Select the TETRA radio for which to determine the coupling (see 
“Selecting a phone model” on page 70 on how to do it).

2 Go to the Coupling Factors tab within the Model Editor menu.

3 You can click on the values in the Low, Mid and High columns to manu-
ally adjust the coupling values.

4 Click Save to store the coupling values.

Note

You may have to repeat the measurements if the coupling values are too 
high because this usually means that the measurement was not success-
ful. Scriptor will prompt you to repeat the measurements in such a case.

Note

The averaging can be used to get a better result for one mobile station, 
or to get an average over several radios.
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Changing the TETRA radio

picture

When a test is called up, Lector or Scriptor displays a picture (or two pictures 
alternating) of a TETRA radio; the picture is linked to the Group and 
Subgroup. In Scriptor you can define another picture (or an additional one) 
to be displayed as follows:

1 Click on the Model Editor tab.
The Model Editor menu appears.

2 Select the TETRA radio model with the Group and Subgroup selection 
fields.
The configuration of the model appears, including the picture currently 
selected.

3 In order to select a picture (or two):

a In the line displaying “Pictures”, click on …
A file selection menu appears.

b Select up to two files with the picture(s) of the mobile station.

c Click Open to confirm your choice.
The new picture is displayed in the Picture section. If more than one 
have been selected, click on the file name to see the corresponding 
picture.

4 In order to remove the current picture without selecting a new one, click 
on the Delete button in the Picture line. 

Note

You can select one or two pictures, e.g. displaying the radio from the 
front and rear to show how the mobile station must be set up. During the 
test, the picture display will alternate between the two in 1-second inter-
vals.

Note

Keep the CTRL key pressed to select multiple files.



Chapter 6 Setting Up Phone Models in Lector and Scriptor

TETRA mobile station models

92 Lector and Scriptor Version 6.10



7

Lector and Scriptor Version 6.10 93

Chapter 7 Modifying and Creating Test Scripts

This chapter describes how Lector and Scriptor can be configured to opti-
mally fit the test needs. Topics discussed in this chapter are as follows:

– “Introduction” on page 94

– “Loading and saving tests” on page 94

– “Editing the test script” on page 96

– “Test command reference – Common commands” on page 99

– “Test command reference – GSM commands” on page 108

– “Test command reference – GPRS commands” on page 118

– “Test command reference – EDGE commands” on page 124

– “Test command reference – WCDMA commands” on page 129

– “Test command reference – HSDPA commands” on page 136

– “Test command reference – CDMA commands” on page 140

– “Test command reference – AMPS commands” on page 151

– “Test command reference – EVDO commands” on page 152

– “Test command reference – TETRA commands” on page 164
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Introduction

This chapter explains how test scripts can be edited with Scriptor from the 
Test Script Editor menu. The various test commands are grouped into 
common (general) commands and into commands for the different wireless 
access technologies, i.e. GSM, GPRS, EDGE, WCDMA, HSDPA, CDMA, AMPS, 
1xEV-DO and TETRA.

The left-hand side shows a list of commands under the tabs for the different 
command groups. The available command groups and commands depend 
on the type of test instrument that you choose at the top of the menu. In 
the middle, there are buttons for different actions. The field on the right-
hand side displays the test script currently being edited.

Loading and saving tests

Loading a test script You can start from scratch with an empty script and add commands. Usually 
it is more convenient, however, to take and modify an existing test script. 
To load a test script from the hard disk, proceed as follows:

1 Click on the Test Script Editor tab.
The Test Script Editor menu opens. If you did not work with the editor 
since the last start of Scriptor, the right-hand side with the commands 
is empty.

2 Click on the Load Test Script button.
A file selector box opens, displaying the files and folders currently avail-
able in the default test script folder (see “Test Script Path” on page 28).
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3 Use the mouse to navigate to and mark the desired test script, then 
click on Open (you may also navigate to a different folder).
The box disappears, and the test script is displayed on the right-hand 
side of the Test Script Editor. You can now make your changes (see 
“Editing the test script” on page 96). Do not forget to save the changes 
before closing Scriptor (see “Saving a test script” on page 95)!

Saving a test script After editing a new test script or making changes to an existing test script, 
the script should be stored in a file so that it can be used by Lector and 
Scriptor.

1 In the Test Script Editor menu, click on Compile and Save.
Lector or Scriptor performs a sanity check on the script, e.g. it checks if 
there is a command to set up a voice or data call before measurements 
are initiated. If there are any errors, Lector or Scriptor will display a 
warning and ask if the test script should be stored despite the problem.
A box appears, displaying a test script folder and its files (see “Test 
Script Path” on page 28). If you previously loaded the file, the File Name 
field contains the file name of the test script previously loaded.

2 Select a file or enter a file name in the appropriate box, then click on 
Save (you may also navigate to a different folder).
If a file of that name already exists, Scriptor will ask you to confirm. The 
test script is then saved in the file.

Encrypting test scripts If you want to pass on a test script without giving away the source code of 
it, you can also save an encrypted version of it. Proceed as in “Saving a test 
script”, but enable the Save Encrypted File check box.
Scriptor will save two versions of the file: an unencrypted RBT file (which 
can be used to archive and maintain the source code) and an encrypted RBE 
file (which can be passed on).

Note on folders

Instead of using the drive and folder defined in the Test Script Path 
parameter of the Configuration > General menu, you can also store files 
in different locations. Lector and Scriptor remember a subfolder to the 
one set in the folder parameter as a relative path, while other directories 
are stored with their absolute location (drive and folder).
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Editing the test script

Selecting the instrument

model

Depending on the type of instrument, there are more or less commands and 
command groups available. Before editing the test script, the instrument 
model (e.g. 4400 or 4100) should be selected in the Test Equipment selec-
tion field.
When the file is saved, Scriptor performs a sanity check on the commands 
and their sequence, taking into account the capabilities of the selected 
instrument.

Adding a new command The test commands (test steps) are explained in “Test command reference 
– Common commands” on page 99. To add a new test command, proceed 
as follows:

1 In the Test Script Editor, use the UP and DOWN cursor keys to move the 
highlight bar in the test script to the command above the position 
where the new command should be inserted.

2 Click on the Test Steps tab containing the new command to be inserted, 
and click on the new command.

3 Click on the >> button. Alternatively, double-click on the new command.
The command is inserted in the test script on the right-hand side.

Alternatively, simply select the test step from the list on the left-hand side, 
and use the mouse to drag it to the position within the test script on the 
right-hand side where it should be inserted. 

Copying, moving or

deleting commands

Multiple commands from the test script on the right-hand side can be 
copied, moved or deleted easily using standard Windows mechanisms, e.g. 
by dragging and dropping commands or by pressing keys.

1 Select one or several commands. The selection can be extended to 
several commands by holding the SHIFT key or the CTRL key and 
marking more commands.

2 Proceed with one of the following steps depending on our intention:

– In order to delete the selected commands, press the DEL key or 
CTRL-X. Alternatively, you can right-click on one of the command 
and select Delete from the context menu that pops up. 

– In order to move the selected commands, press CTRL-X, place the 
cursor on the command under which the deleted commands shall be 
inserted, and press CTRL-V. You can also open the context menu 
with a click on the right mouse button to delete and paste the 
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commands.
Or move the commands to the new position by dragging them with 
the mouse.

– In order to copy the selected steps to an additional position, press 
CTRL-C, place the cursor on the command under which the copied 
commands shall be inserted, and press CTRL-V. Instead pressing 
keys on the keyboard, you can use the context menu that appears if 
you right-click the mouse over the respective test script commands.

Editing test parameters Many of the commands include one or multiple parameters separated by 
commas. The meaning of the test commands and their parameters is 
explained in “Test command reference – Common commands” on page 99. 
The parameters can be edited as follows:

1 In the section containing the test script currently being edited (right-
hand side of the menu), double-click on the test command in question.
A box containing a short description of the command and with entry 
fields for the test parameters opens.

2 Use the keyboard (including DELETE and BACKSPACE keys) to change 
the test parameters.

3 Confirm the changes by clicking OK.
The new test parameters are shown with the command.

Changing the sequence of

commands

If you find that a test step is in the wrong position and should be moved 
further up or down, proceed as follows:

1 In the test script on the right-hand side, highlight the command to be 
moved.
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2 Move the position by clicking the Up or Down button multiple times 
until the command is where you want it.

Enabling and disabling a

command

Sometimes it can be useful to disable a command temporarily, for example 
for testing purposes. Scriptor supports this with the En-/Disable button. 
Just click on the command that you want to “comment out”, and click on the 
En-/Disable button. 
If the command was previously active, it becomes inactive by a comma in 
front of the command (text in the line behind a comma is not processed by 
the command interpreter). If the command was previously inactive, it 
becomes active again by removing the comma.

Deleting a command from

the test script

Commands and their parameters can easily be removed from the text script: 
Place the highlight bar on the command to be removed, then click the 
Delete button. 
The line command with the command in question disappears.

Deleting the entire test

script

You can delete the whole test script by clicking on Delete All.
The section for the test script is emptied.

Note

All changes in the test script only become active after they are saved to a 
file.
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Test command reference – Common commands

AUDIOOPTION Description Sets the audio frequency and volume at the AF out 
connector and takes a measurement. The result is displayed 
and logged in the results file. 

Parameters AF-frequency,AF-volume
AF-frequency – the audio frequency to be set, in hertz.
AF-volume – the audio volume to be set, in % of the 
maximum volume.

Notes Requires a 4400 Series Mobile Phone Tester with the 
4470 Audio Option installed.

Example AUDIOOPTION,1000,50

BLUETOOTH Description Performs a Bluetooth Go/NoGo test on the 3100 or the 
4400 series instrument.

Parameters None.

Notes Requires the Bluetooth Connectivity Test Option to be 
installed in the test set if you are using a 3100 or a 4400 
series instrument. If you are using a different test set, 
please see the BLUETOOTH_DIRECT command below.
In addition, the Bluetooth Test parameter must be enabled 
in the Configuration > General menu for the test to be 
performed, see page 36.

Example BLUETOOTH

BLUETOOTH_DIRECT Description Performs a Bluetooth Go/NoGo test on the 4100, 4200 or 
2201.

Parameters Port.
Port – COM port number allocated to Willtek’s Bluetooth 
USB device (4941 Bluetooth Hardware) on the PC.

Notes Requires the (dongle-based) 7361 Bluetooth Connectivity 
Test License to be installed in the PC running Lector 
Enhanced or Scriptor.
In addition, the Bluetooth Test parameter must be enabled 
in the Configuration > General menu for the test to be 
performed, see page 36.

Example BLUETOOTH_DIRECT,1

CHECK_VERSION Description Compares the software version number of the instrument 
(e.g. the 4400 Mobile Phone Tester) with the version speci-
fied in the parameter. If the instrument bears an older 

Note

Parameters must be written in uppercase!
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version, the test is halted with an error message. Two 
version numbers can be specified as a minimum require-
ment: one for the old and one for the new control processor 
(PC) board.

Parameters Version1, Version2
Version1 – Minimum version number for the old control 
processor board. If you do not want the software to run with 
the old board, specify 9.99.
Version2 – Minimum version number for the new control 
processor board.

Example CHECK_VERSION,6.20,11.20

CONTINUE_STOPWATCH Description Resumes time counting with the internal stopwatch after 
pausing. See also PAUSE_STOPWATCH command.

Parameters None.

Notes See also TIME_STAMP, RESET_STOPWATCH and 
PAUSE_STOPWATCH commands.

Example CONTINUE_STOPWATCH

COUPLING_DATA Description The coupling loss factors given by the parameters are taken 
into account, rather than using an existing coupling loss file. 
Up to ten frequency and attenuation pairs are possible in 
both the lower band from 800 to 1000 MHz and the upper 
band from 1700 to 2000 MHz. The factors are internally 
referenced by a name. The pairs (coupling loss points) char-
acterize the behavior of the coupling loss over frequency.

Parameters Description,f1,a1,f2,a2,...
Description – name for the coupling loss data, in quotation 
marks.
f1, f2, ... – Frequency of the coupling loss point, in MHz 
a1, a2, ... – attenuation at the coupling loss point, in dB.

Notes See also COUPLING_LOSS command.

Example COUPLING_DATA,“setup-
2“,830.0,0.75,900.0,1.15,1750,2.35, 
1800,2.85,1850,3.35

COUPLING_LOSS Description Coupling loss factors are applied during the test; these 
factors are used to adjust the output power level and the 
power measurement. The file describes the frequency 
response of the uplink and the downlink frequencies used 
during test. 
You can use existing files or create, adjust or adapt your own 
coupling loss files, and then load the appropriate file with 
this command.

Parameters File_name
File_name – the name of a coupling loss file.
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Notes See also COUPLING_DATA command.

Example COUPLING_LOSS,"ev_dual.cpl"

DESCRIPTION Description: The description is written to the results file (if results are 
logged to a file).

Parameters: Label
Label – Contains the label of a test.

Note: Do not separate words by comma because a comma is used 
to separate parameters. 

Example: DESCRIPTION,Customer - final test

END_CMD Description: Closes a serial (RS-232) connection to an external device. 

Parameters: None.

Notes See also INIT_CMD, SEND_CMD commands.

Example: END_CMD

FIXTEXT Description: User-defined text is displayed onscreen and in the test 
protocol.

Parameters: Text
Text – Text to be displayed.

Example: FIXTEXT,This is an example text

IMEI_RDCMP Description This command can be used in test scripts (e.g. called up 
from the X2TEST procedure) where the IMEI is entered by 
the keyboard or a barcode reader. The command compares 
the IMEI entered with the one received when the phone 
registered with the network. If the two IMEIs do not match, 
an error message is displayed onscreen.
The IMEI Comparison parameter must be enabled in the 
Configuration > General menu for the test to be performed, 
see page 36.

Parameters None.

Example MS_INFO
IMEI_RDCMP

INIT_CMD Description Sets up the serial (RS-232) interface of the PC to initiate a 
connection. 

Parameters COM-PORT – Number of the serial port in the PC to be used.
Baudrate – Gross data rate for the serial interface, in kbit/s; 
allowable values are 300, 600, 1200, 1800, 2400, 4800, 
9600, 19200.
Handshake – Hardware or software handshake being used 
on the serial interface. Allowable entries: NONE, RTS, CTS, 
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XON-XOFF.
Timeout – Period in milliseconds until the PC software gives 
up connecting the remote device.

Notes See also SEND_CMD, END_CMD commands.

Example INIT_CMD,1,19200,NONE,1000
SEND_CMD,ATS0=1
END_CMD

LAP Description Starts and stops an internal stopwatch, e.g. to calculate the 
effective measurement time (without waiting for user 
inputs or network searching). The stopwatch can identify 
different time intervals. Use the TIME_STAMP command to 
stop the stopwatch and calculate the sum of all intervals.

Parameters IntervalNo – Number of the interval to start or stop.
Mode – Action to perform, can take on the following values: 
START, STOP. The time intervals must not be overlapping.

Notes See also TIME_STAMP command.

Example LAP,1,START
LAP,1,STOP
LAP,2,START
TIME_STAMP,“Test finished“

LIMIT Description This command specifies the file containing the test limits 
that are applicable during the test. 

Parameters Limitfile
Limitfile – Full file name containing the limits. The file must 
be located in the directory specified in the Configuration 
menu.

Note The limits file must be specified before any test is started.

Example LIMIT,limit.lim

MESSAGE Description Displays a message in a pop-up window.

Parameters MessageText
MessageText – The text to be displayed.

Notes Do not separate words in the message text by comma 
because a comma is used to separate parameters.
See also USER_INPUT, USER_QUERY commands.

Example MESSAGE,Test starts now

PAUSE Description Pauses execution and displays a “Test paused” box until the 
user clicks on the Continue button.

Parameters None.

Example PAUSE
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PAUSE_STOPWATCH Description This command stops the internal stopwatch without reset-
ting it. The command to resume time counting is 
CONTINUE_STOPWATCH.

Parameters None.

Notes See also TIME_STAMP, RESET_STOPWATCH and 
CONTINUE_STOPWATCH commands.

Example PAUSE_STOPWATCH

POW_MEAS Description Starts a current measurement at the MS Power output.

Parameters Measurement_Type
Measurement_Type – allowable settings are AVG for aver-
aged results or PEAK for a peak measurement.

Notes Requires a 4400 Series Mobile Phone Tester with the MS 
Power Supply Option and the Current Measurement Option 
installed.
The output power voltage should be set before starting 
tests, see POW_VOLT and POW_SUPPLY commands.

Example POW_MEAS,AVG

POW_SUPPLY Description Switches the MS Power Supply Option of the 4400 Series 
Mobile Phone Tester on or off. 

Parameters State
State – power supply state to switch to (ON or OFF).

Notes Requires the option to be installed.

Example POW_VOLT,3.5
POW_SUPPLY,ON

POW_VOLT Description Sets the voltage at the MS Power output connector of the 
4400 Series Mobile Phone Tester. 

Parameters Voltage
Voltage – the voltage to be set in the power supply option.

Notes Requires a 4400 with the MS Power Supply Option installed.

Example POW_VOLT,3.5
POW_SUPPLY,ON

QUERY_CMD Description Sends a command or query to a device connected to the 
serial interface (RS-232), waits for the response and logs it 
in the results file. If the response is not as expected, the 
command or query is sent again until a timeout is reached.

Parameters Command,Printout,Response,Timeout
Command – the command or query that is to be sent to the 
device.
Printout – text that is written to the test protocol. In addi-
tion, a pass or fail statement will be printed.
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Response – the string that is expected to be sent back over 
the serial interface. If the actual return string is not the 
expected response then the command is resent.
Timeout – time in seconds that Lector waits for the 
response or resends the command before proceeding with 
the test script. In case of a timeout, the Printout text will be 
written to the results file along with a Fail verdict.

Notes The serial connection must be opened with the INIT_CMD 
before.

Example INIT_CMD,1,19200,NONE,1000
QUERY_CMD,*OPC?,Operation complete,1,3
END_CMD

PUSH_RESULT Description This command is used at the end of the test to store the test 
results in a file and/or send them to a printer.

Parameters None.

Example PUSH_RESULT

REM Description Comment text within the text script, will not be executed.

Parameters Comment
Comment – Text that is only visible while editing the test 
script.

Example REM,Data initalisation starts here

RESET_STOPWATCH Description The internal stopwatch is set to zero and restarted. It 
enables time measurements for certain parts of the test. 
This command is useful if e.g. the measurement time or the 
time the call needs to be established is of interest. 

Parameters None.

Notes See also TIME_STAMP command.

Example RESET_STOPWATCH

SEND_CMD Description Sends a text string to an external device connected to the 
PC over the serial port (RS-232), e.g. to the mobile phone. 
The connection must be intialized (using the INIT_CMD) 
before anything can be sent.

Parameters String

Notes See also INIT_CMD, END_CMD commands.

Example INIT_CMD1,19200,NONE,1000
SEND_CMD,ATS0=1
END_CMD
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SCPI_ASK Description Sends a query text string to the instrument (i.e. to the 
active device defined in Connection > Define Interface). 
Execution of the test script is halted until a response is 
received from the instrument. The response is written to the 
logfile (log.txt in the installation folder of Lector and 
Scriptor).

Parameters QueryString

Notes See also SCPI_CMD command.

Example SCPI_ASK,*IDN?

SCPI_CMD Description Sends a text string to the instrument (i.e. to the active 
device defined in Connection > Define Interface).

Parameters CommandString

Notes See also SCPI_ASK command.

Example SCPI_CMD,*CLS

SCPI_QUERY Description Sends a text string (query) to the instrument (i.e. to the 
active device defined in Connection > Define Interface), 
waits for the response and logs it in the results file. If the 
response is not as expected, the command or query is sent 
again until a timeout is reached.

Parameters Command,Printout,Response,Timeout
Command – the command or query that is to be sent to the 
device.
Printout – text that is written to the test protocol. In addi-
tion, a pass or fail statement will be printed.
Response – the string that is expected to be sent back by 
the active device. If the actual return string is not the 
expected response then the command is resent.
Timeout – time in seconds that Lector waits for the 
response or resends the command before proceeding with 
the test script. In case of a timeout, the Printout text will be 
written to the results file along with a Fail verdict.

Notes See also the SPCI_CMD, SCPI_ASK commands.

Example SCPI_QUERY,*OPC?,Operation complete,1,3

STOP Description Terminates execution of the test script.

Parameters None.

Example STOP

STORAGE_PATH Description Redefines the folder where result files are stored. The Result 
Folder Path parameter in the Configuration > General menu 
is overwritten by the new text string. – The command can 
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be used e.g. to store result files depending on the test script 
being used. The results folder can be given as an absolute or 
relative address, but it must already exist.

Parameters Folder
Folder – the (absolute or relative) path.

Example STORAGE_PATH,C:\temp

TEST_CHANNEL Description Specifies the name of a file containing the channel numbers 
to be used for testing. The file can be created from the 
Configuration > Test Channels tab and must be located in 
the Channels folder. See “Frequency band settings” on 
page 42 for more details.

Parameters Filename
Filename – name of a text file. 

Example TEST_CHANNEL,channel.tcf

TIME_STAMP Description This command effectively stops a timer that is started when 
the test script starts to run. The command can be used for 
the overall test time calculation. It stops the test run and the 
LAP timers, displays the resulting test time and the accumu-
latedmeasurement time intervals found with LAP and 
places the instrument in idle mode.
Other commands can restart (RESET_STOPWATCH), pause 
(PAUSE_STOPWATCH) or continue 
(CONTINUE_STOPWATCH) the timer. 
The command does not affect the LAP command which is 
used for a different set of timers. 

Parameters Type
Type – can take on the following value: “Test finished”

Notes See also RESET_STOPWATCH, PAUSE_STOPWATCH, 
CONTINUE_STOPWATCH and LAP commands.

Example TIME_STAMP,Test finished

USER_INPUT Description Opens a pop-up menu with a query and the possibility for 
the user to enter text. The text is then copied to the result 
file.

Parameters QueryText,ResultFileText
QueryText is the text appearing in the menu above the input 
field, and should specify what the user is asked to enter. The 
text should be entered without quotation marks and 
without a comma as part of the title.
ResultFileText is the text appearing in the results log file in 
front of the text that the user has entered. The text should 
be entered without quotation marks and without a comma 
as part of the title.

Notes See also the USER_QUERY, MESSAGE commands.
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Example USER_INPUT,Please enter the service number, Service 
number:

USER_QUERY Description Opens a pop-up menu with a query (e.g. a yes/no decision). 
The answer is added to the result file.

Parameters QueryText,ResultFileText,LeftButtonText,RightButtonText
QueryText is the text appearing in the menu, and should be 
the question (or the decision to take). The text should be 
entered without quotation marks and without a comma as 
part of the title.
ResultFileText is the text appearing in the results log file in 
front of the text that the user has entered. The text should 
be entered without quotation marks and without a comma 
as part of the title.
LeftButtonText is the text appearing on the left-hand 
button in the pop-up menu, and should be very short.
RightButtonText is the text appearing on the right-hand 
button in the pop-up menu, and should be very short.

Notes See also the USER_INPUT, MESSAGE commands.

Example USER_QUERY,Is the display working?,Display is functional:, 
No,Yes

WAIT Description Pauses execution of the test script for a given time.

Parameters Waittime
Waittime – time to pause execution, in milliseconds.

Example WAIT,250
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ACPM_GSM Description Initiates a number of spectrum measurements, either spec-
trum due to modulation or spectrum due to switching tran-
sients.

Parameters Mode,Count,Measurements
Mode – the measurement type. Set AVG for spectrum due to 
modulation or MAX for spectrum due to switching tran-
sients.
Count – Specifies the number of measurements to be 
performed.
Measurements – Specifies the channel offset frequencies at 
which the measurement is to be taken.

Example ACPM_GSM,AVG,5,0

AUDIO Description The speech loopback is activated and the incoming voice on 
the microphone of a mobile is echoed on the loudspeaker. 
The user is instructed to check whether both are working or 
not. Before using this command, the bit error rate loop must 
be opened first, otherwise speech loopback cannot work.

Parameters Signal
Signal – LOOPBACK for speech loopback in the instrument.

Notes See also BER_LOOP command.

Example AUDIO,LOOPBACK

BER_LOOP Description When a BER loop is closed then the appropriate measure-
ment is started and can run in parallel to other measure-
ments. A call needs to be established first.

Parameters Type,Count,Delay
Type = 0: Opens the BER loop.
Type = 1: Residual BER (A-loop).
Type = 2: Nonresidual BER (B-loop).
Type = 3: Fast BER (C-loop).
Count – Specifies the number of bits for comparison of 
received with transmitted bits.
Delay – Specifies the round-trip delay, which is the delay of 
the bits until they are looped back to the test instrument. If 
set to 0 then the instrument determines the round-trip 
delay before starting a measurement.

Notes The BER loop requires a Test SIM (with network parameters 
MCC = 001, MNC = 01) to be used in the mobile phone, 
otherwise the phone will not close the BER loop.
When the BER loop is switched on, the Audio speech loop is 
switched off automatically.
See also RBER_ALL, FBER_ALL, AUDIO commands.

Example BER_LOOP,1,8200,0



Chapter 7 Modifying and Creating Test Scripts

Test command reference – GSM commands

Lector and Scriptor Version 6.10 109

CALL_BY_BS Description A base station call is initiated by the test program.
If the mobile responds within 90 seconds the call will be 
established, otherwise a time-out is displayed and the test 
is stopped.

Parameters None.

Notes The base station simulation should be started before the 
phone is switched on: The phone may have scanned the 
BCCH frequency already, and it depends on the phone when 
it restarts the scan again, hence it may take a while until the 
network is found and the call is established.
See also CALL_BY_MS, TERM_BY_MS, TERM_BY_BS 
commands.

Example CALL_BY_BS

CALL_BY_MS Description Prepares the tester for accepting an incoming call (origi-
nated by the phone). If a call is established within 90 
seconds, the program continues the test; otherwise, a time-
out is displayed and the test is stopped.
The number to dial (see Parameters) is displayed and when 
the call is initiated by the phone, the number is compared 
with the received number.

Parameters Number
Number – Phone number to dial (will be displayed 
onscreen).

Notes The base station simulation should be started before the 
phone is switched on: The phone may have scanned the 
BCCH frequency already, and it depends on the phone when 
it restarts the scan again, hence it may take a while until the 
network is found and the call is established.
See also CALL_BY_BS, TERM_BY_MS, TERM_BY_BS 
commands.

Example CALL_BY_MS,+1234567890

CONFIG_BS_LEVEL Description Sets the power level transmitted by the instrument.

Parameters BS-Level
BS-Level – power level of the instrument, in dBm.

Notes See also CONFIG_CH

Example CONFIG_BS_LEVEL,-70

CONFIG_CH Description This command sets the actual traffic channel frequency and 
the power level of the test instrument and the mobile under 
test.

Parameters BSLevel,MSLevel,TCH
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.
MSLevel – The MS level can be set as a power level step in 
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the range from 5 to 19 in the lower band, and from 0 to 15 
in the upper band.
TCH – Defines the number of the traffic channel by way of 
one of the following expressions: LOW, MID, HIGH for the 
lower band, LOW_UP, MID_UP, HIGH_UP for the higher band, 
and LOW_TRI, MID_TRI, HIGH_TRI for the third band in the 
triple-band case. This sets the traffic channel according to 
the settings in the applicable Configuration > GSM menu.

Notes See also GSM_TYPE, SET_CHANNEL, SET_BCCH, 
CONFIG_BS_LEVEL, CONFIG_TCH_MSLEVEL

Example CONFIG_CH,-60,10,LOW

CONFIG_TCH_MSLEVEL Description This command configures the TCH number and the power 
level to be applied by the phone.

Parameters TCH,MSLevel
TCH – traffic channel frequency number
MSLevel – The MS level can be set as a power level step in 
the range from 5 to 19 in the lower band, and from 0 to 15 
in the upper band.

Notes See also CONFIG_CH.

Example CONFIG_TCH_MSLEVEL,5,10

COUPLING_AUTO Description Uses the TAC (type approval code) of the phone to set the 
coupling factors for the mobile phone, according to the 
entry in the coupling factor databases. The factors are 
frequency-dependent, therefore the frequency band must 
be specified. If the phone’s IMEI has not been read as yet, the 
command will query the phone.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_MODEL.

Example COUPLING_AUTO,900/1800

COUPLING_MODEL Description Uses the entry for the selected group and subgroup in the 
coupling factor databases to set the coupling factors. The 
factors are frequency-dependent, therefore the frequency 
band must be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_AUTO.

Example COUPLING_MODEL,900/1800
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FBER_ALL Description The fast bit error rate measurement is performed. The BER 
loop has to be closed first. The number of bits to be taken 
into account are specified when the loop is closed.

Parameters None.

Notes See also BER_LOOP, RBER_ALL commands.

Example BER_LOOP,1,3,20000
FBER_ALL

GSM_SENSITIVITY Description Decreases the instrument’s output power level in specified 
steps until the bit error rate (BER) exceeds a specified value.

Parameters STEP,BER
STEP – step size of the power decrease, in dB.
BER – bit error rate at which the test stops.

Example GSM_SENSITIVITY,2,0.1

GSM_TYPE Description Sets or changes the configuration between GSM 900/1800 
and 900/1900. May be used during the test of triple-band 
phones. The current TCH and the BCCH should to be in the 
900 MHz band because channel numbers are the same in 
the 1800 and 1900 MHz bands.

Parameters Band
Band – Specifies the band combination to activate. Allow-
able values are 900 and 1900, where “900” stands for the 
900/1800 combination and “1900” stands for 900/1900.

Notes See also SET_BCCH, SET_CHANNEL, CONFIG_CH.

Example GSM_TYPE,900

IMSI Description Sets the IMSI (International Mobile Station Identity) for 
tests starting with paging the phone.

Parameters Number
Number – 15-digit IMSI.

Example IMSI,001011234567890
CALL_BY_BS

MES_TADV Description The timing measurement is carried out on the transmitted 
burst. It describes the measured offset to the current 
setting of the Timing Advance parameter, in microseconds, 
and should be zero. A delay of one bit period corresponds to 
3.69 µs.

Parameters None.

Notes See also SET_TADV command.

Example SET_TADV,10
WAIT,1000
MES_TADV



Chapter 7 Modifying and Creating Test Scripts

Test command reference – GSM commands

112 Lector and Scriptor Version 6.10

MS_INFO Description The tester is commanded to read information from the 
mobile. This includes the IMSI number, IMEI number, the MS 
Class, and the dialed number if it was an MS Call. The dialed 
number will show only blank characters if a BS Call was 
performed. 
This command is usually carried out just after the call has 
been established to get this IMEI number (serial number of 
the phone). As a consequence, the test protocol can be allo-
cated to the right mobile even if the test terminates abnor-
mally.

Parameters None.

Notes See also MS_REPORT and MS_INFO_ALL commands.

Example CALL_BS_BS
MS_INFO

MS_INFO_ALL Description This command delivers the same information as the 
MS_INFO command, plus the following additional informa-
tion: Extended Frequency Range capability, Revision Level, 
Enhanced Full Rate capability, SMS, A5 Ciphering Key, Dual 
Band.

Parameters Output
Output – This field indicates which parameters shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– IMSI
– IMEI
– Power class
– Extended frequency range available
– Revision level
– Enhanced frequency
– SMS capabilities
– Encryption capabilities
– Dualband capability
– Dialed number

Notes See also MS_INFO command.

Example MS_INFO_ALL, 6
Returns the IMEI and the power class.
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MS_REPORT Description The measurement report from the mobile is read. It 
includes: RX Level, RX Quality, Power Control, Timing 
Advance. 
The measurement itself is performed by the mobile. 

Parameters ExpRxQual, Output
ExpRxQual – The expected RX Quality value in the range 
from 0 (BER is lower than 0.2%) to 7 (BER is higher than 
12.8%).
Output – This field indicates which parameters shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– RX Level
– RX Quality

Notes See also MS_INFO command.

Example MS_REPORT,3,3

PHASE_MAX Description RMS-valued TX phase error measurements are performed as 
many times as given by the parameter and then the 
maximum is calculated. Could be carried out after TX_ALL 
measurement if maximum value is needed for RMS phase 
error only. 

Parameters Count
Count – Number of measurements to be carried out.

Notes See also TX_ALL command.
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Example PHASE_MAX,5

RBER_ALL Description RX-related measurements are performed: residual bit error 
rate, Class Ib, Class II and frame erasure rate. The number of 
bits to be taken into account is specified when the BER loop 
is closed.

Parameters Output
Output – This field indicates which parameters shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– BER Class 2
– BER Class 1b
– FER

Notes The BER loop has to be closed first.
See also BER_LOOP, FBER_ALL, MS_REPORT commands.

Example BER_LOOP,1,8200,0
RBER_ALL
BER_LOOP,0,0,0

SET_BCCH Description Sets the Broadcast Control Channel number.

Parameters BCCH
BCCH – channel number of the Broadcast Control Channel. 
The channel numbers preloaded with the SET_CHANNEL 
command are addressed with BCCH for the value in the 
lower band, with BCCH_UP for the upper band and with 
BCCH_TRI for the third band in the triple-band case. This 
sets the Broadcast Control Channel number according to the 
settings in the applicable Configuration > GSM menu.

Notes The BCCH cannot be changed during an ongoing call.
See also SET_CHANNEL, GSM_TYPE, CONFIG_CH.

Example SET_CHANNEL,GSM9001800
SET_BCCH,BCCH_UP
CONFIG_CH,,,LOW

SET_CHANNEL Description The Low, Mid, High and BCCH channel numbers are 
predefined by this command, i.e. depending on the combi-
nation of frequency bands, the internal variables (such as 
LOW, MID, HIGH, BCCH for the lower band, LOW_UP, MID_UP, 
HIGH_UP, BCCH_UP for the upper band) are set. 
The real channel numbers can be modified by the user in the 
Configuration > Test Channels menu. This command has to 
be carried out before a channel setup is performed, usually 
at the beginning of a test script and when there is more 
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than one set of (single, dual or triple-band) channels, e.g. in 
a quad-band test. Note that the actual channel must be set 
before a test is started (see CONFIG_CH, SET_BCCH).

Parameters Band
Band – specifies the frequency bands used during the test. 
Allowable values: GSM850, GSM900, GSM8501900, 
GSM9001800, GSM9001900, E-GSM90018001900

Example SET_CHANNEL,GSM9001800
SET_BCCH,BCCH
CONFIG_CH,,,LOW

SET_TADV Description Sets the Timing Advance to be applied by the phone while 
on a dedicated channel.

Parameters TA – Number in the range from 0 to 63 bits describing the 
Timing Advance in bit periods.

Notes After setting the Timing Advance the mobile may need 
some time for readjusting itself. 
See also MES_TADV.

Example SET_TADV,10
WAIT,1000
MES_TADV

SET_TSLOT Description Sets the time slot on which to apply the traffic channel.

Parameters Timeslot
Timeslot – Slot number in the range from 2 to 6.

Example SET_TSLOT,5

TCH_TYPE Description Selects the type of voice traffic channel. The default is FR for 
Full Rate. The type of traffic channel cannot be changed 
while a call is established.

Parameters Codec
Codec – type of voice channel. Allowable values are FR for 
full rate voice channel, and EFR for enhanced full rate.

Example TCH_TYPE,FR

TERM_BY_BS Description The test instrument initiates a call release.

Parameters None.

Notes See also TERM_BY_MS command.

Example CALL_BY_MS,+1234567890
FASTPOWER,10
TERM_BY_BS
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TERM_BY_MS Description Prompts the user to initiate a call release on the phone 
(message "DISCONNECT" appears on the screen).

Parameters None.

Notes See also TERM_BY_BS command.

Example CALL_BY_BS
TX_ALL,5
TERM_BY_MS

TRIPLEBAND Description The triple-band instruction is shown on the screen and the 
test is halted until the test is continued by pressing a 
button.
It instructs the user to switch the mobile into PCS 1900 
mode.

Parameters None.

Notes See also SET_CHANNEL, GSM_TYPE, CONFIG_CH, SET_BCCH 
commands.

Example TRIPLEBAND

TX_ALL Description All TX-related measurements are carried out; these are RMS 
and peak phase error, frequency error, TX power, template 
check, corner points and flatness.

Parameters Average, Output
Average – Number of measurements to be carried out and 
averaged.
Output – This field indicates which parameters shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– TX power
– Template check
– Frequency error
– RMS phase error
– Peak phase error
– Timing advance

Notes See also TX_ALL_AVG, TX_POWER_AVG, PHASE_MAX 
commands.

Example TX_ALL,1,21

TX_POWER Description The TX Power of a mobile is measured only. No averaging or 
any other statistical evaluation is performed.

Parameters Average
Average – Number of measurements to be carried out and 
averaged.
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Notes See also TX_POWER_AVG, FASTPOWER, TX_ALL, 
TX_ALL_AVG commands.

Example TX_POWER,1

TX_TEMPLATE Description Compares the burst power shape of the phone with the 
template. The result is a Pass or Fail. This measurement is 
also performed with the TX_ALL command.

Parameters Count
Count – Number of measurements to be carried out.

Notes See also TX_ALL command.

Example TX_TEMPLATE
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Test command reference – GPRS commands

ACPM Description Initiates a number of spectrum measurements while a GPRS 
uplink channel is active (initiated by the START_BLER_USF 
command), either spectrum due to modulation or spectrum 
due to switching transients.

Parameters Mode, Count, Output
Mode – AVG or MAX, where AVG performs modulation spec-
trum measurements and MAX performs switching tran-
sients measurements.
Count – Number of measurements to be carried out.
Output – This field indicates which measurements at 
frequency offsets from the carrier shall be presented in the 
Result section on the Running menu and in the test protocol. 
Double-click on the command in the test script section of 
the Test Script Editor menu, and check the test parameters 
you want to see in the results section. Parameters that can 
be affected are:

– +/-100 kHz
– +/-200 kHz
– +/-250 kHz
– +/-400 kHz
– +/-600 kHz
– +/-800 kHz
– +/-1000 kHz
– +/-1200 kHz
– +/-1400 kHz
– +/-1600 kHz
– +/-1800 kHz

Notes See also START_BLER_USF and STOP_BLER_USF commands.

Example START_BLER_USF,100
BLER_USF
ACPM,MAX,5,1156
STOP_BLER_USF

BLER_USF Description Starts a BLER-USF measurement after an GPRS uplink 
channel has been set up with the START_BLER_USF 
command. The latter is also used to set the number of 
samples for the BLER-USF measurement. 

Parameters None.

Notes See also START_BLER_USF and STOP_BLER_USF commands.

Example START_BLER_USF,100
BLER_USF
STOP_BLER_USF
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CONFIG_GPRS_CH Description This command configures the frequency and the levels of 
the test instrument and of the mobile under test, in partic-
ular for multislot operation.

Parameters BSLevel,MSLevel1,MSLevel2,TCH
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.
MSLevel1 – The MS level in the first time slot can be set as 
a power level step in the range from 5 to 19 in the lower 
band, and from 0 to 15 in the upper band.
MSLevel2 – The MS level in the second time slot can be set 
as a power level step in the range from 5 to 19 in the lower 
band, and from 0 to 15 in the upper band.
TCH – Defines the number of the traffic channel by way of 
one of the following expressions: LOW, MID, HIGH. This sets 
the traffic channel according to the settings in the appli-
cable Configuration > GSM menu.

Notes See also GPRS_TYPE, SET_CHANNEL, SET_BCCH

Example CONFIG_GPRS_CH,-50,8,8,MID

COUPLING_AUTO Description Uses the TAC (type approval code) last found to set the 
coupling factors for the mobile phone, according to the 
entry in the coupling factor databases. The factors are 
frequency-dependent, therefore the frequency band must 
be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_MODEL.

Example COUPLING_AUTO,900/1800

COUPLING_MODEL Description Uses the entry for the selected group and subgroup in the 
coupling factor databases to set the coupling factors. The 
factors are frequency-dependent, therefore the frequency 
band must be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_AUTO.

Example COUPLING_MODEL,900/1800

GPRS_ATTACH Description Initiates a GPRS Attach procedure. The mobile phone must 
be attached before a connection can be set up and measure-
ments be performed.

Parameters None.

Notes See also GPRS_DETACH command.
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Example GPRS_ATTACH
TX_ALL_USF
GPRS_DETACH

GPRS_DETACH Description Initiates a GPRS Detach procedure. The phone should be 
detached from the simulated network after tests have been 
performed.

Parameters None.

Notes See also GPRS_ATTACH command.

Example GPRS_ATTACH
TX_ALL_USF
GPRS_DETACH

GPRS_TYPE Description Sets or changes the configuration between GSM 900/1800 
and 900/1900. May be used during the test of triple-band 
phones. The current TCH and the BCCH should to be in the 
900 MHz band because channel numbers are the same in 
the 1800 and 1900 MHz bands.

Parameters Band
Band – Specifies the band combination to activate. Allow-
able values are 900 and 1900, where “900” stands for the 
900/1800 combination and “1900” stands for 900/1900.

Notes See also SET_BCCH, SET_CHANNEL, CONFIG_CH.

Example GPRS_TYPE,900

IMSI Description Sets the IMSI (International Mobile Station Identity) for 
tests starting with paging the phone.

Parameters Number
Number – 15-digit IMSI.

Example IMSI,001011234567890
CALL_BY_BS

SET_BCCH Description Sets the Broadcast Control Channel number.

Parameters BCCH
BCCH – channel number of the Broadcast Control Channel.

Notes The BCCH cannot be changed during an ongoing call.
See also SET_CHANNEL, GPRS_TYPE.

Example SET_BCCH,63

SET_CHANNEL Description The Low, Mid, and High channels are defined by this 
command. 
The real channel numbers can be modified by the user in the 
Configuration > Test Channels menu. This command has to 
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be carried out before a channel setup is performed, usually 
at the beginning of a test script and when the frequency 
band is changed in a multi-band test.

Parameters Band
Band – specifies the frequency bands used during the test. 
Allowable values: GSM850, GSM900, GSM8501900, 
GSM9001800, GSM9001900, E-GSM9001800, E-
GSM9001900, E-GSM90018001900

Example SET_CHANNEL,E-GSM9001800

START_BLER_USF Description Activates a GPRS uplink channel so that BLER-USF and 
transmitter measurements become possible. The actual 
measurement is started with BLER_USF, and the channel is 
released with STOP_BLER_USF.

Parameters Samples, Slots
Samples – Number of samples for a BLER measurement.
Slots – Number of time slots used on the uplink.

Notes See also BLER_USF and STOP_BLER_USF commands.

Example START_BLER_USF,100,2
BLER_USF
STOP_BLER_USF

START_GPRS_TEST Description Activates a GPRS uplink channel so that transmitter 
measurements become possible. The actual measurement is 
started with BLER_USF, and the channel is released with 
STOP_GPRS_TEST.

Parameters Slots
Slots – Number of time slots used in the uplink.

Notes See also STOP_GPRS_TEST command.

Example START_GPRS_TEST,2
TX_ALL_GPRS,10,1
STOP_GPRS_TEST

STOP_BLER_USF Description Releases the GPRS channel that was previously activated 
with the START_BLER_USF command.

Parameters None.

Notes See also START_BLER_USF and BLER_USF commands.

Example START_BLER_USF,100,2
BLER_USF
STOP_BLER_USF

STOP_GPRS_TEST Description Releases the uplink channel previously established with the 
START_GPRS_TEST command.

Parameters None.
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Notes See START_GPRS_TEST command.

Example START_GPRS_TEST,2
TX_ALL_GPRS,10,1
STOP_GPRS_TEST

TX_ALL_GPRS Description Initiates a number of transmitter measurements while a 
GPRS uplink channel is active (initiated by the 
START_BLER_USF command). The measurements are: 
Phase Error RMS, Phase Error Peak, Frequency Error, TX 
Power, Timing Advance, Template Check.

Parameters Average, Timeslot, Output
Average – Number of measurements to be carried out and 
averaged.
Timeslot – Number of time slot to be measured.
Output – This field indicates which measurements shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– TX power
– Template check
– Frequency error
– RMS phase error
– Peak phase error
– Timing advance

Notes See also START_GPRS_TEST and STOP_GPRS_TEST

Example START_GPRS_TEST,2
TX_ALL_GPRS,10,1,21
STOP_GPRS_TEST

TX_ALL_USF Description Initiates a number of transmitter measurements while a 
GPRS uplink channel is active (initiated by the 
START_BLER_USF command). The measurements are: 
Phase Error RMS, Phase Error Peak, Frequency Error, TX 
Power, Timing Advance, Template Check.

Parameters Count, Timeslot, Output
Count – Number of measurements to be carried out.
Timeslot – Number of time slot to be measured.
Output – This field indicates which measurements shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
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script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– TX power
– Template check
– Frequency error
– RMS phase error
– Peak phase error
– Timing advance

Notes See also START_BLER_USF and STOP_BLER_USF commands.

Example START_BLER_USF,100,2
BLER_USF
TX_ALL_USF,10,1,13
STOP_BLER_USF
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Test command reference – EDGE commands

ACPM_EGPRS Description Initiates a number of spectrum measurements while an 
EGPRS uplink channel is active (initiated by the 
START_EGPRS_TEST command), either spectrum due to 
modulation or spectrum due to switching transients.

Parameters Mode, Count, Output
Mode – AVG or MAX, where AVG performs modulation spec-
trum measurements and MAX performs switching tran-
sients measurements.
Count – Number of measurements to be carried out.
Output – This field indicates which measurements at 
frequency offsets from the carrier shall be presented in the 
Result section on the Running menu and in the test protocol. 
Double-click on the command in the test script section of 
the Test Script Editor menu, and check the test parameters 
you want to see in the results section. Parameters that can 
be affected are:

– +/-100 kHz
– +/-200 kHz
– +/-250 kHz
– +/-400 kHz
– +/-600 kHz
– +/-800 kHz
– +/-1000 kHz
– +/-1200 kHz
– +/-1400 kHz
– +/-1600 kHz
– +/-1800 kHz

Notes See also START_EGPRS_TEST and STOP_EGPRS_TEST 
commands.

Example START_EGPRS_TEST
ACPM,AVG,3,546
STOP_EGPRS_TEST

BLER_USF Description Starts a BLER-USF measurement. The number of samples 
and the number of time slots is defined in the 
START_EGPRS_BLER command which also sets up the 
channel.

Parameters None.

Notes See also START_EGPRS_BLER, STOP_EGPRS_BLER

Example START_EGPRS_BLER,100,1
BLER_USF
STOP_EGPRS_BLER
Sets up an uplink EGPRS channel on one time slot, performs 
a measurement over 100 USF messages, and releases the 
channel.
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CONFIG_EGPRS_CH Description This command configures the frequency and the level of the 
test instrument and of the mobile under test.

Parameters BSLevel,MSLevel1,MSLevel2,TCH
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.
MSLevel1 – The MS level on the first time slot can be set as 
a power level step in the range from 5 to 19 in the lower 
band, and from 0 to 15 in the upper band.
MSLevel2 – The MS level on the second time slot can be set 
as a power level step in the range from 5 to 19 in the lower 
band, and from 0 to 15 in the upper band.
TCH – Defines the number of the traffic channel by way of 
one of the following expressions: LOW, MID, HIGH. This sets 
the traffic channel according to the settings in the appli-
cable Configuration > GSM menu.

Notes See also EGPRS_TYPE, SET_CHANNEL, SET_BCCH

Example CONFIG_EGPRS_CH,-60,10,8,5

COUPLING_AUTO Description Uses the TAC (type approval code) last found to set the 
coupling factors for the mobile phone, according to the 
entry in the coupling factor databases. The factors are 
frequency-dependent, therefore the frequency band must 
be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_MODEL.

Example COUPLING_AUTO,900/1800

COUPLING_MODEL Description Uses the entry for the selected group and subgroup in the 
coupling factor databases to set the coupling factors. The 
factors are frequency-dependent, therefore the frequency 
band must be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_AUTO.

Example COUPLING_MODEL,900/1800

EGPRS_ATTACH Description Initiates an EGPRS Attach procedure. The mobile phone 
must be attached before a connection can be set up and 
measurements be performed.

Parameters None.

Notes See also EGPRS_DETACH command.

Example EGPRS_ATTACH
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EGPRS_DETACH Description Initiates an EGPRS Detach procedure. The phone should be 
detached from the simulated network after tests have been 
performed.

Parameters None.

Notes See also EGPRS_ATTACH command.

Example EGPRS_DETACH

EGPRS_TYPE Description Sets or changes the configuration between GSM 900/1800 
and 900/1900. May be used during the test of triple-band 
phones. The current TCH and the BCCH should to be in the 
900 MHz band because channel numbers are the same in 
the 1800 and 1900 MHz bands.

Parameters Band
Band – Specifies the band combination to activate. Allow-
able values are 900 and 1900, where “900” stands for the 
900/1800 combination and “1900” stands for 900/1900.

Notes See also SET_BCCH, SET_CHANNEL, CONFIG_EGPRS_CH.

Example EGPRS_TYPE,900

IMSI Description Sets the IMSI (International Mobile Station Identity) for 
tests starting with paging the phone.

Parameters Number
Number – 15-digit IMSI.

Example IMSI,001011234567890
CALL_BY_BS

SET_BCCH Description Sets the Broadcast Control Channel number.

Parameters BCCH
BCCH – channel number of the Broadcast Control Channel.

Notes The BCCH cannot be changed during an ongoing call.
See also SET_CHANNEL, GPRS_TYPE.

Example SET_BCCH,63

SET_CHANNEL Description The Low, Mid, and High channels are defined by this 
command. 
The real channel numbers can be modified by the user in the 
Configuration > Test Channels menu. This command has to 
be carried out before a channel setup is performed, usually 
at the beginning of a test script and when the frequency 
band is changed in a multi-band test.
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Parameters Band
Band – specifies the frequency bands used during the test. 
Allowable values: GSM850, GSM900, GSM8501900, 
GSM9001800, GSM9001900, E-GSM9001800, E-
GSM9001900, E-GSM90018001900

Example SET_CHANNEL,E-GSM9001800

START_EGPRS_BLER Description This command initiates an EGPRS uplink channel, enabling 
EDGE BLER-USF and transmitter measurements.

Parameters Samples,Slots
Samples – Number of samples (USF messages) to be used.
Slots – Number of time slots to be measured.

Notes See also BLER_USF, STOP_EGPRS_BLER

Example START_EGPRS_BLER,100,1
BLER_USF
STOP_EGPRS_BLER
Sets up an uplink EGPRS channel on one time slot, performs 
a measurement over 100 USF messages, and releases the 
channel.

START_EGPRS_TEST Description This command activates an EGPRS uplink channel, enabling 
EDGE transmitter measurements.

Parameters Slots
Slots – Number of time slots to be measured.

Notes See also STOP_EGPRS_TEST command.

Example START_EGPRS_TEST,2
TX_ALL_EGPRS,10,1
STOP_EGPRS_TEST

STOP_EGPRS_BLER Description This command releases an EGPRS uplink channel previously 
set up with the START_EGPRS_BLER command.

Parameters None.

Notes See also START_EGPRS_BLER, BLER_USF

Example START_EGPRS_BLER,100,1
BLER_USF
STOP_EGPRS_BLER
Sets up an uplink EGPRS channel on one time slot, performs 
a measurement over 100 USF messages, and releases the 
channel.

STOP_EGPRS_TEST Description Releases the EGPRS uplink channel previously set up with 
the START_EGPRS_TEST command.

Parameters None.

Notes See also START_EGPRS_TEST command.
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Example START_EGPRS_TEST,2
TX_ALL_EGPRS,10,2
STOP_EGPRS_TEST

TX_ALL_EGPRS Description Starts a number of transmitter measurements on the EGPRS 
uplink channel previously set up with the 
START_EGPRS_TEST command. The measurement parame-
ters are: TX Power, Template Check, Error Vector Magnitude 
RMS, Error Vector Magnitude Peak.

Parameters Average,Timeslot,Output
Average – Number of measurements to be carried out and 
averaged.
Timeslot – Uplink time slot to be measured.
Output – This field indicates which measurements shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– TX power
– Template check
– RMS error vector magnitude
– Peak error vector magnitude

Notes See also START_EGPRS_TEST and STOP_EGPRS_TEST 
commands.

Example START_EGPRS_TEST
TX_ALL_EGPRS,10,1,9
STOP_EGPRS_TEST
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Test command reference – WCDMA commands

ACLR Description Initiates an adjacent channel leakage ratio (ACLR) measure-
ment; the results, in dBc, are averaged for each of the four 
adjacent channels (±5 and ±10 MHz).

Parameters Count
Count – Number of measurements to be carried out.

Example ACLR,1

AUDIO Description The speech loopback is activated and the incoming voice on 
the microphone of a mobile is echoed on the loudspeaker. 
The is instructed to check whether both are working or not. 
Before using this command, the bit error rate loop must be 
opened first, otherwise speech loopback cannot work. A 
speech call must be active.

Parameters Signal
Signal – LOOPBACK for speech loopback in the instrument.

Example CALL_BY_NB,SPEECH
AUDIO,LOOPBACK

CALL_BY_NB Description CallType

Parameters CallType
CallType = SPEECH: a voice channel is set up, the instrument 
loops back the voice data (echo function).
CallType = LOOPBACK: a reference measurement channel 
RMC is set up and the data sent by the tester should be 
looped back by the phone.

Notes See SET_WCDMA_RMC, TERM_BY_NB commands.

Example CALL_BY_NB,SPEECH

CLOSED_LOOP Description The instrument sends a number of 1 dB power up or down 
commands in the closed loop power control to increase the 
power level by 10 dB nominally. The mobile phone should 
increase or decrease the power level in steps of 1 dB. The 
tester measures the step width and records the actual 
minimum and maximum step width. The power level is then 
directed to the original power level and the procedure 
repeats if more than one measurement is requested.

Parameters Direction,Count
Direction – Can take on the values UP or DOWN for power 
steps up or down, respectively.
Count – Number of measurements to be carried out.

Notes See also CLOSED_LOOPII

Example CLOSED_LOOP,UP,5
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CLOSED_LOOPII Description The instrument sends a number of 1 dB power up or down 
commands in the closed loop power control to increase the 
power level by 10 dB nominally. The mobile phone should 
increase the power level in steps of 1 dB. The tester 
measures the overall power change (nominally 10 dB). The 
power level is then directed to the original power level and 
the procedure repeats if more than one measurement is 
requested.

Parameters Direction,Count
Direction – Can take on the values UP or DOWN for power 
steps up or down, respectively.
Count – Number of measurements to be carried out.

Notes See also CLOSED_LOOP

Example CLOSED_LOOPII,DOWN,1

CONFIG_CH Description This command configures the frequency and the power 
level of the test instrument and of the mobile under test.

Parameters BSLevel,MSLevel,TCH
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.
MSLevel – The MS level can be set in dBm.
TCH – Channel; use HIGH, MID or LOW to reference the 
channel numbers, or enter an uplink channel number.

Note This command is also used for other access technologies.

Examples CONFIG_CH,-60,-30,LOW
CONFIG_CH,-70,-35,9750

COUPLING_AUTO Description Uses the TAC (type approval code, part of the IMEI) last 
found to set the coupling factors for the mobile phone, 
according to the entry in the coupling factor databases. The 
factors are frequency-dependent, therefore the frequency 
band must be specified.

Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900. For the purpose of WCDMA testing, 
use the WCDMA value.

Notes This command is also used for other access technologies.

Example COUPLING_AUTO,WCDMA

Notes See also COUPLING_MODEL.

Example COUPLING_AUTO,900/1800

COUPLING_MODEL Description Uses the entry for the selected group and subgroup in the 
coupling factor databases to set the coupling factors. The 
factors are frequency-dependent, therefore the frequency 
band must be specified.
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Parameters Mode
Mode – Allowable entries are WCDMA, 850, 850/1900, 900, 
900/1800, 1800, 1900.

Notes See also COUPLING_AUTO.

Example COUPLING_MODEL,WCDMA

MODULATION_ALL Description Initiates a number of measurements of the modulation 
quality parameters. The results are averaged.

Parameters Average
Average – Number of measurements to be carried out and 
averaged.
Output – This field indicates which measurements shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– RMS phase error
– Peak phase error
– Frequency error
– RMS magnitude error
– Peak magnitude error
– RMS error vector magnitude
– Peak error vector magnitude
– Rho
– I/Q offset
– I/Q imbalance

Example MODULATION_ALL,10,69

MS_INFO Description The tester is commanded to read information from the 
mobile. This includes the IMSI number, IMEI number, the MS 
Class, and the dialed number if it was an MS Call. The dialed 
number will show only blank characters if a BS Call was 
performed. 
This command is usually carried out just after the call has 
been established to get this IMEI number (serial number of 
the phone). As a consequence, the test protocol can be allo-
cated to the right mobile even if the test terminates abnor-
mally.

Parameters None.

Example REGISTRATION,
MS_INFO

OBW Description Initiates a number of occupied bandwidth (OBW) measure-
ments; the results of the OBW (in MHz) are averaged.
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Parameters Average
Average – Number of measurements to be carried out and 
averaged.

Example OBW,1

OPEN_LOOP Description This command initiates a single open-loop power measure-
ment.

Parameters None.

Example OPEN_LOOP

PCDE Description Initiates a number of peak code domain error (PCDE) 
measurements; the results are averaged.

Parameters Average
Average – Number of measurements to be carried out and 
averaged.

Example PCDE,5

REGISTRATION Description Initiates registration or unregisters the mobile phone 
(required at the beginning and end of a test connection).

Parameters RegType
RegType = YES: Invites the mobile phone to register.
RegType = CLEAR: Clears the current registration.

Example REGISTRATION,YES
CALL_BY_NB,LOOPBACK
UL_POWER_MAX
TERM_BY_NB,LOOPBACK
REGISTRATION,CLEAR

RSCP Description Takes a sample of the received signal code power reported 
by the mobile phone.

Parameters None.

Example RSCP

SEM Description Initiates a number of spectrum emission mask (SEM) 
measurements; the results are compared to a template and 
if one area in all the measurements hits the template, the 
result is FAIL, otherwise PASS.

Parameters Count
Count – Number of measurements to be carried out.

Example SEM,3

SET_CHANNEL Description Prepares the HIGH, MID, LOW channel variables for WCDMA 
(or another frequency band).
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Parameters ChannelAllocation
ChannelAllocation – specifies the frequency band(s) to be 
tested. Allowable inputs are: E-GSM9001800, E-
GSM9001900, GSM850, GSM8501900, GSM1900, 
GSM9001800, GSM 9001900, WCDMA. For WCDMA testing, 
use WCDMA.

Note This command is also used for other access technologies.

Example SET_CHANNEL,WCDMA

SET_WCDMA_RMC Description Sets the type of Reference Measurement Channel to be 
used.

Parameters RMC
RMC – specifies the data rate of the Reference Measurement 
Channel, in kbit/s. Allowable inputs are: 12, 64, 144, 386.

Example SET_WCDMA,12

TERM_BY_NB Description This command initiates the test instrument to terminate an 
ongoing connection (call).

Parameters CallType
CallType = SPEECH: a voice channel was set up.
CallType = LOOPBACK: a reference measurement channel 
RMC was set up and the loopback is released.

Notes See also CALL_BY_NB command.

Example CALL_BY_NB,LOOPBACK
TERM_BY_NB,LOOPBACK

UL_POWER_MAX Description Directs the mobile phone to transmit at its maximum power 
level, takes a number of measurements and averages the 
results.

Parameters Count
Count – Number of measurements to be carried out.

Notes See also UL_POWER_MIN, UL_POWER_MEAN commands.

Example UL_POWER_MAX,10

UL_POWER_MEAN Description Takes a number of measurements of the current uplink 
power level and calculates the average value of the results.

Parameters Count
Count – Number of measurements to be taken and aver-
aged.

Example UL_POWER_MEAN,10
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UL_POWER_MIN Description Directs the mobile phone to transmit at its minimum power 
level, takes a number of measurements and averages the 
results.

Parameters Count
Count – Number of measurements to be carried out.

Notes See also UL_POWER_MAX, UL_POWER_MEAN commands.

Example UL_POWER_MIN,5

WCDMA_BER Description Sets the output power of the instrument to the level speci-
fied, and takes a number of BER measurements. The results 
are averaged.

Parameters Average,BSLevel
Average – Number of measurements to be carried out and 
averaged.
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.

Example WCDMA_BER,3,-106.7

WCDMA_BLER Description Sets the output power of the instrument to the level speci-
fied, and takes a number of BLER measurements. The results 
are averaged.

Parameters Samples,BSLevel
Samples – Number of samples (blocks) that the instrument 
transmits to test the receiver.
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.

Example SET_WCDMA_RMC,12
CALL_BY_NB,LOOPBACK
WCDMA_BLER,100,-106.7
TERM_BY_NB,LOOPBACK

WCDMA_HANDOVER_TO_GSM Description Performs an inter-RAT handover from WCDMA to GSM.

Parameters Band,BSLevel,MSLevel,TCH, CallType
Band – Allowable entries are GSM850, GSM8501900, 
GSM900, GSM9001800, GSM1800, GSM1900.
BSLevel – Defines the level received from the simulated GSM 
base station in dBm, in the range from –120 to –10.
MSLevel – The MS level on the GSM channel can be set in 
dBm.
TCH – Channel; use HIGH, MID or LOW to reference the 
channel numbers.
CallType – Allowable entries are Voice and RMC. This param-
eter lets you select between a voice channel and a reference 
measurement channel (RMC).

Notes A voice call must be active during the handover. If the phone 
is in idle mode, a WCDMA speech call will be set up.
The call must not be in loopback mode!



Chapter 7 Modifying and Creating Test Scripts

Test command reference – WCDMA commands

Lector and Scriptor Version 6.10 135

Example CALL_BY_NB,SPEECH
WCDMA_HANDOVER_TO_GSM,GSM9001800,-60,5,LOW,
VOICE

WCDMA_SENSITIVITY Description Performs a receiver sensitivity measurement by decreasing 
the power (Ior) in defined steps until a certain bit error rate 
(BER) is exceeded.

Parameters StepSize,BERvalue
StepSize – After each BER measurement, the power level, 
Ior, is decreased by this value, given in dB.
BERvalue – The measurement is stopped and the current Ior 
value is noted when this BER value, expressed as a 
percentage, is exceeded.

Example WCDMA_SENSITIVITY,1,0.1
The instrument performs BER measurements, decreases its 
output power level by 1 dB between each measurement 
until the measurement result exceeds 0.1%.

WCDMA_TYPE Description Prepares the tester for WCDMA tests (initialization).

Parameters Band – Defines the WCDMA band in the range from 1 to 10. 

Example WCDMA_TYPE,1
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Test command reference – HSDPA commands

CALL_BY_NB Description CallType

Parameters CallType,TestMode,LoopbackType
CallType = SPEECH: a voice channel is set up, the instrument 
loops back the voice data (echo function).
CallType = LOOPBACK: a reference measurement channel 
RMC is set up and the data sent by the tester should be 
looped back by the phone.
CallType = HSDPA-LOOPBACK: loopback measurements on 
HSDPA channels.
TestMode – can take on the values BER or BER+BLER. These 
are two different test modes for HSDPA; some phones only 
support one method. The TestMode parameter is required 
only with CallType = HSDPA-LOOPBACK.
LoopbackType = MAX-THROUGHPUT: the maximum data 
throughput rate is tested in HSDPA.
LoopbackType = TX-MEAS: the transmitter measurements 
can be performed while in HSDPA loopback mode.
LoopbackType = MAX-INPUT-LEVEL: the HSDPA receiver 
measurement is performed at an input level of –25 dBm.

Notes See TERM_BY_NB command.
Due to power level restrictions in the tester, the MAX-INPUT-
LEVEL loopback test is not supported in conjunction with the 
4916 Antenna Coupler.

Example CALL_BY_NB,SPEECH

CONFIG_CH Description This command configures the frequency and the power 
level of the test instrument and of the mobile under test.

Parameters BSLevel,MSLevel,TCH
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.
MSLevel – The MS level can be set in dBm.
TCH – Channel; use HIGH, MID or LOW to reference the 
channel numbers, or enter an uplink channel number.

Note This command is also used for other access technologies.

Examples CONFIG_CH,-60,-30,LOW
CONFIG_CH,-70,-35,9750

HSDPA_ACLR Description Initiates an adjacent channel leakage ratio (ACLR) measure-
ment; the results, in dBc, are averaged for each of the four 
adjacent channels (±5 and ±10 MHz).

Parameters Count
Count – Number of measurements to be carried out.

Example HSDPA_ACLR,1
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HSDPA_ATTACH Description Initiates an HSDPA Attach. The Attach is a prerequisite for 
setting up a connection and performing subsequent 
measurements. If the wireless device does not attach within 
the timeout limit specified, the HSDPA Attach fails.

Parameters Timeout
Timeout = number (valid range 1to 1000): uses the 
timeout value specified in seconds.

Example HSDPA_ATTACH,140

HSDPA_BLER Description Sets the output power of the instrument to the level speci-
fied, and takes a number of BLER measurements. The results 
are averaged.

Parameters Samples,BSLevel
Samples – Number of samples (blocks) that the instrument 
transmits to test the receiver.
BSLevel – Defines the base station level (RF output level of 
the instrument) in dBm, in the range from –120 to –10.

Example CALL_BY_NB,LOOPBACK
HSDPA_BLER,100,-106.7
TERM_BY_NB,LOOPBACK

HSDPA_MODULATION_ALL Description Initiates a number of measurements of the modulation 
quality parameters. The results are averaged.

Parameters Average
Average – Number of measurements to be carried out and 
averaged.
Output – This field indicates which measurements shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– RMS phase error
– Peak phase error
– Frequency error
– RMS magnitude error
– Peak magnitude error
– RMS error vector magnitude
– Peak error vector magnitude
– Rho
– I/Q offset
– I/Q imbalance

Example HSDPA_MODULATION_ALL,10,69

HSDPA_OBW Description Initiates a number of occupied bandwidth (OBW) measure-
ments; the results of the OBW (in MHz) are averaged.
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Parameters Average
Average – Number of measurements to be carried out and 
averaged.

Example HSDPA_OBW,1

HSDPA_POWER_MAX Description Directs the mobile phone to transmit at its maximum power 
level, takes a number of measurements and averages the 
results.

Parameters Count
Count – Number of measurements to be carried out.

Example HSDPA_POWER_MAX,10

HSDPA_TYPE Description Initializes the tester for HSDPA tests, in particular for the 
WCDM and HSDPA frequency band.

Parameters Band
Band – Allowable entries are 1, 2, 3, 4, 5, 6, 7, 8, 9 and 10.

Example HSDPA_TYPE,1

MS_INFO Description The tester requests information from the wireless device 
and forwards it to Lector and Scriptor. Information gathered 
includes IMSI, IMEI, MS class and, for an MS call, the dialed 
number (left blank for a BS call).

Parameters None.

Example MS_INFO

SET_CHANNEL Description The Low, Mid, and High channels are defined by this 
command. 
The real channel numbers can be modified by the user in the 
Configuration > Test Channels menu. This command has to 
be carried out before a channel setup is performed, usually 
at the beginning of a test script and when the frequency 
band is changed in a multi-band test.

Parameters Band
Band – specifies the frequency bands used during the test. 
Allowable values: GSM850, GSM900, GSM8501900, 
GSM9001800, GSM9001900, E-GSM9001800, E-
GSM9001900, E-GSM90018001900, WCDMA

Example SET_CHANNEL,WCDMA

TERM_BY_NB Description This command initiates the test instrument to terminate an 
ongoing connection (call).
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Parameters CallType
CallType = SPEECH: a voice channel was set up.
CallType = LOOPBACK: a reference measurement channel 
RMC was set up and the loopback is released.

Notes See also CALL_BY_NB command.

Example CALL_BY_NB,LOOPBACK
TERM_BY_NB,LOOPBACK

THROUGHPUT Description This command performs the maximum throughput test. The 
result is obtained in terms of Mbit/s, and depends on the 
UE Category, see Table 13 on page 183.

Parameters None.

Example CALL_BY_NB,LOOPBACK
THROUGHPUT
TERM_BY_NB,LOOPBACK
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Test command reference – CDMA commands

AREA_CODE_LESS_THAN_OR_
EQUAL

Description This command checks the area code of the phone’s MIN. If 
the area code exceeds the value entered, the test will fail. 
The command should be applied immediately after setting 
up a call.

Parameters MaximumMIN
MaximumMIN – The highest value that the MIN of the phone 
under test may take on.

Notes See also ESN_MEID_NOT_ALL_0, ESN_MEID_NOT_ALL_F.

Example CDMA_CALL_BY_BS
AREA_CODE_LESS_THAN_OR_EQUAL,201

CDMA_CALL_BY_BS Description This command is used to page the mobile. Once the mobile 
is on a call registration information is retrieved from the 
mobile and printed. The optional parameter can be used to 
stop the printing of the registration information. This may 
be desirable if this information has already been printed by 
some other means.

Parameters [NotPrintMobileInfo]
NotPrintMobileInfo = 0: prints the registration information. 
The value is automatically set to 0 if it is not specified.
NotPrintMobileInfo = 1: does not print the mobile registra-
tion information on the test printout.

Example CDMA_CALL_BY_BS
This will cause the mobile to be paged, and the registration 
information will be printed since the optional parameter has 
not been used.

CDMA_CALL_BY_MS Description This command prepares the tester for an incoming CDMA 
call. With this function the operator is prompted to press all 
12 keys on the mobile and originate a call. If the call is 
successful the digits dialed are printed. If the keypad test is 
enabled the presence of all 12 digits in the sequence dialed 
are tested for.

Parameters KeypadTest
KeypadTest = number. 0 = Do not perform a keypad test.
1 = Perform a keypad test

Example CDMA_CALL_BY_MS,0
The operator will be prompted to originate a call from the 
mobile, and the keypad test will not be performed.
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CDMA_FER_SETUP Description This command can be used to enable and use the FER, conf. 
level and frames parameters found in the 4400 manual 
mode FER menu. This allows for the control of the maximum 
number of frames that will be transmitted to the mobile 
during an FER test as well as the pass/fail parameters.

Parameters MaxFram,ConfLev,LimLev,EnabOnOff
MaxFram = NULL: the frame error rate (FER) maximum 
frame count remains unchanged.
MaxFram = number: sets the frame error rate (FER) 
maximum frame count to the number specified (100 to 
10000).
MaxFram = CONFIG: sets the frame error rate (FER) 
maximum frame count to the values specified in the appli-
cable limits file.
ConfLev = NULL: the frame error rate (FER) pass/fail confi-
dence level remains unchanged.
ConfLev = number: sets the frame error rate (FER) pass/fail 
confidence level to the number specified (90.0 to 100.0%).
ConfLev = CONFIG: sets the frame error rate (FER) maximum 
frame count to the values specified in the applicable limits 
file.
LimLev = NULL: the frame error rate (FER) pass/fail limit 
remains unchanged.
LimLev = number: sets the frame error rate (FER) pass/fail 
limit to the number specified (0.0 to 5.0%).
LimLev = CONFIG: sets the frame error rate (FER) maximum 
frame count to the values specified in the the applicable 
limits file.
EnabOnOff = NULL: the frame error rate (FER) pass/fail limit 
enable status remains unchanged.
EnabOnOff = ON: enables the frame error rate (FER) pass/
fail limit.
EnabOnOff = OFF: disables the frame error rate (FER) pass/
fail limit

Example CDMA_FER_SETUP,200,100,,ON
The maximum FER test frame count is set to 200, the confi-
dence level is set to 100% ensuring that all 200 frames will 
be transmitted, the pass/fail limit is not changed and the 
limit status is enabled.

CDMA_FER_VERR Description The instrument has the ability to perform RX and TX 
measurements concurrently, drastically reducing test times. 
This command utilizes this capability and allows TX vector 
error test and a mobile power test to be performed during a 
frame error rate (FER) test. The maximum power and 
minimum power tests run during FER utilize all up and all 
down power control bits respectively. Average power is run 
in accordance with the open loop estimate formula. A single 
occurrence of the TX vector error and power measurement 
is performed. The Count parameter controls the number of 
FER measurements performed.
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Parameters Count,BSLevel,TCHLevel[,AddTest] [,PowerControlReset] 
[,PrintOut]
Count = NULL: Count is set to 1.
Count = number: Count is set to number (1 to 100).
BSLevel = NULL: the 4400 RF output level remains 
unchanged.
BSLevel = MIN: sets the 4400 RF output level to the 
minimum base power specified.
BSLevel = number: sets the 4400 RF output level to the 
specified number in dBm (–120.0 to –10.0).
TCHLevel = NULL: the 4400 traffic channel level remains 
unchanged.
TCHLevel = CONFIG: sets the 4400 traffic channel level to the 
FER test traffic level specified.
TCHLevel = number: sets the 4400 traffic channel level (in 
dBm) to the number specified (–5.0 to –32.0).
AddTest = NULL: AddTest is set to 0.
AddTest = number: (7 if not supplied) additional TX tests 
are performed concurrently to frame error rate (FER) as 
follows:
0 = No TX tests
1 = TX vector error
2 = TX max power
3 = TX vector error and max power
4 = TX minimum power
5 = TX vector error and minimum power
6 = TX average power
7 = TX vector error and average power
PowerControlReset = NULL: PowerControlReset is set to 
FALSE.
PowerControlReset = FALSE: no power control reset of the 
mobile is performed at the conclusion of the FER test 
(default if not supplied).
PowerControlReset = TRUE: a power control reset of the 
mobile is performed at the conclusion of the FER test.
PrintOut = number: In the Test Script Editor, double-click on 
the CDMA_FER_VERR command and in the dialog box 
popping up, click on Select. You can now check the measure-
ments that you want to appear in the results section: 

– Waveform quality (rho) 
– Frequency error
– Time error
– Carrier feedthrough
– IQ imbalance
– Peak phase error
– RMS phase error
– RMS vector error
– Peak magnitude error
– RMS magnitude error
– RF power

Examples CDMA_FER_VERR,1,MIN,CONFIG
This command performs a single FER sensitivity test (the 
instrument’s RF output level is set to the minimum base 
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power specified), and all of the TX tests listed under the 
Printout parameter (2047). The RF power test is average 
power, so the closed loop power control is not changed 
during the test.

CDMA_FER_VERR,1,-25,CONFIG,4
This command performs a single FER dynamic range test 
(the instrument’s RF output level is set to –25 dBm), and a 
Minimum RF power test. Closed loop power control is set to 
all down bits during the test and is returned to the previous 
mode once the test is complete. The vector error tests are 
performed, but do not appear on the printout.

CDMA_FER_VERR,1,MIN,CONFIG,3
This command performs a single FER sensitivity test (the 
instrument’s RF output level is set to the minimum base 
power specified), and all of the TX tests listed under the 
Printout parameter (2047). The RF power test is max power, 
so the closed loop power control is all up. A power control 
reset is not performed at the conclusion of the test, but the 
power control mode is returned to its initial state. All of the 
vector error tests are reported on the printout.

CDMA_FER_VERR,1,MIN,CONFIG,3,TRUE
This command performs a single FER sensitivity test (the 
4400 RF output level is set to the minimum base power 
specified in the mobile settings), and all of the TX tests 
listed under the Printout parameter (2047). The RF power 
test is max power, so the closed loop power control is all up. 
A power control reset is performed at the conclusion of the 
test, and the power control mode is returned to its initial 
state. All of the vector error tests are reported on the 
printout.

CDMA_FER_VERR,1,MIN,CONFIG,3,TRUE,1163
This command performs a single FER sensitivity test (the 
4400 RF output level is set to the minimum base power 
specified in the mobile settings), and all of the TX tests 
listed under the Printout parameter (2047). The RF power 
test is max power, so the closed loop power control is all up. 
A power control reset is performed at the conclusion of the 
test, and the power control mode is returned to its initial 
state. The vector error tests reported are RF power, rms 
vector error, carrier feedthrough, frequency error, and wave-
form quality (rho) (1024 + 128 + 8 + 2 + 1).

CDMA_HOFF_TRAF Description This command performs a handoff, and allows for changes 
in the band, channel, radio configuration, and service option. 
Changes in all four of these parameters are not recom-
mended.

Parameters Band,Chan,Rcon,Sopt
Band = NULL: the band is not changed.
Band = PRIMARY: sets the band to the first band in the dual-
band test.
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Band = SECONDARY: sets the band to the second band in the 
dual-band test.
Band = US800: sets the band to the US 800 MHz cellular 
band.
Band = USPCS: sets the band to the US PCS 1900 MHz band.
Band = KPCS: sets the band to the Korean PCS 1700 MHz 
band.
Band = NMT450: sets the band to the 450 MHz band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains unchanged.
Chan = CONTROL: sets the channel to the same value as the 
control channel.
Chan = LOW, MID, HIGH: sets the channel to the value set for 
one of the channels in the long test.
Chan = TRAFFIC: sets the channel to the value set in the 
traffic channel for the short test.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected)
Rcon = NULL: the radio configuration remains unchanged.
Rcon = CONFIG: sets the radio configuration to the value set.
Rcon = number: sets the radio configuration to the value 
specified (range 1 to 5).
Sopt = NULL: the service option remains unchanged.
Sopt = CONFIG: sets the service option to the value set.
Sopt = number: sets the radio configuration to the value 
specified (1, 2, 3, 9, 17, 55, 32768)

Example CDMA_HOFF_TRAF,US800,MID,,
This command performs a handoff to the US 800 (cellular) 
band with the channel specified for the long test middle 
channel. The Rcon and Sopt are left empty, indicating that 
the current settings should be maintained.

CDMA_LEVEL Description This command sets the instrument’s RF output level to the 
BaseLevel value. If BaseLevel is not supplied then no change 
is made.

Parameters BaseLevel
BaseLevel = NULL: the 4400 RF output level remains 
unchanged.
BaseLevel = MINIMUM: sets the instrument’s RF output level 
to the minimum base power specified.
BaseLevel = number: sets the instrument’s RF output level 
to the specified number in dBm (–120.0 to –10.0).

Example CDMA_LEVEL,-40
The instrument’s RF output level is set to –40.0 dBm.

CDMA_NETWORK Description Enables the CDMA mode of the instrument.

Parameters None.

Example CDMA_NETWORK
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CDMA_POW Description This command performs a number (Count) of open loop 
power measurements on the mobile. If Count is greater than 
1, minimum, maximum and average values are reported. If 
Count is NULL or 1 then the single measurement value is 
reported. The limits are determined by the open loop esti-
mate formula.

Parameters Count
Count = NULL: Count is set to 1
Count = number: (1 to 100)

Example CDMA_POW,10
10 open loop power measurements are made and the 
maximum, minimum and average values are reported.

CDMA_POWER_CONTROL Description This command is used to set the closed loop power control 
mode of the instrument. The instrument can send all power 
up bits, all power down bits, or a specific number of power 
up or power down bits to the mobile. It can send alternating 
power up and power down bits to the mobile. It can also 
send the appropriate number of power up or power down 
bits to actively set the mobile output power to the correct 
level as determined by the open loop estimate formula 
(active).
The optional second parameter (reset) can be used in the 
alternating or active power control mode to reset the 
mobile output power to the value determined by the open 
loop estimate formula. This is a single shot operation. Once 
the reset is complete, the instrument returns to the alter-
nating or active power control mode.

Parameters PowCtrlCmd,[ PowCtrlCmd] 
PowCtrlCmd = UP: all power control bits are set to up.
PowCtrlCmd = DOWN: all power control bits are set to down.
PowCtrlCmd = ALTERNATING: alternating power control bits.
PowCtrlCmd = ACTIVE: active power control.
PowCtrlCmd = number: a specific number of down or up 
power control bits (–100 to +100 but not 0).
PowCtrlCmd = RESET: causes a power control reset proce-
dure to be performed on the mobile.

Example CDMA_POWER_CTRL, ALT,RESET
The instrument is set to the alternating power control 
mode, and the mobile is sent the appropriate number of 
power up or power down bits necessary to correct its power 
output as determined by the open loop estimate formula. 
Once the reset is complete, the instrument remains in the 
alternating mode.

CDMA_REL_BY_BS Description This command performs a base station release.

Parameters None.
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Example CDMA_REL_BY_BS
This will cause the instrument to release the call to the 
mobile.

CDMA_TX_WQU Description This command performs a number of (Count) TX waveform 
quality measurements. If Count is not supplied it is set to 1. 
If Count is greater than 1 maximum, minimum, and average 
values are reported. Only the tests included in Printout are 
reported. The RF power test performed is open loop. Limits 
for RF power are based on the open loop estimate formula.

Parameters Count[,Printout]
Count = NULL: Count is set to 1
Count = number: (1 to 100)
Printout: Select the tests that are to be printed in the 
printout. In the Test Script Editor, open the CDMA_TX_WQU 
dialog box and click on Select to choose from the following 
measurements:
Waveform quality (rho)
Frequency error
Time error
Carrier feedthrough
IQ imbalance
Peak phase error
RMS phase error
RMS vector error
Peak magnitude error
RMS magnitude error
RF power

Example CDMA_TX_WQU,,3
Since Count is not supplied, tests are reported as single 
values. Only waveform quality (rho) and frequency error are 
reported.

CDMA_TRAF Description This command sets the CDMA traffic channel parameters 
(Band, RF Channel, Radio Configuration, and Service Option) 
to explicit values (numbers).

Parameters Band,Chan,Rcon,Sopt
Band = NULL: the band remains unchanged.
Band = PRIMARY: sets the band to the first band in the dual-
band test.
Band = SECONDARY: sets the band to the second band in the 
dual-band test.
Band = CELLULAR: sets the band to the US 800 MHz cellular 
band.
Band = PCS: sets the band to the US PCS 1900 MHz band.
Band = KOREAN: Set the band to the Korean PCS 1700 MHz 
band.
Band = NMT450: sets the band to the 450 MHz band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains unchanged.
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Chan = CONTROL: sets the channel to the same value as the 
control channel.
Chan = LOW, MID, HIGH: Set the channel to the value set for 
one of the channels in the long test.
Chan = TRAFFIC: sets the channel to the value set in the 
traffic channel for the short test.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected).
Rcon = NULL: the radio configuration remains unchanged.
Rcon = CONFIG: sets the radio configuration to the preset 
value.
Rcon = number: sets the radio configuration to the value 
specified (range 1 to 5).
Sopt = NULL: the service option remains unchanged.
Sopt = CONFIG: sets the service option to the preset value.
Sopt = number: sets the radio configuration to the value 
specified (1, 2, 3, 9, 17, 55, 32768).

Example CDMA_TRAF, PRIME,LOW,CONFIG,CONFIG
Sets the CDMA traffic band to the first band selected for a 
dual-band test. Sets the CDMA traffic channel to the low 
channel value selected for the long test. Sets the CDMA 
traffic radio configuration and service option to the values 
selected.

CDMA_VOICE_CHECK Description This performs a voice loopback check. The operator is 
prompted to perform a voice check and provide a pass/fail 
decision.

Parameters None.

Example CDMA_VOICE_CHECK

CHANGE_CCCH Description This command is used to set the CDMA control channel 
parameters (Band, RF Channel, SID, RF Level, MCC, MNC, and 
NID) to explicit values (numbers) or values set in the carrier 
settings file.

Parameters Band,Chan,SID,Level,MCC,MNC,NID
Band = NULL: the band remains unchanged.
Band = PRIMARY: sets the band to the first band in the dual-
band test.
Band = SECONDARY: sets the band to the second band in the 
dual-band test.
Band = CELLULAR: sets the band to the US 800 MHz cellular 
band.
Band = PCS: sets the band to the US PCS 1900 MHz band.
Band = KOREAN: sets the band to the Korean PCS 1700 MHz 
band.
Band = NMT450: sets the band to the 450 MHz band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains unchanged.
Chan = CONTROL: sets the channel to the same value as the 
control channel.
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Chan = LOW, MID, HIGH: sets the channel to the value for one 
of the channels in the long test.
Chan = TRAFFIC: sets the channel to the value of the traffic 
channel for the short test.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected).
SID = NULL: the SID remains unchanged.
SID = SID: sets the SID to the preset value.
SID = number: sets the SID to the value specified (0 to 
32768).
Level = NULL: the RF level of the control channel.
Level = number: sets the RF level of the control channel to 
the value specified, in dBm (–120 to 0).
MCC  = NULL: the mobile country code remains unchanged.
MCC = number: sets the mobile country code to the value 
specified (0 to 999).
MCC = CONFIG: sets the mobile country code to the value set 
in the carrier settings file.
MNC  = NULL: the mobile network code remains unchanged.
MNC = number: sets the mobile network code to the value 
specified (0 to 99).
MNC = CONFIG: sets the mobile network code to the value 
set in the carrier settings file.
NID = NULL: the network ID remains unchanged.
NID = number: sets the network ID to the value specified  (0 
to 65535).
NID = CONFIG: sets the network ID to the value set in the 
carrier settings file.

Example CHANGE_CCCH,CELL,384,,-60,,, 
Sets the CDMA control channel to the cellular band channel 
384. The SID (left empty) used is from the carrier settings 
file. The RF level is set to –60 dBm. The MCC, MNC, and NID 
are not changed.

COUPLING_AUTO Description This command activates usage of the user database for 
CDMA and EVDO. Coupling factors according to the selected 
Group and Subgroup will be applied.

Parameters Mode
Mode – must be set to CDMA/EVDO.

Example COUPLING_MODE,CDMA/EVDO

ESN_MEID_NOT_ALL_0 Description This command checks the identity of the phone. If the ESN 
or MEID contains all Fs then the test fails. The command 
should be applied immediately after setting up a call. 

Parameters None.

Notes See also ESN_MEID_NOT_ALL_0, 
AREA_CODE_LESS_THAN_OR_EQUAL.

Example CDMA_CALL_BY_BS
ESN_MEID_NOT_ALL_F
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ESN_MEID_NOT_ALL_F Description This command checks the identity of the phone. If the ESN 
or MEID contains all zeros then the test fails. The command 
should be applied immediately after setting up a call. 

Parameters None.

Notes See also ESN_MEID_NOT_ALL_F, 
AREA_CODE_LESS_THAN_OR_EQUAL.

Example CDMA_CALL_BY_BS
ESN_MEID_NOT_ALL_0

MEASUREMENT_HEADERS Description This command places the following text line into a printout:
BS (dBm)  Ch.   LL    UL    Measured
This line indicates the instrument’s RF output level, channel, 
lower limit, upper limit, and measured value of subsequent 
tests.

Parameters None.

Example MEASUREMENT_HEADERS

MS_REG Description This forces the mobile phone to perform a registration. This 
will provide the instrument with the information necessary 
to page the mobile.

Parameters None.

Example MS_REG
Forces the mobile phone to register.

SET_AWGN Description This command is used to turn the additive white gaussian 
noise (AWGN) generator on or off and to set its level relative 
to the instrument’s RF output level.

Parameters Mode,Level
Mode = NULL: the AWGN state remains unchanged.
Mode = ON: turns the AWGN on.
Mode = OFF: turns the AWGN off.
Level = NULL: the AWGN level remains unchanged.
Level = number: sets the AWGN level to the value specified 
(–10.0 to +5.0 dB).

Example SET_AWGN,ON,0
The AWGN generator is turned on and the level is set to 0 dB 
relative to the instrument’s RF output level.

SET_CARR Description Used to preselect the carrier or carrier network(s) for 
testing. If the carrier networks are already preselected with 
this command, the user will not be offered a wider choice of 
networks as described in “Preselecting carriers” on page 76.

Parameters Carrier
Carrier – The name of a carrier network from the existing set 
of carriers on the instrument.
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Example SET_CARR,EXAMPLE_US800
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Test command reference – AMPS commands

AMPS_HOFF Description This command sets the parameters for an AMPS channel 
and initiates a handover from CDMA to AMPS.

Parameters Channel,MAC,SAT
Channel – SKIP or SAME: The AMPS traffic channel uses the 
same centre frequency as the previous traffic channel.
Channel – TRAFFIC: The AMPS traffic channel is set to the 
MID channel frequency in the previously active CDMA band. 
Channel – CONTROL: The AMPS traffic channel is set to the 
control channel defined in the carrier settings. 
Channel – LOW, MID, or HIGH: The AMPS traffic channel is set 
to the low, mid or high channel as defined in the respective 
Configuration > CDMA menu.
MAC – SKIP or SAME: Leaves the MAC field as is. 
MAC – (number from 0 to 7): Sets the MAC field accordingly. 
The MAC field determines the transmit power level of the 
mobile phone.
SAT – SKIP or SAME: Leaves the SAT frequency setting as is.
SAT = 0 or 5970: Sets the SAT frequency to 5970 hertz.
SAT = 1 or 6000: Sets the SAT frequency to 6000 hertz.
SAT = 2 or 6030: Sets the SAT frequency to 6030 hertz.

Example AMPS_HOFF,MID,2,6000

AMPS_STD_TX Description Starts standard transmitter measurements of the AMPS 
signal. The measurements include Frequency Error, RF 
Power, SAT Frequency Error, SAT Deviation. The results are 
averaged over a number of measurements.

Parameters Count,Printout
Count – Number of measurements to be carried out.
Printout – The tests that are to be printed in the print out. 
Open the AMPS_STD_TX command dialog box and click on 
Select to check the desired measurements:
RF frequency error
RF power
SAT frequency error
SAT deviation

Example AMPS_STD_TX,5,15
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Test command reference – EVDO commands

CDMA_MS_REG_2ND_TESTSET Description Forces a CDMA registration on the other testset in an EVDO 
Hybrid Mode test. The registration attempt times out and is 
considered as failed after the specified period.
Synchronization of the two test sets is achieved through 
the serial interface, which should be initialized using the 
INIT_CMD command (see page 101) before the registration 
command.

Parameters Timeout
Timeout = number (range 1 to 400): Use the timeout value 
specified in seconds.

Notes See also INIT_CMD, EVDO_SYNC.

Example INIT_CMD,1,19200,NONE,1000
EVDO_SYNC
CDMA_MS_REG_2ND_TESTSET,30

COUPLING_AUTO Description This command activates usage of the user database for 
CDMA and EVDO. Coupling factors according to the selected 
Group and Subgroup will be applied.

Parameters Mode
Mode – must be set to CDMA/EVDO.

Example COUPLING_MODE,CDMA/EVDO

EVDO_CHANGE_CCH Description This command sets the EVDO control channel parameters 
(band, RF channel, sector ID, RF level, subnet mask, mobile 
country code, color code, and protocol revision) to explicit 
values (numbers). 

Parameters Band, Chan, Sector_ID, Level, SubNetMask, MCC, Color_Code, 
Protocol, DRate
Band = NULL: the band remains as is.
Band = PRIMARY: sets the band to the first band in the Dual 
Band test in the carrier settings file.
Band = SECONDARY: sets the band to the second band in the 
Dual Band test in the carrier settings file. 
Band = US800: sets the band to the US-800 (cellular) band.
Band = USPCS: sest the band to the US PCS (1900 MHz) 
band.
Band = KPCS: sets the band to the Korean PCS (1700 MHz) 
band.
Band = NMT450: sets the band to the NMT-450 band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains as is.
Chan = CONTROL: sets the channel to the same value as the 
control channel in the carrier settings file.
Chan = LOW or MID or HIGH: sets the channel to the value set 
in the mobile settings file for one of the channels in the long 
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test.
Chan = TRAFFIC: sets the channel to the value set in the 
settings file for the short test traffic channel.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected).
Sector_ID = NULL: the Sector ID remains unchanged.
Sector_ID = SECTOR_ID or CONFIG: uses the sector ID from 
the settings file.
Sector_ID = hex number: sets the sector ID to the hexa-
decimal value specified (1 to 32 characters).
Level = NULL: the RF level of the control channel remains 
unchanged.
Level = number: sets the RF level of the control channel to 
the value specified, in dBm (valid range: –120 to 0).
SubNetMask = NULL: the subnet mask remains unchanged.
SubNetMask = SUBNET_MASK or CONFIG: uses the subnet 
mask from the settings file.
SubNetMask = number: sets the subnet mask of the control 
channel to the value specified (valid range: 0 to 128).
MCC = NULL: the mobile country code remains unchanged.
MCC = MCC or CONFIG: uses the mobile country code from 
the settings file.
MCC = number: sets the mobile country code to the value 
specified (valid range: 0 to 999).
Color_Code = NULL: the color code remains unchanged.
Color_Code = COLOR_CODE or CONFIG: uses the color code 
from the settings file.
Color_Code = number: sets the color code to the value spec-
ified (range: 0 to 255).
Protocol = NULL: the protocol revision setting is not 
changed.
Protocol = PROTOCOL_REV or CONFIG: uses the protocol revi-
sion from the settings file.
Protocol = REV0: sets the protocol revision to Revision 0.
Protocol = REVA: sets the protocol revision to Revision A.
DRate = NULL: the FTAP data rate remains unchanged.
DRate = CONFIG: sets the FTAP data rate to the value speci-
fied in the mobile settings file.
DRate = number: 0 < number < 50: QPSK 38.4 kbps
50 < number < 100: QPSK 76.8 kbps
100 < number < 200: QPSK 153.6 kbps
200 < number < 500: QPSK 307.2 kbps
500 < number < 700: QPSK 614.4 kbps
700 < number < 1000: EPSK 921.6 kbps
1000 < number < 1500: QPSK 1228.8 kbps
1500 < number < 2000: EPSK 1843.2 kbps
2000 < number < 2700: QAM 2457.6 kbps
2700 < number < 3300: QAM 3072 kbps

Example EVDO_CHANGE_CCH,US800,384,CONFIG,-
60,NULL,NULL,NULL, NULL 
Sets the EVDO control channel to the US-800 band channel 
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384, and the RF Level to –60 dBm.  The sector ID (CONFIG) 
used is from the settings file. Mobile country code, color 
code and protocol revision are not changed.

EVDO_CLOSE_CONNECT Description This command is used close an EVDO connection. If the EVDO 
connection does not close within the timeout limit specified, 
the EVDO Close Connection fails.

Parameters [Timeout]
Timeout = NULL or CONFIG: the default timeout value of 30 
seconds is used.
Timeout = number (range 0 to 100): Use the timeout value 
specified in seconds.

Example EVDO_CLOSE_CONNECT,DEF
Closes an EVDO connection using the default timeout value 
of 30 seconds.

EVDO_CLOSE_SESSION Description This command is used close an EVDO session. If the EVDO 
session does not close within the timeout limit specified, the 
EVDO Close Session fails.

Parameters [Timeout]
Timeout = NULL or CONFIG: the default timeout value of 30 
seconds is used.
Timeout = number (range 0 to 100): Use the timeout value 
specified in seconds.

Example EVDO_CLOSE_SESSION,DEF
Closes an EVDO session using the default timeout value of 
30 seconds.

EVDO_CONNECT Description This command opens a connection with the mobile and acti-
vates the forward and reverse traffic channels. The test 
application protocol is set to RTAP or FTAP as specified. If the 
connection does not open within the timeout specified the 
EVDO Connect fails.

Parameters [Timeout[,TAP]]
Timeout = NULL or CONFIG: the default timeout value of 
30 seconds is used.
Timeout = number (range 0 to 100): the timeout value 
specified in seconds is used.
TAP = NULL: the Test Application Protocol RTAP remains 
unchanged.
TAP = FTAP or RX: sets the test application protocol to FTAP.
TAP = RTAP or TX: sets the test application protocol to RTAP.

Example EVDO_CONNECT,DEF,RTAP
Opens an EVDO connection using the default timeout value 
of 30 seconds and RTAP test application protocol.
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EVDO_FTAP_PARAMS Description This command is used to set  EVDO TAP parameters FTAP 
data rate, ACK channel fixed bit mode, the percentage of 
packets to address to the mobile, and limited TAP to explicit 
values (numbers) or values set in the mobile settings file.

Parameters DRate,AckBitFixMode,Packet_Percent,LimitedTAP
DRate = NULL: the FTAP data rate remains unchanged.
DRate = CONFIG: sets the FTAP data rate to the value speci-
fied in the mobile settings file.
DRate = number: 0 < number < 50: QPSK 38.4 kbps
50 < number < 100: QPSK 76.8 kbps
100 < number < 200: QPSK 153.6 kbps
200 < number < 500: QPSK 307.2 kbps
500 < number < 700: QPSK 614.4 kbps
700 < number < 1000: EPSK 921.6 kbps
1000 < number < 1500: QPSK 1228.8 kbps
1500 < number < 2000: EPSK 1843.2 kbps
2000 < number < 2700: QAM 2457.6 kbps
2700 < number < 3300: QAM 3072 kbps
AckBitFixMode = NULL: the ACK channel fixed bit mode 
remains unchanged.
AckBitFixMode = 1 or ON: sets the ACK channel fixed bit 
mode ON.
AckBitFixMode = 0 or OFF: sets the ACK channel fixed bit 
mode OFF.
Packet_Percent = NULL: the percentage of packets to 
address to the mobile remains unchanged.
Packet_Percent = number (range 0 to 100): changes the 
percentage of packets to address the mobile to the value 
specified.
LimitedTAP = NULL: the Limited TAP parameter remains 
unchanged.
LimitedTAP = 1 or ON: sets the Limited TAP ON.
LimitedTAP = 0 or OFF: sets the Limited TAP OFF.

Example EVDO_FTAP_PARAMS,,,50,OFF
Set´s the percentage of packets to address to the mobile to 
50%, and the Limited TAP OFF. Does not change the FTAP 
data rate or Ack channel bit fixed mode.

EVDO_HOFF Description This command performs an EVDO handoff to the band and 
channel specified.

Parameters Band,Channel
Band = NULL: the band remains as is.
Band = PRIMARY: sets the band to the first band in the Dual 
Band test in the carrier settings file.
Band = SECONDARY: sets the band to the second band in the 
dualband test in the carrier settings file. 
Band = US800: sets the band to the US-800 (cellular) band.
Band = USPCS: sest the band to the US PCS (1900 MHz) 
band.
Band = KPCS: sets the band to the Korean PCS (1700 MHz) 
band.
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Band = NMT450: sets the band to the NMT-450 band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains as is.
Chan = CONTROL: sets the channel to the same value as the 
control channel in the carrier settings file.
Chan = LOW or MID or HIGH: sets the channel to the value set 
in the mobile settings file for one of the channels in the long 
test.
Chan = TRAFFIC: sets the channel to the value set in the 
mobile settings file for the short test traffic channel.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected).

Example EVDO_HOFF,SEC,TRAFFIC
Handoff to the fast test traffic channel on the second band 
in a dualband test.

EVDO_LEVEL Description This command is used to set the EVDO BS Level to explicit 
values (numbers) or values set in the mobile settings file.

Parameters Level
Level = NULL: the EVDO BS Level remains unchanged.
Level = MINIMUM or MIN: changes the EVDO BS Level to the 
Minimum BS Level specified in the mobile settings file.
Level = number: sets the EVDO BS Level to the value speci-
fied (range from –120 to 0 dBm).

Example EVDO_LEVEL,-85
Sets the EVDO BS Level to –85 dBm.

EVDO_MEASUREMENT_HEADE
RS

Description This command is only performed if an EVDO test is active. It 
is skipped if a CDMA test is active. This line indicates the 
4400 RF Out level, channel, lower limit, upper limit, and 
measured value of subsequent tests on the print-out (if 
printing is requested).

Parameters None.

Example EVDO_MEASUREMENT_HEADERS

EVDO_MOBILE_ID Description This command queries and prints the desired information 
about the mobile phone. An EVDO session must be open 
before this command can be performed. The mobile power 
class information specified in the mobile settings file is 
always printed. If no printout value is specified the hexadec-
imal and decimal hardware values are printed.

Parameters [Print_Val]
Print_Val = CONFIG: sets the print out value to 3 (this is the 
default value assumed when the parameter is omitted).
Print_Val = ALL: sets the print out value to 63.
Print_Val = number: The Mobile ID parameters that are to 
be printed in the print out. This number is the sum of the 
following numbers. Only add up the numbers of the Mobile 
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ID parameters desired in the printout:
1: the 32-bit hardware value for the AT as a hexadecimal 
value.
2: the 32-bit hardware value for the AT as a decimal value.
4: the 24-bit hardware ID type for the AT.
8: the 32-bit session seed value for the AT as a hexadecimal 
value.
16: the UATI color code associated with the subnet to which 
the UATI belongs.
32: the lower 24 bits of the UATI assigned by the AN.

Example EVDO_MOBILE_ID,DEF
Prints the hexadecimal and decimal hardware values and 
mobile power classes.

EVDO_NETWORK Description Enables the 1xEV-DO mode of the instrument.

Parameters None.

Example EVDO_NETWORK

EVDO_OPEN_SESSION Description This command is used to open an EVDO session. If the EVDO 
session does not open within the timeout limit specified, the 
EVDO Open Session fails.

Parameters [Timeout]
Timeout = NULL or CONFIG: the default timeout value of 30 
seconds is used.
Timeout = number (valid range 0 to 100): uses the timeout 
value specified in seconds.

Example EVDO_OPEN_SESSION,DEF
Opens an EVDO session using the default timeout value of 
30 seconds.

EVDO_PER Description This command performs the packet error rate (PER) test. 
This test currently forces FTAP.
If PowType is set to any legal value other than NO_TX a TX 
quality and RF power measurement is also performed. All of 
the parameters for this command apply to this TX quality 
and RF power measurement. There is no averaging of PER 
measurements. The PER test is performed at the BS level 
specified. If the BS level specified is greater than –50 dBm 
the power control is temporarily set to All Up. The pre-test 
BS level and power control type are reset at the end of the 
test. A power control reset is also performed if specified.

Parameters Count,BSLevel,PowType,PowerControlReset,PrintOut
Count = NULL: Count is set to 1.
Count = number (range 1 to 100)
BSLevel = NULL: the EVDO BS level remains unchanged.
BSLevel = MINIMUM or MIN: change the EVDO BS level to the 
Minimum BS level specified in the mobile settings file.
BSLevel = number: sets the EVDO BS level to the value spec-
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ified, in dBm (range –120 to 0).
PowType = NO_TX: an EVDO TX quality test is not performed 
during the PER measurement.
PowType = MAX: an EVDO maximum RF power test is 
performed during the PER measurement.
PowType = MIN: an EVDO minimum RF power test is 
performed during the PER measurement.
PowType = AVG or AVERAGE: an EVDO average (open loop 
estimate) RF power test is performed during the PER 
measurement.
PowerControlReset = NULL or FALSE: a power control reset is 
not performed at the end of the test.
PowerControlReset = TRUE: a power control reset is 
performed at the end of the test.
PrintOut = CONFIG: sets the Print Out value to 1031.
PrintOut = number: Open the EVDO_PER command dialog 
box, select Manual and click on the Select button to check 
the measurements desired in the results: 
Waveform quality (rho)
Frequency error
Time error 
Carrier feedthrough
IQ imbalance
Peak phase error
RMS phase error
RMS vector error
Peak magnitude error
RMS magnitude error
RF power

Example EVDO_PER,,MIN,NO_TX,TRUE,DEF
Performs a PER test only (no TX quality is performed) at the 
minimum BS level.

EVDO_PER_SETUP Description This command is used to set Packet Error Rate Test param-
eters Maximum Frames, Confidence Level and Pass/Fail 
Limit Level, to explicit values (numbers) or values set in the 
limits file.

Parameters MaxFram,ConfLev,LimLev,EnabOnOff
MaxFram = NULL: the Packet Error Rate Maximum Frames 
remains unchanged.
MaxFram = CONFIG: sets the Packet Error Rate Maximum 
Frames to the value specified in the limits file.
MaxFram = number (range 10 to 10000)
ConfLev = NULL: the Packet Error Rate Confidence Level 
remains unchanged.
ConfLev = CONFIG: sets the Packet Error Rate Confidence 
Level to the value specified in the limits file.
ConfLev = number (valid range: 90 to 1000)
LimLev = NULL: the Packet Error Rate Pass / Fail Limit Level 
remains unchanged.
LimLev = CONFIG: sets the Packet Error Rate Rate Pass / Fail 
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Limit Level to the value specified in the limits file.
LimLev = number (valid range: 0 to 5)
EnabOnOff: Unused.

Example EVDO_PER_SETUP,DEF,DEF,DEF,ON
Sets all Packet Error Rate test parameters to the values 
specified in the limits file.

EVDO_POWER_CONTROL Description This command is used to set the closed loop power control 
mode of the 4400. The 4400 can send all Power Up bits, all 
Power Down bits, or a specific number of Power Up or Power 
Down bits to the mobile. It can send alternating Power Up 
and Power Down bits to the mobile. It can also send the 
appropriate number of Power Up or Power Down bits to 
actively set the Mobile output power to the correct level as 
determined by the open loop estimate formula (Active).
The Optional second parameter (Reset) can be used in the 
Alternating or Active power control mode to reset the 
mobile output power to the value determined by the open 
loop estimate formula. This is a single shot operation. Once 
the reset is complete the 4400 returns to the Alternating or 
Active power control mode.

Parameters PowCtrlCmd[,ResetOption]
PowCtrlCmd = UP: all Up power control bits
PowCtrlCmd = DOWN: all Down power control bits
PowCtrlCmd = ALT: alternating power control bits
PowCtrlCmd = ACT: active power control
number (range –100 to +100 but not 0): a specific number 
of Down or Up power control bits
ResetOption = RESET: causes a Power Control Reset proce-
dure to be performed on the mobile.

Notes The ResetOption parameter is optional.

Example EVDO_POWER_CTRL,ALT,RESET
The 4400 is set to the Alternating power control mode, and 
the mobile is sent the appropriate number of power Up or 
power Down bits necessary to correct its power output as 
determined by the open loop estimate formula. Once the 
reset is complete, the 4400 remains in the Alternating 
mode.

EVDO_SHUTDOWN Description Switches the simulated 1xEV-DO network completely off.

Parameters None.

Notes See also EVDO_NETWORK.

Example EVDO_SHUTDOWN
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EVDO_SYNC Description This command initiates a time-of-day synchronization of 
the two test sets in an EVDO Hybrid Mode test setup. 
Synchronization is achieved through the serial interface, 
which should be initialized using the INIT_CMD command 
(see page 101) before synchronization.

Parameters None.

Notes See also INIT_CMD, CDMA_MS_REG_2ND_TESTSET

Example INIT_CMD,1,19200,NONE,1000
EVDO_SYNC

EVDO_TRAF Description This command is used to set EVDO traffic channel, TAP data 
rate and mobile power class to explicit values (numbers) or 
values set in the mobile settings file.

Parameters Band,Chan,Ftap_Data_Rate,Rtap_Data_Rate,Power_Class
Band = NULL: the band remains as is.
Band = PRIMARY: sets the band to the first band in the Dual 
Band test in the carrier settings file.
Band = SECONDARY: sets the band to the second band in the 
Dual Band test in the carrier settings file. 
Band = US800: sets the band to the US-800 (cellular) band.
Band = USPCS: sest the band to the US PCS (1900 MHz) 
band.
Band = KPCS: sets the band to the Korean PCS (1700 MHz) 
band.
Band = NMT450: sets the band to the NMT-450 band.
Band = AWS: sets the band to the AWS band.
Chan = NULL: the channel remains as is.
Chan = CONTROL: sets the channel to the same value as the 
control channel in the carrier settings file.
Chan = LOW or MID or HIGH: sets the channel to the value set 
in the settings file for one of the channels in the long test.
Chan = TRAFFIC: sets the channel to the value set in the 
settings file for the short test traffic channel.
Chan = number: sets the channel to this number (must be 
a valid channel number for the band selected).
Ftap_Data_Rate = NULL: the FTAP data rate remains 
unchanged.
Ftap_Data_Rate = CONFIG: sets the FTAP data rate to the 
value specified in the settings file.
Ftap_Data_Rate = number: 0 < number < 50: QPSK 38.4 
kbps
50 < number < 100: QPSK 76.8 kbps
100 < number < 200: QPSK 153.6 kbps
200 < number < 500: QPSK 307.2 kbps
500 < number < 700: QPSK 614.4 kbps
700 < number < 1000: EPSK 921.6 kbps
1000 < number < 1500: QPSK 1228.8 kbps
1500 < number < 2000: EPSK 1843.2 kbps
2000 < number < 2700: QAM 2457.6 kbps
2700 < number < 3300: QAM 3072 kbps
Rap_Data_Rate = NULL: the RTAP data rate remains 
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unchanged.
Rap_Data_Rate = CONFIG: sets the RTAP data rate to the 
value specified in the settings file.
Rap_Data_Rate = number: 0 < number < 15: BSK 9.6 kbps
15 < number < 30: BSK 19.2 kbps
30 < number < 60: BSK 38.4 kbps
60 < number < 100: BSK 76.8 kbps
100 < number < 200: BPSK 153.6 kbps
200 < number < 300: QPSK 230 kbps
300 < number < 400: QPSK 307 kbps
400 < number < 500: QPSK 460 kbps
500 < number < 800: QPSK 614 kbps
800 < number < 1000: QPSK 921 kbps
1000 < number < 1500: QPSK 1228 kbps
1500 < number < 2000: EPSK 1843 kbps
Power_Class = NULL: the mobile power class remains 
unchanged.
Power_Class = POWER_CLASS or CONFIG: sets the mobile 
power class to the value specified in the mobile settings file.
Power_Class = number: sets the mobile power class to the 
value specified. The valid range is 1 to 5.

Example EVDO_TRAF,PRIMARY,TRAFFIC,CONFIG,CONFIG,CONFIG
Sets the traffic band to the first band in a dual band test, 
and the channel, TAP data rates and mobile power class to 
the values specified in the mobile settings file.

EVDO_TX_WQU Description This command performs TX quality and RF power measure-
ments. This test currently checks the test application 
protocol and changes it to RTAP if it is currently set to FTAP. 
The tests are performed at the BS level specified. The Count 
value allows averaging to be performed. reported are 
always the average of the measurements. When max power 
is specified, all power Up control bits are sent to the mobile. 
When min power is specified all power Down bits are sent. 
All of the tests shown are always performed, but only the 
tests specified in the Printout parameter are reported. The 
power control type and BS level are reset to the pre-test 
values after the test is performed. If specified a power 
control reset is performed at the end of the test.

Parameters Count,BSLevel,PowType,PowerControlReset,PrintOut
Count = NULL: Count is set to 1
Count = number (range 1 to 100)
BSLevel = NULL: the EVDO BS level remains unchanged.
BSLevel = MINIMUM or MIN: changes the EVDO BS level to 
the minimum BS level specified in the settings file.
BSLevel = number: sets the EVDO BS level to the value spec-
ified, in dBm (valid range from –120 to 0).
PowType = MAX: performs an EVDO Maximum RF Power 
test.
PowType = MIN: performs an EVDO Minimum RF Power test.
PowType = AVG or AVERAGE: performs an EVDO Average 
(Open Loop Estimate) RF Power test.
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PowerControlReset = NULL or FALSE: does not perform a 
Power Control Reset at the end of the test.
PowerControlReset = TRUE: performs a Power Control Reset 
at the end of the test.
PrintOut = CONFIG: prints RF power and Carrier feedthrough 
in the results.
PrintOut = number: Selec the tests to be printed in the print 
out. 
Waveform quality (rho)
Frequency error
Time error
Carrier feedthrough 
IQ imbalance
Peak phase error
RMS phase error
RMS vector error
Peak magnitude error
RMS magnitude error 
RF power

Example EVDO_TX_WQU,10,MIN,MAX,TRUE,DEF
Performs max power and waveform quality test at the 
minimum RF level using a count of 10. Perform a power 
control reset at the end of the test. Use the default printout 
(1031 = 1024 + 4 + 2 + 1). This will print rho, frequency 
error, time error and RF power.

EVDO_USE_STATUS_WAIT Description When EVDO_Stat_Wait is set to 0 the Event registers of the 
instrument are not used.  When EVDO_Stat_Wait is set to 1 
the Event registers are used during TX Quality and PER 
measurements. 
Initializes the algorithm to wait for transmitter and PER 
measurement results to become available. 

Parameters EVDO_Stat_Wait
EVDO_Stat_Wait = 0: The 4400 Event Status registers are 
not used to determine when EVDO measurement events 
occur. This is the recommended method.
EVDO_Stat_Wait = 1: The 4400 Event Status registers are 
used during EVDO tests to determine when measurements 
occur. 

Example EVDO_USE_STATUS_WAIT,0

HARDWARE_ID_NOT_ALL_0 Description This command checks the hardware ID of the phone. If the 
ID contains all zeros then the test fails. The command 
should be applied immediately after the EVDO_MOB_ID 
command.

Parameters None.

Notes See also HARDWARE_ID_NOT_ALL_F

Example EVDO_MOB_ID
HARDWARE_ID_NOT_ALL_0
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HARDWARE_ID_NOT_ALL_F Description This command checks the hardware ID of the phone. If the 
ID contains all Fs then the test fails. The command should be 
applied immediately after the EVDO_MOB_ID command.

Parameters None.

Notes See also HARDWARE_ID_NOT_ALL_0

Example EVDO_MOB_ID
HARDWARE_ID_NOT_ALL_F

SET_CARR Description Used to preselect the carrier or carrier network(s) for 
testing. If the carrier networks are already preselected with 
this command, the user will not be offered a wider choice of 
networks as described in “Preselecting carriers” on page 76.

Parameters Carrier
Carrier – The name of a carrier network from the existing set 
of carriers on the instrument.

Example SET_CARR,EXAMPLE_US800
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Test command reference – TETRA commands

COUPLING_AUTO Description This command activates usage of the user database for 
TETRA. Coupling factors according to the selected Group and 
Subgroup will be applied.

Parameters Mode
Mode – must be set to TETRA.

Example COUPLING_MODE,TETRA

SET_TETRA_SYSTEM Description Loads the TETRA channel setup (defined in the model 
editor) for subsequent tests. If the channel setup name is 
given as a parameter, this setup will be used immediately. If 
the parameter is set to VAR and there is more than one 
TETRA channel setup, a pop-up menu will ask which one to 
use.

Parameters ChannelSetup
ChannelSetup – enter VAR if to be hand-picked by the user, 
otherwise the setup name should be entered.

Example TETRA_TYPE,TMO
SET_TETRA_SYSTEM,SETUP-3
TETRA_CONFIG_CH,-80.0,2,LOW

TETRA_BER Description Starts a BER measurement when the TETRA radio is on a 
traffic channel with the BER loop closed. This command can 
be run in parallel with other measurements 
(TETRA_TX_ALL). 

Parameters Frames,Count,BS-Level,Measurements
Frames – number of frames over which one measurement is 
performed.
Count – number of BER measurements to be performed.
BS-Level – power level during the measurement.
Measurements – types of measurements to be performed 
(BER Class 0, BER Class 1, BER Class 2 and/or MER).

Notes See also TETRA_TX_ALL command.

Example TETRA_TYPE,TTM
SET_TETRA_SYSTEM,SETUP-3
TETRA_CALL_BY_BS,INDIVIDUAL_DUPLEX
TETRA_TX_ALL,10,21
TETRA_BER,10,1,-112,0
TETRA_TERM_BY_BS

TETRA_CALL_BY_BS Description Initiates a mobile-terminated call. If the TETRA radio does 
not respond within 90 seconds, a timeout occurs and the 
test is stopped.
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Parameters CallType
CalllType – INDIVIDUAL_DUPLEX (the only supported call 
type).

Example TETRA_TYPE,TMO
SET_TETRA_SYSTEM,SETUP-3
TETRA_CALL_BY_BS,INDIVIDUAL_DUPLEX

TETRA_CALL_BY_MS Description Prepares the tester for a mobile-initiated call. If the TETRA 
radio does not call within 90 seconds, a timeout occurs and 
the test is stopped.

Parameters PhoneNumber
PhoneNumber – expected dialed number.

Example TETRA_TYPE,TMO
SET_TETRA_SYSTEM,SETUP-3
TETRA_CALL_BY_MS,1234567890

TETRA_CONFIG_BS_LEVEL Description Sets the power level of the (simulated) base station.

Parameters BS-Level
BS-Level – new output power level of the instrument, in 
dBm, in the range from –122.0 to –40.0 dBm.

Notes See also TETRA_CONFIG_CH

Example TETRA_CONFIG_BS_LEVEL,-80

TETRA_CONFIG_CH Description Sets the base station power level, the traffic channel time 
slot and traffic channel for the call.

Parameters BS-Level,Timeslot,Channel
BS-Level – new output power level of the instrument, in 
dBm, in the range from –122.0 to –40.0 dBm.
Timeslot – Time slot to be used, in the range from 2 to 4.
Channel – LOW or MID or HIGH for a predefined channel, or 
channel number to be used.

Notes See also TETRA_CONFIG_BS_LEVEL command.

Example TETRA_CONFIG_CH,-80.0,2,LOW

TETRA_PAGING_SENSITIVITY Description Starts a test to determine the paging sensitivity of the 
TETRA radio. In each test step, the BS power level is 
decreased until a defined sensitivity level (BER level) has 
been reached. 

Parameters StartLevel,Step,StopLevel
StartLevel – the BS power level at which the test starts, in 
dBm.
StopLevel – power level at which the test stops.
Step – step size of the power decrease, in dB.
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Example TETRA_TYPE,TMO
SET_TETRA_SYSTEM,SETUP-3
TETRA_CALL_BY_BS,INDIVIDUAL_DUPLEX
TETRA_PAGING_SENSITIVITY,-106.0,-120.0,1.0

TETRA_TERM_BY_BS Description Initiates a call release by the base station (i.e. the instru-
ment).

Parameters None.

Notes See also TETRA_TERM_BY_MS, TETRA_CALL_BY_BS

Example TETRA_CALL_BY_MS,1234567890
TETRA_TX_ALL
TETRA_TERM_BY_BS

TETRA_TERM_BY_MS Description Prompts the user to release the call on the TETRA radio.

Parameters None.

Notes See also TETRA_TERM_BY_BS, TETRA_CALL_BY_MS

Example TETRA_CALL_BY_BS,INDIVIDUAL_DUPLEX
TETRA_TX_ALL
TETRA_TERM_BY_MS

TETRA_TX_ALL Description All TX-related measurements are carried out; these are TX 
power, template check, frequency error, RMS and peak 
vector error, frame alignment and residual carrier power. 

Parameters Average, Output
Average – Number of measurements to be carried out and 
averaged.
Output – This field indicates which parameters shall be 
presented in the Result section on the Running menu and in 
the test protocol. Double-click on the command in the test 
script section of the Test Script Editor menu, and check the 
test parameters you want to see in the results section. 
Parameters that can be affected are:

– TX power
– Template check (PTT)
– Frequency error
– RMS phase error
– Peak phase error
– Timing advance (frame alignment)
– Residual carrier power

Example TX_ALL,10,21

TETRA_TYPE Description Initializes the instrument for either Trunked Mode Opera-
tion (TMO) or TETRA Test Mode (TTM). If the test mode is 
selected, the type of BER loop should be given in addition.
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Parameters Mode,BER-Type
Mode – TMO or TTM.
BER-Type – RESIDUAL or NONRESIDUAL.

Notes TETRA_BER, SET_TETRA_SYSTEM

Example TETRA_TYPE,TMO
SET_TETRA_SYSTEM,SETUP-3
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Chapter 8 Defining Test Limits

This chapter describes how the test limits can be changed in 7315 Scriptor. 
Topics discussed in this chapter are as follows:

– “Introduction” on page 170

– “Changing the limits for GSM transmitter tests” on page 171

– “Changing the limits for GSM receiver tests” on page 174

– “Changing the spectrum test limits for GPRS” on page 176

– “Changing the audio measurement limits” on page 177

– “Changing the test limits for EDGE” on page 178

– “Changing the test limits for WCDMA” on page 179

– “Changing the test limits for HSDPA” on page 182

– “Changing the test limits for CDMA” on page 185

– “Changing the test limits for EVDO” on page 188

– “Changing the test limits for AMPS” on page 191

– “Changing the test limits for TETRA” on page 193
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Introduction

This chapter explains how test limits can be set up from the Limit Editor tab. 
Once a limits file is loaded, the various test parameters are basically 
grouped by the different access technologies. The test limits can be stored 
in a file from the Limit Editor. They can be loaded and used for a test from 
within the test script.

The sections below explain the test parameters in more detail. In order to 
change a parameter, proceed as follows:

1 In order to change an upper or lower limit, click the Limit Editor tab. 
The menu displays tabs for the access technologies supported by Lector 
and Scriptor. The values shown are taken from the default file, limit.lim.

2 If you want to change the values from another limits file, select a 
different file in the Filename field. 

3 Select the wireless access technology by clicking on the appropriate tab.
The appropriate list of test parameters as supported by Lector and 
Scriptor is displayed.

4 Click on the Min or Max value for the test parameter you want to 
change. 
The values becomes editable. The Min value characterises the lower 
limit and the Max value characterises the upper limit. 

5 Edit the value and confirm the change with RETURN.
The new value is displayed as part of the test parameter table.

6 Click Save to store the changes.
A “Save file as...” box appears.

7 Enter a file name (or select an existing one to overwrite the file) and 
click OK.
The current limit settings are stored in that file.

Reloading default limit values

If you made changes to your limit values and you would like to return to the 
default values, just click on the All Limits back to default button.
All limit parameters in the onscreen list are replaced by their factory 
defaults. Click on Save to store them in a file.
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Changing the limits for GSM transmitter tests

Use the GSM-TX tab menu to alter the upper and lower limits for the 
following GSM parameters.

Phase Error RMS The RMS (root-mean square) value of the phase error is a measure for the 
modulation quality, expressing the mean difference between the modu-
lated signal and the perfect signal (in degrees, rms-valued).

Phase Error Peak The peak phase error is a measure for the modulation quality, and is the 
maximum phase error detected within a burst (in degrees).

Frequency Error The frequency error expresses the mobile’s carrier offset to the expected 
frequency, in Hz.

The limits may vary between different frequency bands. Lector and Scriptor 
can differentiate between three frequency bands: GSM 850 and 900, 
GSM 1800, and GSM 1900.

Power Level In GSM, the power level is controlled by the base station (or the test instru-
ment) by way of the power control. 

In the GSM 850 and GSM 900 frequency bands, the power control levels 5 
to 19 are used, and can be translated into nominal output power levels (in 
dBm) according to Table 10. In the GSM 1800 and GSM 1900 bands, the 
power control levels 0 to 15 apply according to Table 11. Both tables also 
list the tolerances according to the GSM specifications.

You may want to apply wider tolerances if the coupling loss is not known 
exactly.

Table 10 GSM 850 and GSM 900 power control levels

Power control 
level

Nominal 
output power 
(dBm)

Tolerance (dB)

5 33 ±3

6 31 ±3

7 29 ±3

8 27 ±3

9 25 ±3

10 23 ±3

11 21 ±3

12 19 ±3
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Power Time Template While the mobile has to ramp up or down its RF power level within some 
30 microseconds, the RF power level should be constant during the burst. 
The PTT (= power/time template) defines the power level the mobile should 
transmit with for any time position during and some 50 microseconds 
before and after the burst.

13 17 ±3

14 15 ±3

15 13 ±3

16 11 ±5

17 9 ±5

18 7 ±5

19 5 ±5

Table 11 GSM 1800 and GSM 1900 power control levels

Power control 
level

Nominal 
output power 
(dBm)

Tolerance (dB)

0 30 ±3

1 28 ±3

2 26 ±3

3 24 ±3

4 22 ±3

5 20 ±3

6 18 ±3

7 16 ±3

8 14 ±3

9 12 ±4

10 10 ±4

11 8 ±4

12 6 ±4

13 4 ±4

14 2 ±5

15 0 ±5

Table 10 GSM 850 and GSM 900 power control levels (Continued)

Power control 
level

Nominal 
output power 
(dBm)

Tolerance (dB)
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Different templates exist for the various power control levels. The test 
system knows the applicable limits and compares the power vs. time curve 
against these limits.

If you want the result of the power/time template check to be included in 
the overall assessment of the mobile’s performance, enter 0 in both the Min 
and Max parameter fields.
If you do not want to include the power/time template result in the perfor-
mance assessment, enter 0 in the Min and 1 in the Max parameter field.

Timing Advance This limit parameter refers to the timing error (in microseconds or µs) of the 
bursts transmitted by the mobile phone, taking the commanded timing 
advance into account. These limits are used in all the transmitter measure-
ments except for the MES_TADV measurement (see also Timing Advance 
Bits below).

Timing Advance Bits This parameter is the same as the above Timing Advance, but the limit can 
be stated in bit periods. They can be stated as a fraction of bits, e.g. 0.75.

The software uses the limits of Timing Advance Bits (in bit periods) in the 
“MES_TADV” command. 
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Changing the limits for GSM receiver tests

Use the GSM-RX tab menu to alter the upper and lower limits for the 
following GSM and GPRS parameters.

Frame Erasure Rate The frame erasure rate is a measure of the receiver quality, and is defined 
as the ratio of the frames rejected by the mobile in relation to all frames 
transmitted to it.
A frame is marked as ‘erased’ and rejected by the mobile when its error 
detector finds an error. To do so, the mobile will use the checksum provided 
with the class Ia bits. The frame erasure rate is expressed as a percentage.

The frame erasure rate may be carried out at different receive levels, so 
Lector and Scriptor offer two limit parameters, one for low receive levels 
(Frame Erasure Rate) and one for higher levels (Frame Erasure Rate(>-
80dBm)).

Bit Error Rate Class 1b The bit error ratio is defined as the ratio of falsely decoded bits in relation 
to all bits transmitted for a speech frame. It is calculated for the three 
different bit classes separately: class Ia, class Ib, and class II. 

This limit parameter determines the upper (and lower) limit for the bit error 
rate on class Ib bits.

The bit error rate may be carried out at different receive levels, so Lector 
and Scriptor offer two limit parameters, one for low receive levels (Bit Error 
Rate Class 1b) and one for higher levels (Bit Error Rate Class 1b(>-80dBm)).

Bit Error Rate Class 2 The bit error ratio is defined as the ratio of falsely decoded bits in relation 
to all bits transmitted for a speech frame. It is calculated for the three 
different bit classes separately: class Ia, class Ib, and class II. 

This limit parameter determines the upper (and lower) limit for the bit error 
rate on class II bits.

The bit error rate may be carried out at different receive levels, so Lector 
and Scriptor offer two limit parameters, one for low receive levels (Bit Error 
Rate Class 2) and one for higher levels (Bit Error Rate Class 2(>-80dBm)).

Block Error Rate USF The USF-based block error rate measurement is a receiver test in GPRS oper-
ation mode. Based on the Uplink State Flag (USF), it can be compared with 
a paging test. The measurement result is defined as a percentage.

RX Level The mobile under test estimates the RF power level at which it receives the 
base station (i.e. the test instrument). The RX Level measurement in the 
phone depends on the level transmitted by the tester, so there are limit 
parameters for power levels from –110 to –40 dBm. The limits used depend 
on the power level actually transmitted by the tester.
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RX Quality Based on the number of bits corrected by its own channel decoder, the 
mobile estimates the BER. The mobile phone reports its RX (receive) quality 
back to the network (or the tester) in its MS report as a number from 0 to 
7. The RX quality is coded as shown in Table 12.

Table 12 RX quality coding

RX Quality BER in %

0 < 0.2

1 0.2...0.4

2 0.4...0.8

3 0.8...1.6

4 1.6...3.2

5 3.2...6.4

6 6.4...12.8

7 > 12.8
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Changing the spectrum test limits for GPRS

The following measurement limits apply to measurements on GPRS chan-
nels only.

ACPM Modulation ACPM Modulation is the measurement of the adjacent channel power due 
to modulation. The measurement is performed during the active part of the 
burst, through a 30 kHz filter at offsets of ±100 kHz, ±250 kHz and all 
multiples of ±200 kHz from the carrier up to (and including) ±1800 kHz. 
The results are expressed in dBc.

The limits can be defined for each of the specified carrier offsets. The worst-
case result from both sides (offset below and above the carrier) is 
compared to the limits.

ACPM Transient The spectrum due to switching transients is measured through a 30 kHz 
filter at the carrier frequency and at offsets of ±400 kHz, ±600 kHz, 
±1200 kHz and ±1800 kHz from the carrier. Measurements are ungated, 
i.e. measurements include the edges and the midamble. The results are 
expressed in dBm. For each of these carrier offsets, upper and lower limits 
can be specified. As limits typically differ between the GSM 850 and 900 
bands on the one hand side, and GSM 1800 and 1900 on the other, separate 
limit parameters by band group are available. The worst-case result from 
both sides (offset below and above the carrier) is compared to the limits.
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Changing the audio measurement limits

Audio measurements can be performed on signals applied to the AFin 
connector of the instrument.

Audio Volume The audio volume at the AFin connector is RMS-valued and measured in mV.
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Changing the test limits for EDGE

If the appropriate option is enabled, the tester can take EDGE measure-
ments on EGPRS signals.

EDGE Error Vector Magnitude The key measurement for EDGE modulation is the error vector magnitude or 
EVM for short, which is the distance in the I/Q diagram between the 
measured signal and the ideal one, relative to the ideal signal vector magni-
tude; the EVM is measured separately for each symbol. Standard measure-
ment results to observe are the RMS-averaged EVM (for all the symbols of 
a burst) and the maximum (peak) EVM within the burst. The results are 
expressed as a percentage.

EDGE ACPM Transient The spectrum due to switching transients is measured through a 30 kHz 
filter at the carrier frequency and at offsets of ±400 kHz, ±600 kHz, 
±1200 kHz and ±1800 kHz from the carrier. Measurements are ungated, 
i.e. measurements include the edges and the midamble. The results are 
expressed in dBm. For each of these carrier offsets, upper and lower limits 
can be specified. As limits typically differ between the GSM 850 and 900 
bands on the one hand side, and GSM 1800 and 1900 on the other, separate 
limit parameters by band group are available.

EDGE ACPM Modulation ACPM Modulation is the measurement of the adjacent channel power due 
to modulation. The measurement is performed during the active part of the 
burst, through a 30 kHz filter at offsets of ±100 kHz, ±250 kHz and all 
multiples of ±200 kHz from the carrier up to (and including) ±1800 kHz. 
The results are expressed in dBc.

The limits can be defined for each of the specified carrier offsets.
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Changing the test limits for WCDMA

Spectrum Emission Mask In the spectrum emission mask (SEM) the signal spectrum outside the allo-
cated channel is measured. The spectrum curve is compared to a limit 
template and the result is a pass (0) or fail (1).

If you want to consider the result of the spectrum emission mask in your 
overall assessment of the phone, set both the upper and lower limit to zero. 
Otherwise, if you do not care about the spectrum emission mask, set the 
upper limit to 1.

Peak Code Domain Error The peak code domain error is a measure of the modulation error. It is the 
maximum relative power on a code channel that is not in use by the phone 
under test. The peak code domain error is measured in dB.

Open Loop Power Control
(OLPC)

The open loop power control measurement tests the ability of the mobile 
phone to set its transmit power to a specific level, depending on the 
received signal strength (i.e. the output power level of the instrument). The 
power level error (compared to the expected power) is measured in dB.

Inner Loop (High Service
Level) DOWN

The high-level test of the inner loop power control for power Down 
commands tests the ability of the phone to adjust its output power in 1 dB 
steps. Lector and Scriptor compare the worst-case results from ten 
measurements (ten times a 1 dB step down) with the limit for the lowest 
power step deviation and the highest power step deviation.

Inner Loop (High Service
Level) UP

The high-level test of the inner loop power control for power Up commands 
tests the ability of the phone to adjust its output power in 1 dB steps. Lector 
and Scriptor compare the worst-case results from ten measurements (ten 
times a 1 dB step up) with the limit for the lowest power step deviation and 
the highest power step deviation.

Inner Loop (Go/NoGo) DOWN The Go/NoGo-level test of the inner loop power control for power Down 
commands tests the ability of the phone to adjust its output power in steps 
by 10 dB. Lector and Scriptor compare the result from a measurement with 
the limit for the lowest power step deviation and the highest power step 
deviation.

Inner Loop (Go/NoGo) UP The Go/NoGo-level test of the inner loop power control for power Up 
commands tests the ability of the phone to adjust its output power in steps 
by 10 dB. Lector and Scriptor compare the result from a measurement with 
the limit for the lowest power step deviation and the highest power step 
deviation.
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Uplink Power MAX The test instrument can make the mobile phone transmit at its maximum 
possible power level, according to its power class. There are limit parame-
ters for the maximum power level (measured in dBm) for all four power 
classes. 

Uplink Power MIN Similar to the Uplink Power MAX, the test instrument can make the mobile 
phone transmit at its minimum possible power level. The power level is 
measured in dBm and there is one set of limits, independent of the power 
class.

Uplink Power MEAN In this test, the power level between the minimum and maximum is 
measured and compared with the nominal value. The result is expressed in 
dB.

WCDMA Occupied Bandwidth This measurement shows the bandwidth occupied by the UE’s signal. The 
occupied bandwidth identifies the frequency range into which a given 
percentage of the signal power falls. 99% of the entire power should be 
spread within a range of no more than 5 MHz around the carrier frequency. 
The purpose of this measurement is to verify that the UE’s occupied band-
width is lower than 5 MHz based on a chip rate of 3.84 Mcps. An occupied 
bandwidth exceeding this value may increase interference with other chan-
nels or other systems.

WCDMA Error Vector
Magnitude

The key measurement for WCDMA modulation is the error vector magni-
tude or EVM for short, which is the distance in the I/Q diagram between the 
measured signal and the ideal one, relative to the ideal signal vector magni-
tude; the EVM is measured separately for each symbol. Standard measure-
ment results to observe are the RMS-averaged EVM (for all the symbols of 
a frame) and the maximum (peak) EVM within the frame. The results are 
expressed as a percentage.
Limit value for the RMS EVM according to WCDMA specifications: 17.5%.
Limit value for the peak EVM according to WCDMA specifications: 50%.

WCDMA Magnitude Error The root mean squared magnitude error is a measurement of the error in 
the mobile’s transmit signal size (magnitude) at the decision points. The 
result is measured as a percentage, relative to the nominal magnitude.
Limit value for the RMS magnitude error: 17.5%.
Limit value for the peak magnitude error: 50%.

WCDMA Phase Error The phase error indicates the phase difference, i.e. the angle difference, 
between the signal vector measured and the ideal signal vector. The phase 
error is calculated for each bit; for the purposes of WCDMA tests, both the 
RMS-valued phase error (RMS-averaged over a frame) or the peak 
(maximum) phase error over a frame are evaluated.
Limit value range for the RMS phase error, according to WCDMA specifica-
tions: ±10°.
Limit value range for the peak phase error, according to WCDMA specifica-
tions: ±45°.
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WCDMA Frequency Error There are band-specific limits for the frequency error measurement which 
indicates the deviation of the actual carrier frequency from the nominal 
carrier frequency, in hertz.
The limits are separately definable for Bands I and II, Bands III, IV, IX and X, 
Bands V, VI and VIII, and Band VII.

WCDMA Rho Rho is the waveform quality factor, a measure of modulation accuracy. A 
value of 1 indicates perfect waveform quality.
Limit value according to WCDMA specifications: 0.9440

WCDMA IQ Offset The I/Q offset value is the determined ratio between the I/Q offset vector 
and the average signal vector corrected by offset. It is expressed in dB.
Limit value according to WCDMA specifications: –15 dB

WCDMA IQ Imbalance The I/Q imbalance value indicates the ratio of the power in the desired side-
band carrier produced and the undesired sideband carrier produced due to 
an amplitude difference between the input signals to the I/Q modulator, 
expressed in dB.
Limit value according to WCDMA specifications: –25 dB

WCDMA ACLR The measurement of the adjacent channel leakage ratio (ACLR) determines 
the ratio of the spectral power in the neighboring channels to the power in 
the allocated channel. The purpose of this measurement is to verify that the 
ACLR value does not exceed the WCDMA limits and to ensure thereby that 
the mobile’s modulator does not create sideband emissions that would then 
disturb transmission on adjacent traffic channels. 

The ACLR measurements are performed at offsets of 5 MHz and 10 MHz, 
and the results are in dBc. Separate limits for 5 and 10 MHz exist.

RSCP (normal condition) The Common Pilot Channel received signal code power is the average power 
of the signal received by the UE, after despreading and combining the 
signal. It is important how the UE received the CPICH transmitted by Node 
B. Based on this value the Preamble Initial Power is calculated. This value 
indicates the accuracy of the UE’s CPICH RSCP measurement. The RSCP is 
determined in dBm.

RSCP (extreme condition) The test is the same as in RSCP (normal conditions), but separate (usually 
wider) limits apply.

WCDMA Bit Error Rate The bit error rate indicates the number of erroneous bits in relation to the 
total number of bits in a transmission. It is expressed as a percentage. A BER 
of 0 would be ideal. 
According to WCDMA specifications the BER value shall not exceed 0.001 at 
an input level that depends on the WCDMA frequency band.
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Changing the test limits for HSDPA

HSDPA ACLR The measurement of the adjacent channel leakage ratio (ACLR) determines 
the ratio of the spectral power in the neighboring channels to the power in 
the allocated channel. The purpose of this measurement is to verify that the 
ACLR value does not exceed the HSDPA limits and to ensure thereby that 
the mobile’s modulator does not create sideband emissions that would then 
disturb transmission on adjacent traffic channels. 

The ACLR measurements are performed at offsets of 5 MHz and 10 MHz, 
and the results are in dBc. Separate limits for 5 and 10 MHz apply.

HSDPA Block Error Rate The block error rate indicates the number of blocks received in error in rela-
tion to the total number of blocks in a transmission. It is expressed as a 
percentage. A BLER of 0 would be ideal. 
According to HSDPA specifications the BLER value shall not exceed 10% at 
an input level that depends on the frequency band.

HSDPA Error Vector Magnitude In important modulation measurement for WCDMA is the error vector 
magnitude or EVM for short, which is the distance in the I/Q diagram 
between the measured signal and the ideal one, relative to the ideal signal 
vector magnitude; the EVM is measured separately for each symbol. Stan-
dard measurement results to observe are the RMS-averaged EVM (for all 
the symbols of a frame) and the maximum (peak) EVM within the frame. 
The results are expressed as a percentage.
Limit value for the RMS EVM according to HSDPA specifications: 17.5%.
Limit value for the peak EVM according to HSDPA specifications: 50%.

HSDPA Frequency Error There are band-specific limits for the frequency error measurement which 
indicates the deviation of the actual carrier frequency from the nominal 
carrier frequency, in hertz.
The limits are separately definable for Bands I and II, Bands III, IV, IX and X, 
Bands V, VI and VIII, and Band VII.

HSDPA IQ Offset The I/Q offset value is the determined ratio between the I/Q offset vector 
and the average signal vector corrected by offset. It is expressed in dB.
Limit value according to WCDMA specifications: –15 dB.

HSDPA IQ Imbalance The I/Q imbalance value indicates the ratio of the power in the desired side-
band carrier produced and the undesired sideband carrier produced due to 
an amplitude difference between the input signals to the I/Q modulator, 
expressed in dB.
Limit value according to HSDPA specifications: –25 dB.



Chapter 8 Defining Test Limits

Changing the test limits for HSDPA

Lector and Scriptor Version 6.10 183

HSDPA Magnitude Error The root mean squared magnitude error is a measurement of the error in 
the mobile’s transmit signal size (magnitude) at the decision points. The 
result is measured as a percentage, relative to the nominal magnitude.
Limit value for the RMS magnitude error: 17.5%.
Limit value for the peak magnitude error: 50%.

HSDPA Occupied Bandwidth This measurement shows the bandwidth occupied by the UE’s signal. The 
occupied bandwidth identifies the frequency range into which a given 
percentage of the signal power falls. 99% of the entire power should be 
spread within a range of no more than 5 MHz around the carrier frequency. 
The purpose of this measurement is to verify that the UE’s occupied band-
width is lower than 5 MHz based on a chip rate of 3.84 Mcps. An occupied 
bandwidth exceeding this value may increase interference with other chan-
nels or other systems.

HSDPA Power MAX The test instrument can make the mobile phone transmit at its maximum 
possible power level, according to its power class. There are limit parame-
ters for the maximum power level (measured in dBm) for all four power 
classes. 

HSDPA Phase Error RMS The phase error indicates the phase difference, i.e. the angle difference, 
between the signal vector measured and the ideal signal vector. The phase 
error is calculated for each bit; for the purposes of HSDPA tests, both the 
RMS-valued phase error (RMS-averaged over a frame) or the peak 
(maximum) phase error over a frame are evaluated.
Limit value range for the RMS phase error, according to HSDPA specifica-
tions: ±10°.
Limit value range for the peak phase error, according to HSDPA specifica-
tions: ±45°.

HSDPA Rho Rho is the waveform quality factor, a measure of modulation accuracy. A 
value of 1 indicates perfect waveform quality.
Limit value according to HSDPA specifications: 0.9440. 

HSDPA Throughput Category The HSDPA throughput category is equivalent to the UE Category. The 
maximum (peak) throughput of the mobile (UE) depends on the number of 
code channels, the minimum TTI interval and the modulation scheme as 
follows:

Table 13 Maximum throughput rate as a function of the UE 
category

UE 
category

HS- 
(P)DSCH 

code 
channels

Min. TTI 
interval

Modulation
Peak data 

rate 
(Mbit/s)

1 5 3 QPSK, 16QAM 1.2

2 5 3 QPSK, 16QAM 1.2
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3 5 2 QPSK, 16QAM 1.8

4 5 2 QPSK, 16QAM 1.8

5 5 1 QPSK, 16QAM 3.6

6 5 1 QPSK, 16QAM 3.6

7 10 1 QPSK, 16QAM 7.2

8 10 1 QPSK, 16QAM 7.2

9 15 1 QPSK, 16QAM 10.8

10 15 1 QPSK, 16QAM 14.4

11 5 2 QPSK 0.9

12 5 1 QPSK 1.8

Table 13 Maximum throughput rate as a function of the UE 
category

UE 
category

HS- 
(P)DSCH 

code 
channels

Min. TTI 
interval

Modulation
Peak data 

rate 
(Mbit/s)
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Changing the test limits for CDMA

CDMA US800 Power This measurement determines the maximum power level for the US 800 
frequency band. Limits can be entered for each of the three power classes. 
The power level is measured in dBm.

CDMA USPCS Power This measurement determines the maximum power level for the US-PCS 
frequency band. Limits can be entered for each of the five power classes. 
The power level is measured in dBm.

CDMA KPCS Power This measurement determines the maximum power level for the Korean PCS 
frequency band. Limits can be entered for each of the five power classes. 
The power level is measured in dBm.

CDMA NMT450 Power This measurement determines the maximum power level for the NMT 450 
frequency band. Limits can be entered for each of the four power classes. 
The power level is measured in dBm.

CDMA AWS Power This measurement determines the maximum power level for the AWS 
frequency band. Limits can be entered for each of the five power classes. 
The power level is measured in dBm.

CDMA Open Loop Estimate The open loop estimate tests the ability of the mobile phone to set its 
transmit power to a specific level, depending on the received signal 
strength (i.e. the output power level of the instrument). The power level 
error (compared to the expected power) is measured in dB.

CDMA Minimum Power The test instrument can make the mobile phone transmit at its minimum 
possible power level. The power level is measured in dBm.

CDMA Standby Power The standby power (in dBm) is the in-band power level measured while the 
mobile phone is inactive and observing the base station signals. 

CDMA Access Power This is the measured power (in dBm) of the first burst of an access probe 
(first burst), i.e. while the mobile phone accesses the network, e.g. to set up 
a call. 

CDMA Closed Loop Range This measurement can be used to verify the mobile phone’s closed loop 
power control ability and to measure its maximum and minimum power 
level, respectively. First the initial power is measured (in dBm). The test 
instrument then directs the CDMA phone to increase its power level by 
means of sending power control bits, until the phone transmits at its 
maximum power level. This level is measured relative to the initial power, 
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in dB. Similarly, the power control bits are then set so that the phone 
transmits at its minimum power level, and the relative power level is 
measured.

The closed loop range limits refer to the upper and lower power measure-
ment. The value in the Min column determines the upper limit for the 
lower power, relative to the initial power value. The value in the Max col-
umn gives the lower limit for the upper power with respect to the initial 
power.

The defaults are –24 and +24 dB, respectively as defined in the CDMA spec-
ifications.

CDMA Freq. Error This is the limit for the frequency error measurement which indicates the 
deviation of the actual carrier frequency from the nominal carrier frequency, 
in hertz.

The frequency error limit depends on the frequency band. Separate limits 
can be defined for the US 800, US-PCS, Korean PCS, NMT 450 and AWS 
bands.

CDMA Waveform Quality The waveform quality factor rho is a measure of the modulation quality. The 
ideal value is 1; measured values are in the range 0 to 1.

The waveform quality factor rho must be greater than 0.944 as specified in 
the CDMA specifications.

CDMA Time Error The time error indicates the transmit time error (Tau) with respect to the 
forward channel timing and is measured in microseconds.

The time error must be within ±1 µs according to the CDMA specifications.

CDMA Carrier Feedthrough The carrier feedthrough indicates the accuracy of the I/Q modulator’s DC 
setup; it is usually an undesired leakage produced due to a DC offset in the 
phone’s I/Q modulator. It is measured in dBc.

CDMA I/Q Imbalance The I/Q imbalance measurement is an indication of the accuracy of the I/Q 
modulator's modulating signal amplitude balance. It is the ratio of the 
power in the desired sideband carrier produced and the undesired sideband 
carrier produced due to an amplitude difference between the input signals 
to the I/Q modulator.

The I/Q imbalance is measured in dBc.

CDMA Peak Phase Error The phase error is a measurement of the phase component of the vector 
error of the mobile’s transmit signal at the decision points. The peak 
measurement determines the maximum phase error over a measurement 
interval. The phase error is given in degrees. 
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CDMA RMS Phase Error The phase error is a measurement of the phase component of the vector 
error of the mobile’s transmit signal at the decision points. The RMS 
measurement determines an average value over a measurement interval. 
The phase error is given in degrees.

CDMA Peak EVM The error vector magnitude (EVM) is a measure of the modulation accuracy 
at the decision points. It is the difference between the vector of the received 
signal and that of the ideal (expected) signal. The peak value is the 
maximum EVM of all the decision points (symbols) over a whole measure-
ment interval. EVM is given as a percentage.

CDMA RMS EVM The error vector magnitude (EVM) is a measure of the modulation accuracy 
at the decision points. It is the difference between the vector of the received 
signal and that of the ideal (expected) signal. The RMS value is an average 
of all the decision points (symbols) over a whole measurement interval. 
EVM is given as a percentage.

CDMA Peak Mag. Error The magnitude error is a measurement of the error in the mobile’s transmit 
signal size (magnitude) at the decision points. The peak value is the 
maximum error over a whole measurement interval. The magnitude error is 
given as a percentage.

CDMA RMS Mag. Error The magnitude error is a measurement of the error in the mobile’s transmit 
signal size (magnitude) at the decision points. The root-mean square value 
is an average over a whole measurement interval. The magnitude error is 
given as a percentage.

CDMA FER Frame Erasure Rate The FER (frame error rate) indicates the number of bad frames (frame 
errors) the mobile has received relative to the overall number of frames 
received. The FER is measured in percent.

CDMA FER Confidence Level The confidence level is a statistical measure of the completeness of infor-
mation obtained about a statistical process. A confidence level of less than 
100% may result in the test being concluded before the specified number 
of frames has been reached, so that the test time can be shortened. The 
expected confidence level is in the range from 95 to 100%.

CDMA FER Max. Frames This is not a limit but the maximum number of frames to be used for a FER 
measurement.
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Changing the test limits for EVDO

EVDO Open Loop Estimate The open loop estimate tests the ability of the mobile phone to set its 
transmit power to a specific level, depending on the received signal 
strength (i.e. the output power level of the instrument). The power level 
error (compared to the expected power) is measured in dB.

EVDO Minimum Power The minimum power measurement represents the minimum power level 
supported by the mobile. Setting the mobile to its lowest power level is 
achieved by a combination of open loop power control (where the 4400’s 
output power is set to a high level) and closed loop power control (the 
mobile is repetitively told to decrease its power level). The power level is 
measured in dBm.

EVDO Standby Power The standby power (in dBm) is the in-band power level measured while the 
mobile phone is inactive and observing the base station signals. 

EVDO Access Power This is the measured power (in dBm) of the first burst of an access probe 
(first burst), i.e. while the mobile phone accesses the network, e.g. to set up 
a call. 

EVDO Closed Loop Range This measurement can be used to verify the mobile phone’s closed loop 
power control ability and to measure its maximum and minimum power 
level, respectively. First the initial power is measured (in dBm). The test 
instrument then directs the CDMA phone to increase its power level by 
means of sending power control bits, until the phone transmits at its 
maximum power level. This level is measured relative to the initial power, 
in dB. Similarly, the power control bits are then set so that the phone 
transmits at its minimum power level, and the relative power level is 
measured.

The closed loop range limits refer to the upper and lower power measure-
ment. The value in the Min column determines the upper limit for the 
lower power, relative to the initial power value. The value in the Max col-
umn gives the lower limit for the upper power with respect to the initial 
power.

The defaults are –24 and +24 dB, respectively as defined in the CDMA spec-
ifications.

EVDO Freq. Error The frequency error (measured in Hertz) is a measure of the synthesizer 
accuracy. The frequency error is frequently updated during a data connec-
tion. A value of 0 Hz indicates perfect synthesizer accuracy. The limits may 
differ between the supported frequency bands (US 800, US-PCS, Korean 
PCS, NMT-450, AWS).
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EVDO Waveform Quality The waveform quality factor, rho is a measure of the modulation accuracy. 
A value of 1 indicates perfect waveform quality.

EVDO Time Error The time error indicates the transmit time error (Tau) with respect to the 
forward channel timing. The result is in microseconds. The ideal value for 
the time error is 0 µs.

EVDO Carrier Feedthrough The carrier feedthrough is an undesired leakage of the unmodulated carrier 
at the nominal R-TCH frequency. As it is caused by a DC offset in the mobile’s 
I/Q modulator, this measurement can be used to trim this offset. The 
measurement results are in dBc. 

EVDO I/Q Imbalance The I/Q imbalance indicates the accuracy of the I/Q modulator's output 
signal spectrum. It is the ratio of the power produced in the undesired side-
band(s) and in the desired sideband(s) and is expressed in dB.
I/Q imbalance usually is caused by a physical difference (e.g. amplitude) 
between the input signals to the I/Q modulator.

EVDO Peak Phase Error Results of the phase error measurement are positive numbers in degrees; 
the ideal value is zero. A lower limit is therefore not configurable. Measure-
ment results (with pass/fail verdict according to these limits) are available 
in the Rho/Freq. test menu.

EVDO RMS Phase Error This is the root mean squared phase component of the error vector at the 
constellation points.

The phase error is given in degrees; the ideal value for the RMS Phase Error 
is 0°.

EVDO Peak EVM The error vector magnitude (EVM) is a measure of the modulation accuracy 
at the constellation points (symbols). The error vector magnitude is the 
difference between the vector of the received signal and that of the ideal 
(expected) signal. The peak value is the maximum of the EVMs for all 
constellation points over a whole measurement interval. 

The EVM is given as a percentage, relative to the ideal signal. Therefore, the 
ideal value is 0%.

EVDO RMS EVM The error vector magnitude (EVM) is a measure of the modulation accuracy 
at the constellation points (symbols). The error vector magnitude is the 
difference between the vector of the received signal and that of the ideal 
(expected) signal. The root mean squared (RMS) value is an average of all 
EVMs for all constellation points over a whole measurement interval. 

The EVM is given as a percentage, relative to the ideal signal. Therefore, the 
ideal value is 0%.
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EVDO Peak Mag. Error The magnitude error is the magnitude component of the error vector at the 
constellation points. The peak value is the maximum over all the constella-
tion points of a measurement interval.

The magnitude error is given as a percentage, related to the ideal signal. 
Therefore, the ideal value is 0%.

EVDO RMS Mag. Error The magnitude error is the magnitude component of the error vector at the 
constellation points. The RMS value is the root mean square over all the 
constellation points of a measurement interval.

The magnitude error is given as a percentage, related to the ideal signal. 
Therefore, the ideal value is 0%.

EVDO FER Frame Error Rate The FER (frame error rate) indicates the number of bad frames (frame 
errors) the mobile has received relative to the overall number of frames 
received. The FER is measured in percent.

EVDO FER Confidence Level The confidence level is a statistical measure of the completeness of infor-
mation obtained about a statistical process. A confidence level of less than 
100% may result in the test being concluded before the specified number 
of frames has been reached, so that the test time can be shortened. The 
expected confidence level is in the range from 95 to 100%. [Und deshalb 
sind die Standardlimits 0 bis 95%.]

EVDO FER Max. Frames This is not a limit but the maximum number of frames to be used for a FER 
measurement.
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Changing the test limits for AMPS

AMPS Power Level The AMPS transmit power is measured in dBm. The actual power level is 
affected by the power control performed by the base station (or the test 
instrument in the case of the measurements) by way of the MAC (see 
Table 14), therefore separate limits for each of the MACs apply. Note that 
nominal power levels exceeding the mobile’s capabilities given by its power 
class, result in the highest possible power level.

AMPS Freq. Error The frequency error (measured in Hertz) is a measure of the synthesizer 
accuracy. The frequency error is frequently updated during a data connec-
tion. A value of 0 Hz indicates perfect synthesizer accuracy.

AMPS SAT Freq. Error The SAT frequency error describes the difference between the measured 
and the nominal SAT carrier frequency. The ideal value is 0 hertz.

AMPS SAT Deviation The deviation of the SAT (supervisory audio tone) is measured. The SAT 
carrier is modulated with a nominal deviation of 2 kHz and the allowable 
limit is ±0.2 kHz off the nominal value.

AMPS ST Freq. Error The signaling tone (ST) is a 10 kHz tone used in AMPS for mobile ringing, 
call terminations, handoffs, and switch-hook operation. The ST test is 
designed to verify the baseband signaling performance and circuitry of a 
mobile. 
The frequency error of the signaling tone, measured in hertz, should be 
close to zero.

Table 14 Mobile attenuation codes (MAC) and nominal power 
levels

MAC Nominal power 
level

0 36 dBm

1 32 dBm

2 28 dBm

3 24 dBm

4 20 dBm

5 16 dBm

6 12 dBm

7 8 dBm
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AMPS ST Deviation The signaling tone (ST) is a 10 kHz tone used in AMPS for mobile ringing, 
call terminations, handoffs, and switch-hook operation. The ST test is 
designed to verify the baseband signaling performance and circuitry of a 
mobile. 
The deviation of the signaling tone is 8 kHz ±0.8 kHz typically.

AMPS RX SINAD The SINAD (signal to noise and distortion), measured in dB, is a measure of 
the receive quality. The higher the value at low power levels, the better the 
quality or receiver sensitivity. The measurement is taken from the signal fed 
into the AF IN connector of the instrument.

AMPS Peak Audio Deviation This measurement indicates the frequency deviation affected by the trans-
mitted audio (or DTMF) signal. The deviation should rise with the audio level 
but not exceed 12 kHz.
The upper and lower limits of the audio deviation depend on the signal fed 
into the mobile phone. The upper limit should not exceed 12 kHz as this is 
the maximum allowable value for AMPS phones.

AMPS BS Level Sensitivity The upper limit is used as the maximum power level at which sensivity 
measurements based on the AMPS SAT are performed.
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Changing the test limits for TETRA

MAX TX Power The nominal (maximum) transmit power depends on the power class of the 
TETRA radio (power classes 1 thru 4 and 1L thru 4L). The allowable range 
at the nominal power level, in dBm, differs from that at any other power 
level step.

TX Power
(Power Steps 5 thru 7)

Limits for these three power steps can be entered in dBm.

Tetra Frequency Error The frequency error expresses the mobile station carrier offset to the 
expected frequency, in Hz. The upper and lower limits depend on the actual 
frequency, the limit range is ±10-7. 

Tetra Frame Alignment This limit parameter refers to the timing error (in symbol periods) of the 
bursts transmitted by the TETRA radio, taking the commanded timing 
advance into account.

Tetra Residual Carrier Power The residual carrier power is a measure of the modulation quality. It is an 
absolute value measured in %.

Tetra Vector Error (RMS and
Peak)

The vector error is another measure of the modulation quality. It is 
measured as an RMS and as a peak percentage value over the symbols of a 
burst. 

Tetra Power/Time Template While the TETRA radio has to ramp up or down its RF power level within 
microseconds, the RF power level should be constant during the burst. The 
PTT (= power/time template) defines the power level that the radio should 
transmit for any time position during the burst.

If you want the result of the power/time template check to be included in 
the overall assessment of the mobile’s performance, enter 0 in both the Min 
and Max parameter fields.
If you do not want to include the power/time template result in the perfor-
mance assessment, enter 0 in the Min and 1 in the Max parameter field.

Tetra Paging Sensitivity The Paging Sensitivity test is a means of determining the receiver quality at 
low levels. The result is the lowest power level at which the TETRA radio still 
responds to paging. The upper limit, in dBm, should be set to the maximum 
allowable sensitivity threshold (e.g. –112 if the radio is expected to 
successfully receive down to –112 dBm or better).
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TT BER (Class 0 thru 2) These limits apply to the bit error rate (BER) measurement for class 0, 1 and 
2 bits in the TETRA Test mode loopback test which is performed in call 
mode. The limits are entered as percentage values.

TT MER These limits apply to the message erasure rate (MER) measurement in the 
TETRA Test mode loopback test which is performed in call mode. The limits 
are entered as percentage values.
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Chapter 9 X2TEST Editor

This chapter describes how the X2TEST feature can be set up. Topics 
discussed in this chapter are as follows:

– “What X2TEST does” on page 196

– “Creating and modifying TAC2TEST files” on page 200
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What X2TEST does

Overview GSM and WCDMA tests usually depend on the serial number of the phone, 
the IMEI (International Mobile Equipment Identity) because the IMEI 
contains a Type Approval Code (TAC) indicating the brand and type of 
mobile phone. The capabilities, necessary tests and vendor-specific limits 
can all be derived from this information. The IMEI can be requested by the 
test equipment over the air interface.
In CDMA2000, the type of phone and the subsequent tests are usually set 
with the group, subgroup and test script settings. 

However, with X2TEST, the test script to be run depends on a code that is 
entered by the user, e.g. the phone’s serial number (or an important part 
within the serial number, e.g. the type approval code TAC. The user enters 
the code using either the keyboard or – more failsafe – a barcode reader. 
The serial number is typically printed on the phone, inside the battery 
compartment.

GSM and WCDMA mobile phones have a serial number containing a code for 
the whole series, usually the first eight digits (TAC). Lector can use this code 
to determine which test shall be carried out. The operator only needs to 
enter the serial number or scan it using a barcode reader; Lector then uses 
a user-defined table to find out the right test script.

Limit values and coupling factors may also depend on a specific code 
because they can be loaded from the test script.

Lector and Scriptor support three different concepts: TAC2TEST, TECH2TEST 
and CODE2TEST.

NOTE

In order for this to work, the IMEI Comparison parameter in Configuration 
> General must be set to “Always” or “Only TAC2TEST”. Please refer to 
“IMEI Comparison” on page 36 for more information.
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TAC2TEST The code to be entered should be the serial number (IMEI in GSM and 
WCDMA). Lector or Scriptor performs a plausibility check on the code, then 
extracts the TAC (Type Approval Code) and searches for the TAC in a user-
defined list (the X2T file) associating TACs with test scripts. If the TAC is 
present in the list, the related test script is started. Once the test is 
completed, the next mobile phone can be tested, i.e. TAC2TEST expects the 
next serial number.

An example TAC2TEST file can be found under the subgroup TAC2TEST in 
the GSM/WCDMA group of tests. You can modify this file or add your own 
TAC2TEST files to any test group and subgroup.
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TECH2TEST Similar to TAC2TEST, the code to be entered should be the serial number 
(IMEI). Lector or Scriptor performs a plausibility check on the code, then 
extracts the TAC and searches for the TAC in the coupling factor databases. 
If the TAC is present, Lector or Scriptor reads the technologies that the 
mobile phone supports from the coupling factor database. The user-defined 
X2T file contains a table of technologies and associated test scripts. The 
advantage over TAC2TEST is that the user does not need to maintain a list 
with all the different mobile phone types because this is extracted from the 
coupling factor databases (the 7360 Coupling Factor Update License can be 
very helpful in this case). You can also set up the X2T file so that certain 
technologies are ignored, e.g. if you do not want to perform GPRS or 
WCDMA tests.
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CODE2TEST The code to be entered can be a serial number, a code for a particular type 
of mobile phone or supported technology. Lector or Scriptor looks up the 
code in a user-defined list (the X2T file) associating the code with a test 
group, subgroup and script. The group and subgroup information is partic-
ularly important in CDMA because a lot of configuration information is 
linked to group and subgroup. The test script is started; once the test is 
completed, the next mobile phone can be tested, i.e. CODE2TEST expexts the 
next code. 

An example CODE2TEST file can be found in the subgroup MEID2TEST of the 
CDMA/EVDO group of tests. You can modify this file or add your own 
CODE2TEST files to any test group and subgroup.

General TAC2TEST, TECH2TEST and CODE2TEST files all have the filename extension 
X2T (instead of RBT for normal test scripts). You can have different X2T files 
for individual purposes, e.g. one for each service level with different test 
depths.

Before tests can be performed, test scripts must be assigned to codes. This 
can be done with 7315 Scriptor; the following section explains the neces-
sary steps.
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Creating and modifying TAC2TEST files

The X2T Editor in Scriptor allows you to assign codes, such as a serial 
number or parts of it, to test scripts.

1 In 7315 Scriptor, open the X2T Editor.

2 In the Load X2T File section, click on … to select the X2T file that you 
want to modify. 
The section entitled Linked Test Script displays the serial numbers and 
associated test scripts that are already defined in the TAC2TEST file. 
– Or, if you want to create a new file: – 

a Click New in the Load X2T File section.
A popup menu entitled Create New X2T File appears.

b Select TAC2TEST as the X2T file type.

c Click … to enter a file name and select a folder for the new file.

d Click OK to confirm your selections.
The popup menu disappears, and the section entitled Linked Test 
Script displays an empty table for serial numbers and associated test 
scripts.

3 In order to assign a new serial number (range) to a test script:
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a Click on New. 
The “Assign new scanned number” window pops up.

b In the Scanned Number field, enter the serial number of the phone to 
test, or the first relevant digits that characterize a phone series (e.g. 
the first eight digits in GSM and WCDMA). 

c In the Stored digits field, select TAC(8 digits) if the Scanned Number 
field contains the TAC (Type Approval Code) for a GSM or WCDMA 
phone. 
Or select ALL if the field contains a complete serial number.
Or select USER and enter the number of relevant digits.

d In the last input field, select the test script that shall be used when 
the mobile phone under test matches the Scanned Number.

e Click Assign to confirm your entries and to add them to the 
TAC2TEST list.

4 In order to modify an existing entry, select the entry with the mouse 
key and click Edit. Then follow the sub-steps starting under step 3.b.

5 In order to delete an assignment, select the entry with the mouse key 
and click Delete.
The serial number and the test script are deleted from the list.

6 Click Save to confirm the changes and have Scriptor save the X2T file. 
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Creating and modifying TECH2TEST files

The X2T Editor in Scriptor allows you to assign wireless technologies to test 
scripts. The technologies supported by a phone under test are identified 
through its serial number and comparison with the coupling factor data-
bases.

1 In 7315 Scriptor, open the X2T Editor.

2 In the Load X2T File section, click on … to select the X2T file that you 
want to modify. 
The section entitled Linked Test Script displays the relevant wireless 
technologies and associated test scripts that are already defined in the 
TECH2TEST file. 
– Or, if you want to create a new file: – 

a Click New in the Load X2T File section.
A popup menu entitled Create New X2T File appears.

b Select TECH2TEST as the X2T file type.
The popup menu displays additional selection boxes for the different 
wireless technologies.
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c Check all the technologies that are relevant for testing.

d Click … to enter a file name and select a folder for the new file.

e Click OK to confirm your selections.
The popup box disappears, and the section entitled Linked Test 
Script displays an empty table for the relevant technologies and 
associated test scripts.

3 In order to assign a new technology (combination) to a test script:

a Click on New. 
The “Tech2Test” menu pops up, with the available wireless technolo-
gies (systems) listed.,

b Check the wireless technologies (systems) that are to be tested or 
available in the phone.

c In the Test Script input field, click on … to select the test script that 
shall be used when the mobile phone under test supports the 
selected technologies.
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d Click Assign to confirm your entries and to add them to the 
TECH2TEST list.

4 In order to modify an existing entry, select the entry with the mouse 
key and click Edit. Then follow the sub-steps starting under step 3.b.

5 In order to delete an assignment, select the entry with the mouse key 
and click Delete.
The serial number and the test script are deleted from the list.

6 Click Save to confirm the changes and have Scriptor save the X2T file. 

Creating and modifying CODE2TEST files

The X2T Editor in Scriptor allows you to assign codes to test groups, 
subgroups and scripts.

1 In 7315 Scriptor, open the X2T Editor.

2 In the Load X2T File section, click on … to select the X2T file that you 
want to modify. 
The section entitled Linked Test Script displays the codes and associ-
ated test groups, subgroups and scripts that are already defined in the 
CODE2TEST file. 
– Or, if you want to create a new file: – 

a Click New in the Load X2T File section.
A popup menu entitled Create New X2T File appears.

b Select CODE2TEST as the X2T file type.

c Click … to enter a file name and select a folder for the new file.
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d Click OK to confirm your selections.
The popup menu disappears, and the section entitled Linked Test 
Script displays an empty table for codes and associated test groups, 
subgroups and scripts.

3 In order to assign a new code to a test script:

a Click on New. 
The “Assign new scanned number” window pops up.

b In the Scanned Number field, enter the code associated with phones 
to test, or the first relevant digits that characterize a phone series.

c In the Stored digits field, select TAC(8 digits) if the Scanned Number 
field contains the TAC (Type Approval Code) for a GSM or WCDMA 
phone. 
Or select ALL if the field contains a complete code.
Or select USER and enter the number of relevant digits.

d In the Group, Subgroup and Test Script input fields, select appro-
priate entries for the test script that shall be used when the mobile 
phone under test matches the Scanned Number.

e Click Assign to confirm your entries and to add them to the 
CODE2TEST list.

4 In order to modify an existing entry, select the entry with the mouse 
key and click Edit. Then follow the sub-steps starting under step 3.b.

5 In order to delete an assignment, select the entry with the mouse key 
and click Delete.
The serial number and the test script are deleted from the list.

6 Click Save to confirm the changes and have Scriptor save the X2T file. 
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Chapter 10 Administrating Lector on multiple 

computers

This chapter shows how an administrator with 7315 Scriptor can install 
new and modified test scripts and mobile phone description files on 
computers running Lector. Topics discussed in this chapter are as follows:

– “Introduction” on page 208

– “Using a particular configuration on multiple test stations” on 
page 208

– “Copying test scripts and phone definition files for GSM and WCDMA to 
other test stations” on page 208

– “Copying test scripts and phone definition files for CDMA2000 1xRTT 
and 1xEV-DO to other test stations” on page 209
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Introduction

An administrator in a service factory takes care of the test environment on 
a number of work benches, in particular in incoming inspection and final 
test. Using Scriptor, the administrator may create description files for new 
mobile phones, including pictures of phones and coupling factors. Test 
scripts may also be altered or added. It is easily possible to make these 
changes and additions available to all test stations, even if they are only 
running the Lector software. This chapter provides the necessary steps to 
do this.

Using a particular configuration on multiple test stations

Configuration data such as folders for files to be read or created, print and 
save settings should be uniform over all the test stations to ease mainte-
nance. Also, in order to protect configuration data from being altered by 
unauthorized users, they should be read-only.

This can be achieved by simply copying the config.ini file from Scriptor to 
the test stations, e.g. using the local area network or a USB memory stick. 
The config.ini file is located in Data\Init within the program installation 
folder (typically C:\Program files\Willtek\731X Lector-Scriptor).

Copying test scripts and phone definition files for GSM and WCDMA to other 
test stations

In order to manually replicate information about new GSM or WCDMA 
phones on other test stations, the following files should be copied to the 
test stations, e.g. using the local area network or a USB memory stick. Note 
that the file locations are relative to the software installation folder (typi-
cally C:\Program files\Willtek\731X Lector-Scriptor) and apply for a 
default configuration.

Data\Init\phones.ini (for the groups and subgroups)
Data\CPL_DB\MPUSER.DAT (phone models and coupling factors)
Data\CPL_DB\TAC6USER.DAT (how TACs are assigned to phone models)
Data\CPL_DB\USERTAC.DAT (assignment of new TACs to existing phone 
models)
Data\CPL_DB\Pictures\*.* (new phone pictures)
Data\Scripts\*.rbt (files with new or modified scripts)
Data\Limits\*.lim (limit values)

Note that if you want to return to the default settings of groups and 
subgroups, you can delete the existing ones by copying phones.def to 
phones.ini (effectively overwriting the old file).

Note

Drives and folders used in the Lector environment must have the same 
names and drive letters on all of the computers.
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Copying test scripts and phone definition files for CDMA2000 1xRTT and 
1xEV-DO to other test stations

In order to manually replicate information about new CDMA-capable 
phones on other test stations, the following files should be copied to the 
test stations, e.g. using the local area network or a USB memory stick. Note 
that the file locations are relative to the software installation folder (typi-
cally C:\Program files\Willtek\731X Lector-Scriptor) and apply for a 
default configuration.

Data\Init\phones.ini (for the groups and subgroups)
Data\Init\mobilesettings.ini
Data\Init\carrier.ini
Data\CPL_DB\MPCUSER.DAT (phone models and coupling factors)
Data\CPL_DB\Pictures\*.* (new phone pictures)
Data\Scripts\*.rbt (files with new or modified scripts)
Data\Limits\*.lim (limit values)

Note that if you want to return to the default settings of groups and 
subgroups, you can delete the existing ones by copying phones.def to 
phones.ini (effectively overwriting the old file).

Copying test scripts and mobile station definition files for TETRA to other test 

stations

In order to manually replicate information about new TETRA radios on other 
test stations, the following files should be copied to the test stations, e.g. 
using the local area network or a USB flash disk. Note that the file locations 
are relative to the software installation folder (typically 
C:\Program files\Willtek\731X Lector-Scriptor) and apply for a default 
configuration.

Data\Init\phones.ini (for the groups and subgroups)
Data\Init\mobilesettings.ini
Data\Init\channelsettings.ini
Data\CPL_DB\MPTUSER.DAT (TETRA radio models and coupling factors)
Data\CPL_DB\Pictures\*.* (new pictures of mobile stations)
Data\Scripts\*.rbt (files with new or modified scripts)
Data\Limits\*.lim (limit values)

Note that if you want to return to the default settings of groups and 
subgroups, you can delete the existing ones by copying phones.def to 
phones.ini (effectively overwriting the old file).
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Providing a reference configuration to multiple users

Principle As an alternative to the above distribution method, configuration files can 
also be provided on a network and copied into the local installation folders. 
The update on the local PCs (clients) can be done either manually or auto-
matically at regular intervals; this requires 7312 Lector Enhanced installa-
tions on the client PCs and is described in “Updating the configuration from 
a network drive” on page 51.

The administrator provides the reference configuration (mobile, carrier and 
coupling factor definitions, scripts and limits) in a folder on a network drive 
that the clients can access also. In this case, the administrator’s 7315 
Scriptor software copies the local user data to the network folder. The local 
user data are organized in files as outlined in “User-defined configuration 
data files” on page 212.

Updating the server data In order to copy the current local user data, proceed as follows.

1 In 7315 Scriptor, select Extras > Synchronize > Sync Settings... to 
open the Synchronization Settings pop-up menu.

2 Check the Write Files for Synchronization radio button.

3 Click on the ... button in the Synchronization Path section of the pop-up 
menu and select a network drive and folder where the user configura-
tion data shall be stored. Confirm your choice by clicking OK. 

4 Confirm your changes by clicking OK.
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5 Select Extras > Synchronize > Write Manually. 
The file creation date and time of the respective files from the test 
script folder (as set up in the Configuration section, see “Test Script 
Path” on page 28) and from the Data\CPL folder of the software instal-
lation directory are compared with the same files on the network server. 
If a file on the network server is older or does not yet exist, it will be 
copied from the local installation to the network. Newer files will not be 
overwritten.

6 If you want to copy additional files to the synchronization folder on the 
network, you can select them in Extras > Synchronize > Single Sync... 
Once the files to be copied have been added to the list, click on Write to 
Sync Server to copy them. 
When a client is synchronized with the synchronization folder on the 
network, the additional files will be copied there as well.
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User-defined configuration data files

The following files contain user-defined configuration data for mobile 
phones, mobile carriers and coupling factors as follows; in order to maintain 
the same data on multiple Lector or Scriptor installations, it is advisable to 
copy them from a reference configuration to all the local installations as 
explained above.

The reference folder is the installation path, typically 
C:\Program files\Willtek\731X Lector-Scriptor. 

Table 15 Files containing user-defined configuration data

subfolder and file name Data contained

Data\Init\phones.ini

Data\Init\PhonesAll.INI

Groups and subgroups

Data\Init\mobilesettings.ini Mobile phone definitions for CDMA 
and 1xEV-DO, and for TETRA radios

Data\Init\carrier.ini Carrier definitions for CDMA and 
1xEV-DO

Data\Init\channelsettings.ini Network and channel definitions for 
TETRA

Data\CPL_DB\MPUSER.DAT Phone models and coupling factors for 
GSM and WCDMA

Data\CPL_DB\MPCUSER.DAT Phone models and coupling factors for 
CDMA and 1xEV-DO

Data\CPL_DB\MPTUSER.DAT Mobile station models and coupling 
factors for TETRA

Data\CPL_DB\TAC6USER.DAT Assignment of TACs to phone models

Data\CPL_DB\USERTAC.DAT Assignment of additional TACs to 
existing phone models

Data\CPL_DB\Pictures\*.* Pictures from the mobile phones

Data\Scripts\*.rbt Test scripts

Data\Limits\*.lim Limit values

Data\Channels\*.* Test channels that are defined in the 
Configuration section under the Test 
Channels tab.
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Appendix A Testing Bluetooth devices

This appendix summarizes the measures to be taken to test Bluetooth-
enabled mobile phones. The topics discussed in this appendix are as follows:

– “Performing Bluetooth tests with Lector” on page 214

– “Troubleshooting Bluetooth tests with Lector” on page 214
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Performing Bluetooth tests with Lector

This section explains how to carry out connectivity tests on the Bluetooth 
device integrated in wireless devices. See section “Bluetooth Test” on 
page 36 on how to enable and disable this feature.

The Bluetooth test can be an integral part of the mobile phone test proce-
dure. 

– If you are using the 3100 Mobile Fault Finder or a 4400 Series Mobile 
Phone Tester, this requires the BLUETOOTH command (see “BLUE-
TOOTH” on page 99) as part of the test script.

– If you are using the 2201 ProLock, a 4100 or a 4200 series instruments, 
the test script needs to include the BLUETOOTH_DIRECT command (see 
“BLUETOOTH_DIRECT” on page 99).

In addition, users of 7315 Scriptor can check the script and add the 
command.

Typically after a connection (a call) between the phone and the tester has 
been established, Lector will ask if you want to perform a Bluetooth.

Follow the onscreen instructions. In particular, make sure that 

– the Willtek Bluetooth dongle is switched on

– the Bluetooth function in the mobile phone is enabled

– the Bluetooth visibility in the phone is enabled

After completing the mobile phone tests, Lector shows or prints a test 
protocol that includes the RF measurements as well as the results of the 
Bluetooth connectivity test. 
If successful, the Bluetooth test result consists of the MAC address of the 
Bluetooth device and the device name. The device name should be identical 
to the one that is set up in the phone.

Troubleshooting Bluetooth tests with Lector

If a Bluetooth test fails, this is indicated by asterisks on the right-hand side 
of the results printout. 

Test failure may occur for different reasons. It may be either because the 
test setup is not suitable or because the Bluetooth device in the mobile 
phone is defective. Here are a few possibilities:

– The Bluetooth testing device is switched off.
Switch on the device in the 4921 RF Shield.
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– The phone under test does not have a Bluetooth device.
Repeat the test, but do not request a Bluetooth connectivity test.

– The Bluetooth function in the phone is disabled.
Turn on the Bluetooth feature in the phone.

– The Bluetooth function is enabled, but the visibility is disabled.
Enable the Bluetooth visibility in the phone.

– There are other Bluetooth devices around that make communication 
difficult.
Close the RF Shield before starting the Bluetooth test.

If none of these conditions are met, the Bluetooth device in the phone may 
indeed by defective!
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Appendix B Warranty and Repair

This chapter describes the customer services available through Willtek. 
Topics discussed in this chapter include the following:

– “Warranty information” on page 218

– “Equipment return instructions” on page 219
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Warranty information

Willtek warrants that all of its products conform to Willtek's published spec-
ifications and are free from defects in materials and workmanship for a 
period of one year from the date of delivery to the original buyer, when used 
under normal operating conditions and within the service conditions for 
which they were designed. This warranty is not transferable and does not 
apply to used or demonstration products.

In case of a warranty claim, Willtek's obligation shall be limited to repairing, 
or at its option, replacing without charge, any assembly or component 
(except batteries) which in Willtek’s sole opinion proves to be defective 
within the scope of the warranty. In the event Willtek is not able to modify, 
repair or replace nonconforming defective parts or components to a condi-
tion as warranted within a reasonable time after receipt thereof, the buyer 
shall receive credit in the amount of the original invoiced price of the 
product.

It is the buyer's responsibility to notify Willtek in writing of the defect or 
nonconformity within the warranty period and to return the affected 
product to Willtek’s factory, designated service provider, or authorized 
service center within thirty (30) days after discovery of such defect or 
nonconformity. The buyer shall prepay shipping charges and insurance for 
products returned to Willtek or its designated service provider for warranty 
service. Willtek or its designated service provider shall pay costs for return 
of products to the buyer.

Willtek’s obligation and the customer’s sole remedy under this hardware 
warranty is limited to the repair or replacement, at Willtek’s option, of the 
defective product. Willtek shall have no obligation to remedy any such 
defect if it can be shown: (a) that the product was altered, repaired, or 
reworked by any party other than Willtek without Willtek’s written consent; 
(b) that such defects were the result of customer’s improper storage, 
mishandling, abuse, or misuse of the product; (c) that such defects were the 
result of customer’s use of the product in conjunction with equipment elec-
tronically or mechanically incompatible or of an inferior quality; or (d) that 
the defect was the result of damage by fire, explosion, power failure, or any 
act of nature.

The warranty described above is the buyer’s sole and exclusive remedy and 
no other warranty, whether written or oral, expressed or implied by statute 
or course of dealing shall apply. Willtek specifically disclaims the implied 
warranties of merchantability and fitness for a particular purpose. No state-
ment, representation, agreement, or understanding, oral or written, made 
by an agent, distributor, or employee of Willtek, which is not contained in 
the foregoing warranty will be binding upon Willtek, unless made in writing 
and executed by an authorized representative of Willtek. Under no circum-
stances shall Willtek be liable for any direct, indirect, special, incidental, or 
consequential damages, expenses, or losses, including loss of profits, based 
on contract, tort, or any other legal theory.
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Equipment return instructions

Please contact your local service center for Willtek products via telephone 
or web site for return or reference authorization to accompany your equip-
ment. For each piece of equipment returned for repair, attach a tag that 
includes the following information:

– Owner’s name, address, and telephone number.

– Serial number, product type, and model.

– Warranty status. (If you are unsure of the warranty status of your 
instrument, include a copy of the invoice or delivery note.)

– Detailed description of the problem or service requested.

– Name and telephone number of the person to contact regarding ques-
tions about the repair.

– Return authorization (RA) number or reference number.

If possible, return the equipment using the original shipping container and 
material. Additional Willtek shipping containers are available from Willtek 
on request. If the original container is not available, the unit should be care-
fully packed so that it will not be damaged in transit. Willtek is not liable for 
any damage that may occur during shipping. The customer should clearly 
mark the Willtek-issued RA or reference number on the outside of the 
package and ship it prepaid and insured to Willtek.



Appendix B Warranty and Repair

Equipment return instructions

220 Lector and Scriptor Version 6.10



C

Lector and Scriptor Version 6.10 221

Appendix C End-User License Agreement

This appendix describes the conditions for using the software.
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All copyrights in and to the software product are owned by Willtek Commu-
nications or its licensors. The software is protected by copyright laws and 
international copyright treaties, as well as other intellectual property laws 
and treaties.

This end-user license agreement grants you the right to use the software 
contained in this product subject to the following restrictions. You may not:

(i) use the software and/or any copy of the software in different 
computers concurrently, unless the software is an update that has been 
downloaded from the Internet at www.willtek.com;

(ii) copy the software, except for archive purposes consistent with your 
standard archive procedures;

(iii) transfer the software to a third party apart from the entire product;

(iv) modify, decompile, disassemble, reverse engineer or otherwise 
attempt to derive the source code of the software;

(v) export the software in contravention of applicable export laws and 
regulations of the country of purchase;

(vi) use the software other than in connection with operation of the 
product.

The licensor's suppliers do not make or pass on to end users or any other 
third party, any express, implied or statutory warranty or representation on 
behalf of such suppliers, including but not limited to the implied warranties 
of noninfringement, title, merchantability or fitness for a particular 
purpose.

Willtek Communications shall not be held liable for any damages suffered 
or incurred by you or any other third party (including, but not limited to, 
general, special, consequential or incidental damages including damages for 
loss of business profits, business interruption, loss of business information 
and the like), arising out of or in connection with the delivery, use or perfor-
mance of the software.
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